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Starting the Program

1 Welcome
MAXQDA 10 is a high-performance program for professional social science-oriented text
analysis, ideal for researchers from social sciences, education, economics, and many others,
who work with and analyze text in their professional capacities.
MAXQDA 10 is the result of more than 20 years of continuous development: MAX for DOS
was released in 1989, winMAX for Windows came out in 1994, and the first version of
MAXQDA was released in 2001. The current version, MAXQDA 10, builds on this tradition.
When MAXQDA 1 came out in 2001, it was a completely new program that didn’t adopt a
single line of code from the previous version winMAX. The new version was immediately
accessible to users of the former version, though, because it was based on the same basic
ideas, concepts, and handling as the older version.
MAXQDA 10 is a further developed version of MAXQDA 2007 – it contains many changes,
both small and large. An overview of these changes and improvements can be found on
the website at www.maxqda.com.
This handbook gives a detailed overview of all functions of MAXQDA. The short introduction, also available in the MAXQDA help menu, is a good way to get a more general introduction to the program. If you would like to have a printed introduction, it is recommended
that you print out that PDF.
This handbook is not designed as a quick introduction, but rather systematically explains all
functions and features of the program. It is also not set up to follow the logic of learning
the program.
Attached to this handbook, you will find tips for troubleshooting possible problems that
arise. There you will find information about the technical details and limits of MAXQDA.
There is also free telephone and internet support available to all registered users that have
questions regarding the use of the software:
 Tel.: VERBI Software. Consult. Sozialforschung. GmbH +49 (0) 6421/3400730
 Internet: www.maxqda.com
If you find any bugs or experience other problems with specific functions of the software,
please don’t hesitate to contact support. We are dedicated to constantly improving and
updating the software, which is partially dependent on feedback from our users. If you are
interested in staying abreast of the newest developments and program updates, keep
checking back on the MAXQDA website: www.maxqda.com.

What’s New in MAXQDA 10?

9

2 What’s New in MAXQDA 10?
For users of the older versions of MAXQDA, the following section offers an overview of the
changes and new functions. Project files from MAXQDA 2 (ending in “.mx2”) and MAXQDA 2007 (“.mx3”) will still be readable and will automatically be transformed into the new
format (“.mx4”).
The list of changes in MAXQDA 10 consists of 132 points, including very simple improvements as well as some that required a large amount of programming time. Our philosophy
remained the same for the most recent version: MAXQDA should remain the leading program for social science-oriented analysis of qualitative data, primarily text. MAXQDA
should, therefore, not become a special program for video analysis or picture archiving.
The focus still remains on those users that do research, either alone or in a team, based on
systematic analysis of texts, e.g. interviews, group discussions, field notes, etc. The MAXQDA-supported analysis is not embedded in a specific method, but lends itself well to a wide
range of approaches, from more structured methods like the classic qualitative analysis to
the more open approaches, like those based on Grounded Theory. Work done in MAXQDA
is generally category-based, which means the researcher does the interpretation, classification, and categorization of the material. MAXQDA has supporting functions and can take
on some tasks, like automatic searching and coding.
Behind some of the new features, there is a whole range of new functions: the user interface, for example, was completely redesigned, meaning more than 100 new icons were
developed in addition to new, more functional dialog fields.
The development of MAXQDA is embedded in the developments of social scientific research methods. Researchers of many different disciplines use MAXQDA, but the concentration for development is the social science’s concept of qualitative social research and
mixed methods approaches. There were five points that were especially important in the
development of this version:
1. Visualizations as analytical instruments – there were already many new functions in this
area in the last two versions of MAXQDA, which were then copied by other QDA programs.
2. Integration of qualitative and quantitative methods – this has always been a focus in the
development of MAXQDA, and there is no other software that makes this integration
easier.
3. Show geospatial relationships via geo-referencing – MAXQDA 2007 was the first QDA
program that systematically built in geo-referencing capabilities and offered geo-tagging
in MAXMaps, so that it would be possible to jump back and forth directly between
MAXQDA and Google Earth™.
4. Synchronized audio/video files with transcribed text – by integrating a media player, it is
now possible to have direct access from a transcript to the original audio or video file.
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One can even transcribe within MAXQDA. There is also the option to use the free professional transcription software F4, which creates transcripts and timestamps that can be
imported to MAXQDA.

5. Full support for PDF files – this was one of the big break-throughs in the new version
and had been requested again and again by MAXQDA users. The PDFs are visualized exactly as they would be in Adobe Acrobat and can now be imported and coded.
Short Overview of the Top 10 Changes in MAXQDA 10
There are ten important changes that we want to highlight and describe:
1. The completely reworked user interface
2. The search windows, tab options, and memo management
3. DOC/X documents
4. Full support for PDFs
5. Visual presentation: the new models in MAXMaps
6. Connection to audio/video files from transcripts
7. New mixed methods tools: variables for each speaker in group discussions
8. Coding of image files
9. Geo-referencing
10. Import and export of Excel files
1. The Completely Reworked User Interface
The first thing you will notice when you see the new version is the new user interface. The
icons are now three-dimensional and have a Windows Vista look. The various toolbars can
be shown or hidden, moved around within the toolbar area, or even freely dragged anywhere on the screen. We kept the classic MAXQDA look with the four main windows, so
you’ll still feel at home and won’t have to re-learn the program; you won’t have any problem finding the functions you’re so familiar with.
Almost every single aspect of the MAXQDA screen was reworked: icons, code stripes, dialogue fields, memo visualization, and much more. The new toolbars are especially practical. Not only can they be hidden and rearranged as you wish, they can also be moved anywhere on the screen. Regardless of how big your monitor is, you can now arrange the
Code Toolbar to be right next to the Text Browser. The Text Browser, by the way, is now
called the “Document Browser”, since MAXQDA can now import image and PDF files, and
therefore isn’t limited to the analysis of texts.
All dialogue windows were also overhauled, and not just visually. They now offer more
functionality as well. The Memo Manager, for example, displays a preview of each memo,
similar to the two-window structure in the coding overview.
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2. The Search Window, Tab Options, and Memo Management
You may be familiar with the small search bar in Adobe Acrobat, which allows you to do
quick searches for words or phrases in a document. If the search returns more than one hit,
you can toggle from one to the next. This kind of search bar is now integrated into all four
windows of MAXQDA.
Using tabs for internet browsing has become the norm, and this is now also possible in
MAXQDA. Several texts, image files, and/or PDFs can be opened simultaneously in the
“Document Browser”, which allows you to quickly switch back and forth between documents that you want to code simultaneously. You can also open more than one memo at a
time with tabs in the Memo Manager.
No QDA software has memo functionality coming anywhere close to that which MAXQDA
offers, and MAXQDA10 comes with even more improvements in this area. The Memo
Manager allows you to browse through your memos, compare them quickly via the tabbed
window, and integrate or summarize them in new memos.
The memo window is now much more flexible: it can be resized to fit the amount of text,
and a whole array of Rich Text formatting options have been added.
3. DOC/X Files
MAXQDA 10 can now import and code DOC and DOCX files. You only need to have a version of Microsoft Office installed on your computer.
The protocol for working with DOC files is the same as that for Rich Text documents. As in
previous versions of MAXQDA, the imported documents become part of the project file:
one project = one file. This means that MAXQDA has full control of the text once it has
been imported – it can be added to, modified, and highlighted as you wish. This makes the
transfer of projects in a teamwork setting or over the internet much easier, because you
only need to keep track and transfer a single file.
4. Full Support for PDF Documents
With MAXQDA10, you can now import and code PDF documents. PDFs are handled in their
own format, meaning they aren’t converted to Rich Text, but rather retain their exact formatting. In MAXQDA, they look exactly like they do in Adobe Acrobat or in a printout.
PDF documents are, however, dealt with somewhat differently than RTF or DOC files. For
RTF and DOC files, the rule is “one project = one file.” This is also the case with PDFs, but
only to a certain point. Since PDFs can be fairly large, including them as part of the project
file could make the project file too big to transfer or send by e-mail, defeating the whole
purpose of keeping everything together in one file. PDFs are therefore only imported until
the project file reaches a certain size, after which point, a link to the file will be inserted
rather than the actual file. You can set the limit to fit your needs (default is 10 MB). This
does come with some risks, since MAXQDA no longer has exclusive control of files that
aren’t imported. If another program would view, edit, or delete the linked PDF file, the
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coded segments that you created in MAXQDA would no longer be correct. When MAXQDA starts, it always checks to make sure that all external files still exist. If they are not
found, they are listed as missing in the „Document System“ window.
5. Visual Presentation: The New Models in MAXMaps
MAXQDA10 now makes it even easier to illustrate the connections in your data set. We
created model templates based on oft-used illustrations, which can now be applied to your
data automatically.
Five various models can be applied, each of which has various settings that you can change
according to your needs. The settings decide which elements are included in the automatically-created map.
1. One-Case Model – All relevant data attached to a document is illustrated in the map.
This includes all appropriate memos, codes, and coded segments.
2. One-Code Model – This model is very similar to the One-Case Model, except that a code
is the focus rather than a document. The coded segments and memos attached to the
code are included in this model along with any memos that are linked to the code.
3. Code Theory Model – This model is especially helpful for the development of theory. It
automatically displays all memos (with their ideas and hypotheses) attached to a specific
code.
4. Code Co-Occurence Model –This model illustrates the associations and intersections between selected codes. One or more codes are selected and dragged onto the MAXMaps
window. All codes that intersect with any of these selected codes are then automatically
inserted with an arrow connecting them to the code with which they intersect. The
width of this arrow is dependent on the number of intersections. The model can be
made more complex by including the subcodes in the visualization.
5. Code-Subcode-Segment Model – This is the most complex of the five models. The subcodes, connected memos, and the coded segments for all selected codes are illustrated
in a single model.
With just a few clicks, very complex visualizations can be created with the model templates.
They can also be quickly and easily modified and added to in MAXMaps. The results can
easily be used in presentations or printed out (even for large posters). The layers function in
MAXMaps allows you to create various layers, which can be used to represent steps in the
research process or to highlight specific aspects of the visualization in a presentation. For
printing large posters, it is recommended that visualizations be exported in EMF format, the
vector-based Windows extended metafile format.
6. Connection to Audio/Video Files from Transcripts
It is often very practical to have access to the original media file when analyzing a transcript, whether it be an audio or video file. MAXQDA 10 makes it possible to associate an
audio or video file to every transcript. With timestamps, which are displayed in MAXQDA
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very much like coded segments and memos in the „Document Browser”, it is easy to jump
from the transcript to an exact spot in the associated multimedia file. The new built-in
MAXQDA media player allows you to play these files directly in the program. A timestamp
list allows you to insert comments for each segment, which can later be searched for, allowing you to jump directly to the segment in the file or transcript.
7. New Mixed Methods Tools: Variables for Speakers in Group Discussions
It was already possible in the first version of MAXQDA to set global variables for imported
documents. This is fully adequate for standard interview techniques: a single person is interviewed, the interview is transcribed, and it is imported into MAXQDA. The same person
fills out a standardized questionnaire, which is also imported and associated with the interview.
The text-level attributes were not sufficient, however, for group discussions, because more
than one person is being interviewed, and it wasn’t possible to add more than one value
for each attribute. With MAXQDA10, this is now possible. Profile variables can even be defined for subcodes so that variables can be defined for each speaker taking part in a group
discussion.
8. Coding of Image Files
MAXQDA10 can also work with image files – which in previous versions could only be used
as elements of a text and could only be coded as a whole. With the new version, however,
images can be imported into the „Document System“ and sections of the image can be
selected and coded. MAXQDA should definitely not be used as a picture archiving program
– there are many other programs like iPhoto that are much better able to carry out such
functions – but it is sometimes very helpful to be able to code aspects of images in a sociological research project.
9. Geo-referencing
Every possible location in Google Earth™ can be linked to any part of a MAXQDA document or code. And not only that! A MAXQDA geolink can also be inserted as a free object
in MAXMaps or used as a hidden hotspot in a MAXMaps graphic (e.g. in a photo or symbol) – clicking on the graphic zooms you in to the connected geographic point. This function was first made available in a free update for MAXQDA 2007, and in MAXQDA10, the
function has been made even better. It is now possible to create a connection to the leading geographic information software Arc-GIS.
10. Import and Export of Excel Files
In addition to having the option of exporting to RTF and HTML formats, it is now possible
to export to Excel in XLS/X format. You can, for example, now export and view the Memo
Manager, the Overview of Coded Segments, the Table of Variables, and the Code Matrix
Browser in Excel. This makes export to SPSS very easy.
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It is also now possible to import more than just document variables from Excel files. Structured documents, especially those with results of standardized and non-standardized questionnaires, can also now be imported as well as code systems and code memos from Excel
documents.

MAXQDA Screens and Menus
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3 MAXQDA Screens and Menus
3.1 Starting the Program
After opening MAXQDA, a window will appear with the MAXQDA logo and then the following screen:

The MAXQDA start window

You can enter your name or initials in the user field, so that all of your actions, whether
they be importing documents, coding segments, or writing memos, are marked with your
user signature. This user system is especially helpful when you are working in a team. You
can then look to see who in the team did each action.
If you aren’t yet familiar with MAXQDA, it is a good idea to start by reading the MAXQDA
Introduction file, which is available as a PDF in the help menu under the ? drop-down
menu. You can also access a free tutorial on the website at www.maxqda.com.
For those that have worked with previous versions of the software, it is important to know
that you can open projects from previous versions of the software (with the format .mx3,
.mx2, or .m2k), which will then be transformed to the MAXQDA 10 format .mx4. When
selecting the old project to open, it is necessary to select the appropriate format in the
project dialogue field.
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Important: It is strongly recommended that you regularly create project backups and save
them on various external hard drives or flash drives, so that you minimize losses in the case
of computer problems.

3.2 The Main Menu
After opening or creating a new project, you will see the MAXQDA interface, which is designed similar to many other Windows programs. At the very top of the screen, you will see
the project document name including the location where it is saved.
Underneath the file name, you will see the drop-down menus and various toolbars with
buttons that offer quick access to frequently-used functions. As is the case with other Windows programs, the various toolbars can be dragged to other locations on the screen.

MAXQDA Standard toolbar

In addition to the main toolbar (“MAXQDA standard”), there are seven other toolbars that
can be shown or hidden as necessary.
The “Code” toolbar offers quick access to functions for coding, linking text segments, and
turning on/off Edit Mode.

Code toolbar

The “Document navigation” toolbar makes it easy to navigate within PDF documents and
zoom in and out in the “Document Browser”.

Document navigation toolbar

The “Media player” toolbar makes it possible to play audio and video files connected to
texts and insert time stamps.

Media player toolbar

The “Highlight coding” toolbar has five icons, which allow you to highlight/color code
segments of text in a document.

MAXQDA Screens and Menus
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Highlight coding toolbar

The “Visual tools” toolbar has seven symbols, giving you quick access to the mapping tool
MAXMaps as well as the visualization functions “Code Matrix Browser”, “Code Relations
Browser”, “Document Comparison Chart”, “Document Portrait”, “Codeline”, and “Crosstabs”.

Visual tools toolbar

The “MAXDictio” toolbar makes it easy to access six of the most common functions in the
add-on module MAXDictio for quantitative, dictionary-based content analysis.

MAXDictio toolbar

The last toolbar “Language selection” allows you to switch interface languages with a single click.

Language selection toolbar

The four main MAXQDA windows are located below the toolbars:
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The
four main MAXQDA windows

The four windows have the following functions:
 The “Document System” (top left) provides an overview of all the documents that have
been imported into the project. You also have the option of organizing these documents in document groups, which act as folders.
 The “Code System” (bottom right) displays all the codes and subcodes that you have
created along with the number of times each of the codes has been used.
 The “Document Browser” (top right) displays one of the documents from the „Document System“, where it can then be worked on. You can highlight, edit, code, create
links, or attach memos in this window.
 The “Retrieved Segments” window (bottom right) is a results window. Document segments will be displayed here according to the documents and codes that you have chosen in the „Document System“ and „Code System“.
Each window has a toolbar, which gives you quick access to frequently-used functions. By
hovering over each symbol, you can see what each symbol does. Symbols that are found in
more than one toolbar always have the same function, such as:
prints out the content of the window
exports the content of the window
allows for context search in associated window
maximizes the window to the largest possible size
closes the window

MAXQDA Screens and Menus

19

All four windows can be shown or hidden in various ways so that you can control the arrangement of windows on your screen and optimize your work space.
1. You can hide or show the windows through the drop-down menu.
2. You can hide or show the windows by clicking on the appropriate icons in the MAXQDA
Standard toolbar.
3. You can close the windows by clicking on the appropriate icon in the upper-right hand
corner of each window. Next to the close icon, you also have the option of clicking to
maximize the window to its largest possible size.

Hide or show windows via the drop-down menu or the four icons in the Standard toolbar.

You can hide or show all windows, but at least one window must be shown at all times,
which means it isn’t possible to close all four windows.
The main MAXQDA toolbar should always be visible. It contains buttons that give you quick
access to the most commonly-used functions. The buttons have the following functions:

Overview of the buttons in the Standard toolbar

The optimal setup of your windows in MAXQDA 10 depends largely on the size of your
monitor and the set resolution. It is not recommended that you use a resolution smaller
than 1024 x 768. You will generally work with MAXQDA with all four main windows visible, closing certain windows only for specific steps in your research. The size of each window in comparison to the others can be adjusted as you wish by clicking with the left
mouse button on a border and dragging it in the appropriate direction.

20

The Main Menu

Window height and width can be adjusted by clicking and dragging borders with the mouse

In the standard setup, the windows are set up with the „Document System“ and „Code
System“ on the left side of your screen.
It is possible to change this in MAXQDA 10, assigning the „Document System“ and „Code
System“ to the right side of your screen. To do so, open the Options in the Project dropdown menu. Changes to these options will be implemented the next time you start the
program.
If you are importing many texts at one time that you want to assign to various document
groups, it is recommended that you maximize the „Document System“ to see it in its largest viewable form.

Maximizing a window

When coding a document, it is sometimes helpful to close the „Document System“ and
„Retrieved Segments“ window, so the „Code System“ and “Document Browser” are larger. The “Document Browser” can then be made even bigger by dragging the border in the
direction of the „Code System“.
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Optimal window setup when coding

It is similarly helpful to close the “Document Browser” when you are doing text retrievals,
so you have access to the three necessary screens while maximizing the size of your „Retrieved Segments“ window. Whenever you now click on the text information box in the
„Retrieved Segments“ window, the corresponding text will be open in the “Document
Browser” window.

The maximized Code System window

The “Document Browser” window includes the coding column, a gray area left (or right) of
the text document in which codes are displayed. To adjust the width of the coding column,
move the mouse pointer to the top of the line separating it from the document, press the
left mouse button, and drag the column to the left (or right) side of the text.
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Adjusting the width of the coding column

You can choose whether or not the to display the names of each code by clicking on an
empty spot in the coding column and right-clicking. A window will then appear that allows
you to change this setting (see Visualization of Coded Segments in the Document Browser).
Access to functions of MAXQDA are available in the drop-down menus, the toolbars at the
top of the main window, and at the top of each of the four windows representing the four
workspaces. The drop-down menus can be opened by left-clicking on them or by using the
keyboard shortcuts. The long list of shortcuts can be viewed by clicking on Keyboard
shortcuts in the “?“ drop-down menu. Standard shortcuts were used whenever possible,
such as Ctrl+C for copy, Strg+V for paste, etc.
The main MAXQDA toolbar includes the following menus:

The MAXQDA toolbar

The drop-down menus offer the following functions:
Project Menu
In the Project menu, you can choose to create a new project, open an existing project, or
complete other project management functions like printing, exporting, and importing. This
makes it possible, for example, to print out the „Document System“, the „Code System“,
the „Retrieved Segments“ window, and the currently opened document in the “Document
Browser”. You can also change the user name or access the options menu to change your
settings.
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Edit Menu
Here you will find, as in all Windows programs, options to cut, copy, and paste text into the
Windows clipboard. In MAXQDA, these options are possible only when the “Document
Browser” is active. Moreover, you’ll find options like undo and undo all.
Document Menu
In this menu, you can create a new document group or a new document or import documents. A special function also allows you to import structured document forms.
The document shown in the “Document Browser” can also be printed or exported, and the
overview of links in the project can be called up. This last function is explained in the section about Links: Document Links, External Links, Web Links, and Geolinks.
Code Menu
This menu offers functions that connect to your codes, and some of the functions can also
be accessed by right-clicking in the „Code System“ window.
The available functions allow you to create a new code, view an overview of code frequencies, or create a complete index of all codes assigned to all document segments.
You also have the option of printing the „Code System“, importing or exporting the „Code
System“. The list of all coded segments can be printed or exported.
Memo Menu
The Memo Manager is the most important function in this menu and gives you a table with
an overview of all the memos in the project. This includes all memos including document
memos, document group memos, code memos, and free memos. You can view and edit
each memo in this table as well as sort the memos according to any of the column headings.
The menu also offers various selection functions: only memos of open documents, only
memos from certain users, etc. (see Memos: Managing Your Ideas).
Variables Menu
The variables menu allows you to create, edit, and set values for document variables (see
Variables), as well as switch between the various variable views. You can also import or export variables from this menu and call up code variables.
Analysis Menu
This menu offers many different options related to the lexical search and retrieval functions.
The lexical search option allows you to search within documents (or just the activated documents), memos, and retrieved segments. The search function can be used to search for
certain words, phrases, or character combinations. The documents to be searched can be
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chosen in various ways. You can search for keywords in context and automatically code the
hits that are found (see Searching for Text: The Lexical Search).
Most of this menu’s functions relate to retrieval (Retrieval: Finding Coded Segments). You
can select various criteria for the segments to be found (e.g. OR, AND, logical combinations, NEAR, etc.).
The retrieved segments can also be filtered according to various criteria in the „Retrieved
Segments“ window, based on a weight filter and/or the inclusion/exclusion of subcodes.
Mixed Methods Menu
This menu includes various functions for the combination of qualitative and quantitative
data using documents and variables. The logical activation, found in the section Activation
by Variable: Variables as Selection Criteria for Retrievals, allows you to activate documents
or document groups based on their assigned variables, thereby limiting the retrievals to certain document segments. The Quote Matrix and Crosstabs functions are different visualizations that show connections between coded segments and selected variables or variable
categories. The Typology Table is similar and shows percentages and/or mean values and
standard deviations for qualitatively-designed typologies.
Visual Tools Menu
This menu offers seven different visualization function options. MAXMaps, the tool for qualitative modeling; the Code Matrix Browser; the Code Relations Browser; and the Document
Comparison Chart are all for numerous or all of your documents; and the Document Portrait and Codeline visualizations apply only to one document at a time, which means that
they can only be selected when a document is activated in the „Document System“.
Windows Menu
This menu allows you to hide or view each of the four main MAXQDA work area windows.
MAXDictio Menu (optional)
This menu is only available if you the MAXDictio module is installed. It is an add-on, which
offers a number of functions for quantitative content analysis, e.g. coding according to
created dictionaries and viewing word frequencies.
Language Menu
Here you can select which language you would like to view the MAXQDA user interface in.
Toolbars Menu
The eight MAXQDA toolbars can be turned on or off in this menu. After turning on a toolbar, you can move the toolbar around, freely placing it anywhere on your screen. If a toolbar is closed and then opened again, it will reappear where it had last been placed.
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Help Menu (?)
Here you will find the Introduction to MAXQDA in PDF format, which may be helpful to
print out. You will also find detailed help and links to the online tutorials, which give you a
quick introduction to the program. You can also search for an update and download the
update if you don’t have the most recent version. The Tips and Tricks option opens a window with a number of helpful hints for working with the software.

3.3 Context Menus and Toolbar in the Document System
In addition to using the various drop-down menus, MAXQDA also makes it possible for you
use the toolbar and context menu in each window to access functions and commands. In
the „Document System“ window, most options in the context menu connect to functions
regarding your documents.

3.3.1 Toolbar
The toolbar at the top of the „Document System“ window offers quick access to the following frequently-used functions:
Reset activations
Print Document System
Export Document System in RTF or XLS/X format
Activation by document color
Context search allowing for searches for a specific document name
Maximize window
Hide window

3.3.2 Documents and Document Groups
In order to better organize your documents, it is possible to create document groups, which
documents can then be moved to. In MAXQDA 10, it is not, however, absolutely necessary
that each document be put in a document group. Documents can simply be left in the main
“folder.”
Documents can also be temporarily grouped together from various document groups for
certain aspects of your analysis. In MAXQDA 10, these are called document sets.
Example: In an interview-based study on Kindergarten where teachers, administrators, and
parents are interviewed, it makes sense to make three folders, one for each category of
interviewees. All interview transcripts would be imported into the project (perhaps called
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“KindergartenStudy”) and then assigned to one of the three created document groups,
named “Administrator,” “Teachers,” and “Parents.”
In the „Document System“, it is possible to differentiate between three levels, each level
offering a different context menu:
 the project level
 the document group(s) level
 the document level

Three levels in the Document System window

3.3.3 The Upper Level
The upper level in the „Document System“ hierarchy is the project level. After creating a
new project, the „Document System“ is empty except for the Documents icon. By rightclicking on this icon, you will call up the following context menu:
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Context menu for the upper level in the Document System

The menu contains the following functions:
Activate all documents – activates all documents in the entire project file.
Deactivate all documents – deactivates all documents in the entire project.
Logical activation – allows you to activate documents based on their document variables
(e.g. to activate GENDER = Male, AGE > 29, Education = High School).
Invert activations – activates all documents that are not currently activated and deactivates all those documents that are currently activated. This is especially helpful when
doing logical activations; you can then very quickly call up segments from documents with the contrasting document variables.
----------------------------Memo – creates a memo that can hold information about the entire project.
-----------------------------
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Overview of coded segments – list all coded segments from the entire project in table
form.
Overview of memos – lists all memos in the entire project in table form.
Overview of variables – shows a matrix with all variables in the entire project.
Overview of links – lists all links in the entire project in table form.
Tag cloud – creates a visualization of the 50 most frequently-used words in the entire
project.
----------------------------New document group – creates a new document group.
Sort document groups – sorts all document groups alphabetically from A to Z.
Sort document groups – sorts all document groups in reverse alphabetical order.
----------------------------Create document – inserts a new, empty document with a default name into the „Document System“. The document is also automatically opened and put in Edit Mode, allowing
you to immediately type content into the document.
Import document(s) – allows you to import document(s) into the project. They will be inserted at the highest hierarchical level of the „Document System“. After clicking on this
function, a standard Windows screen will appear, which allows you to navigate to the document(s) you wish to import. These documents can be in TXT, RTF, DOC/X, PDF, JPG, or GIF
format.
Import structured documents (Preprocessor) – facilitates the import of documents already coded with the help of MAXQDA’s Preprocessor (see Importing Structured Documents).
Import documents from spreadsheet – allows previously-coded text in spreadsheet format (e.g. from an Excel document) to be imported into the project (see Importing Structured Documents)
Transcribe audio/video – facilitates the import of an audio or video file to be transcribed
within MAXQDA (see Working with Audio and Video Files in MAXQDA). The new document name will be that of the chosen audio/video file.
----------------------------Teamwork export – allows for the export of all coded segments, memos, and project variables.
Teamwork import – allows for the import of all coded segments, memos, and project variables.
-----------------------------
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MAXDictio Coder – opens the MAXDictio Coder (requires the purchase of add-on module
MAXDictio).
In MAXQDA 10, it is not absolutely necessary that you create at least one document group.
MAXQDA works with document groups similar to the way Windows Explorer works with
folders. You can create document groups/folders to better organize your documents, but
each document doesn’t have to be put in one. Documents can be moved freely from one
document group to another without having it affect the document in any way.

3.3.4 The Middle Level: Document Groups
A project can contain as may different document groups as you wish to create. A context
menu is also available at the document group level, which offers functions that only affect
that specific document group that was right-clicked on.

Context menu for the middle (document group) level in the Document System

These are the following options available in the document group context menu:
Activate all documents – activates all documents in the document group.
Deactivate all documents – deactivates all documents in the document group.
Sort documents – sorts all documents in the document group alphabetically, from A to Z.
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Sort documents – sorts all documents in the document group reverse alphabetically, from
Z to A.
----------------------------Memo – creates a memo that can hold information about the document group.
----------------------------Create document – inserts a new, empty document with a default name into the document group. The document is also automatically opened and put in Edit Mode, allowing
you to immediately type content into the document.
Import document(s) – allows you to import document(s) into the document group. After
clicking on this function, a standard Windows screen will appear, which allows you to navigate to the document(s) you wish to import. These documents can be in TXT, RTF, DOC/X,
PDF, JPG, or GIF format.
Import structured documents (Preprocessor) – facilitates the import of documents already coded with the help of MAXQDA’s Preprocessor into the document group (see Importing Structured Documents).
Import documents from spreadsheet – allows previously-coded text in spreadsheet format (e.g. from an Excel document) to be imported into the document group (see Importing
Structured Documents)
Transcribe audio/video – facilitates the import of an audio or video file to be transcribed
within MAXQDA into the document group (see Working with Audio/Video Files in MAXQDA). The new document name will be that of the chosen audio/video file.
----------------------------Delete document group – deletes the document group, including all documents, coded
segments, memos, and variables that are associated with it. MAXQDA only completes the
deletion after confirming that you do indeed wish to carry out the action.
Rename document group – lets you give a new name to the document group.
----------------------------Overview of coded segments – list all coded segments from the document group in table
form.
Overview of memos – lists all memos in the document group in table form.
Overview of variables – shows a matrix with all variables from the document group.
Overview of links – lists all links in the document group in table form.
Tag cloud – creates a visualization of the 50 most frequently-used words in the document
group.
-----------------------------

MAXQDA Screens and Menus

31

Teamwork export – allows for the export of all coded segments, memos, and variables
from the document group.
Teamwork import – allows for the import of all coded segments, memos, and variables
from the document group.
----------------------------MAXDictio Coder – opens the MAXDictio Coder for the document group (requires the
purchase of add-on module MAXDictio).
----------------------------Document sets are handled similarly to document groups. They are a temporary grouping
of documents, but only contain links to the documents instead of the documents themselves. The context menu that appears when you right click on a document set are similar
to the document group context menu, but they do not contain the options to import documents.

3.3.5 The Lower Level: The Document
A context menu is also available at the individual document level and contains a variety of
functions connected to the document you have right-clicked on.

Context menu for the lowest (document) level
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The menu contains the following functions:
Activate document – activates the document; if the document is already activated, the
option will be to deactivate it.
Open document – opens the document in the „Document Browser“. The document
opened in the „Document Browser” is always visualized in the „Document System“ with a
pen symbol.
Open document in a new tab – opens the document in a new tab in the „Document
Browser”. The document will also be visualized with a pen symbol in the „Document System“.
Document memo – creates a memo for the document.
Color – opens a window that allows you to select a color for the document.
----------------------------Delete document – deletes the document including all connected information, including
memos, coded segments, variables, etc.
Rename document – allows you to give the document a new name.
----------------------------Overview of coded segments – list all coded segments from the document in table form.
Overview of memos – lists all memos in the document in table form.
Overview of variables – shows a matrix with all variables in the document.
Overview of links – lists all links in the document in table form.
Document Portrait – opens a visualization of the document that uses the code colors of
the coded segments in the document to create a picture of the document. The size of the
coded segment acts as the weighting factor, meaning that the longer the coded segment,
the more space that color takes up in the visualization.
Codeline – opens a visualization of the coded segments of the document. A matrix is
created with the codes on the y-axis and the paragraph numbers on the x-axis. It is then
possible to see which codes were used in each paragraph of the document.
Tag cloud – creates a visualization of the 50 most frequently-used words in the document.
----------------------------Teamwork export – allows for the export of all coded segments, memos, and variables for
the document.
Teamwork import – allows for the import of all coded segments, memos, and variables
for the document
-----------------------------
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MAXDictio Coder – opens the MAXDictio Coder for the document (requires the purchase
of add-on module MAXDictio).
Properties – opens a window with all the properties of the document, which you can then
edit (e.g. whether or not the document should be read only). It is also possible to link the
document to an audio or video file, so you can have a direct connection between a transcription and the original audio/video file.

3.4 Context Menus and Toolbar in the Document Browser
3.4.1 Toolbar
The “Document Browser” is the main work area in MAXQDA; in it you will code, write
memos, link document segments, insert external links, etc. The majority of the functions
you will carry out in the “Document Browser” are available in the context menu, which you
can access by simply right-clicking in the window. The most commonly-used functions are
also available in the toolbar at the top of the “Document Browser”. It contains the following functions:
Print „Document Browser“ (with or without memos and coded segments visualized)
Export „Document Browser“ in RTF or PDF format
Coded segments color filter, which allows you to choose which coded segments
should be visualized in the coding column based on their color
Context search, allowing for searches within the open document
Maximize window
Hide window

3.4.2 Tabs
MAXQDA 10 includes the option of opening more than one document in the „Document
Browser“ at once, each opened in a separate tab. This allows you to switch quickly back
and forth between documents. Once you have opened documents in tabs, you can switch
to any of them by clicking on the appropriate tab at the top of the „Document Browser“.
Documents can be opened in tabs by holding the Shift key and double-clicking on the document or by right-clicking on the document and selecting Open in a new tab.
Once a document has been opened in this way, tabs will appear at the top of the „Document Browser“ with the names of each of the documents open. You can switch between
the documents by clicking once on the appropriate tab. The tabs can be closed individually.
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If tabs are already open, a document opened in the normal fashion from the „Document
System“ will appear in the currently selected tab in the „Document Browser“.

3.4.3 Context Menu
If you highlight a segment of text or select a section of a picture opened in the „Document
Browser“, a context menu will appear with a large selection of various functions.

Context menu of a highlighted segment of text in the Document Browser

Most of the available functions are self-explanatory, but they will still be explained quickly
in the following section.
Undo text changes – undoes the most recent change to the text (only works when in Edit
Mode).
Undo all text changes – undoes all changes to the text that have been done since Edit
Mode was turned on (only works when in Edit Mode). (See Editing and Opening Documents.)
----------------------------Cut – cuts the highlighted text out of the document as in Microsoft Word.
Copy – copies the highlighted text as in Microsoft Word.
Paste – pastes the text that had been copied or cut as in Microsoft Word.
-----------------------------
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Wrap and line number – sets the number of characters that should make up each line
and sets each line to be handled as a paragraph. Since this function changes the text, it is
necessary to turn on Edit Mode to use this function (see Editing and Opening Documents).
Read-only documents can also not be edited in this way unless you change the permission
settings to make the document editable.
----------------------------Code with a new code – codes the highlighted text or section of a picture with a new
code that you will be able to create after clicking on this option.
Code in-vivo – codes the highlighted text with a new code created and named with the
highlighted text.
Code with “xyz” – codes highlighted text or section of a picture with the most recent
code used.
Code with selection – codes highlighted text or section of a picture with all activated
codes in the „Code System“.
----------------------------Insert document link – sets an anchor for a text link, which is a connection between two
sections of a text or image.
Insert external link – opens a window to allow you to choose a document to be linked to
the highlighted section of the text or image.
Insert geolink – opens a window where you can select a KML file, which will be the reference for your geolink inserted in the highlighted text or section of picture.
Remove link – deletes the link at the section where you right-clicked.
----------------------------Show geolink bar – displays the geolink column next to the memo and code visualization
column next to the text in the „Document Browser“. All geolinks are visualized with a symbol in this column.
----------------------------Insert memo – creates a memo next to the section of text where you right-clicked.

3.5 Context Menus and Toolbar in the Code System
3.5.1 Toolbar
The toolbar at the top of the „Code System“ window offers quick access to the most
commonly-used functions in this window. These functions are:
Reset activations
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Print Code System
Export Code System in RTF or XLS/X format
Create new code
Opens the Code Browser window, which is an alternative view of the „Code System“ and the code memos. It can be especially helpful if you want to create many codes at
one time.
Activation by code color, allowing codes to be activated based on their assigned
colors.
Switches between the standard hierarchical view of the Code System and a
matrix view.
Context search allowing for searches for codes within the „Code System“
Maximize window
Hide window

3.5.2 The Upper Level in the Code System
When you create a new project, the „Code System“ is empty except for the „Code System“ icon and label. This represents the root directory or folder, the upper level of the
„Code System“ hierarchy. If you right-click on the symbol or the label next to it, you will
see the context menu that looks as follows:

Context menu for the upper level of the Code System
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This menu offers access to the following functions:
Activate all codes – activates all codes in the entire „Code System“.
Deactivate all codes – deactivates all codes in the entire „Code System“.
Activation by code variable – allows for activation based on code variable values (e.g. by
speaker in a group discussion).
Invert activations – activates all currently deactivated codes and deactivates all currently
activated codes in the entire „Code System“.
Activate codes together with subcodes – sets preference that all subcodes automatically
be activated when top level codes are activated.
----------------------------Overview of coded segments – opens a table with all coded segments coded with any
code in the entire „Code System“.
Overview of linked memos – Opens a list of all memos that are linked to any code in the
„Code System“.
----------------------------New code – creates a new code. The shortcut keys Alt+N can also be used for this function.
Sort codes – sorts all codes in the upper level of the „Code System“ hierarchy.
----------------------------Export Code System – exports and saves the „Code System“ as a file.
Import Code System – imports a saved „Code System“ (must have originally been exported from the upper level of the „Code System“).
----------------------------Load activation – implements activations/deactivations based on a saved set of code activations.
Save activation – saves the current code activations as a file, which can later be opened to
re-implement current activations/deactivations.
----------------------------Code with selection – codes the currently highlighted text or image segment in the Document Browser with all currently-activated codes.

3.5.3 The Lower Level: Individual Codes and Subcodes
There is also a context menu for the single code/subcode level, which offer functions that
affect the code you right-clicked on.
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Context menu on the code/subcode level

The following functions are shown in the context menu:
Activate/Deactivate – activates or deactivates the code, depending on whether it is currently activated or not. If this code has subcodes, they too will be activated (or deactivated)
if the option in the following context menu row is selected. If you do not wish to activate
all subcodes, they can be individually deactivated by right-clicking on them and selecting
the appropriate option in the context menu that appears.
Activate codes together with subcodes – automatically activates subcodes of the current
code when it is activated.
----------------------------Code – codes the currently highlighted text or image segment in the „Document Browser“
with the current code.
Color – opens a window where you can set a color for the code.
Code memo – creates a memo for the current code.
Transform into a variable – creates a numerical document variable with the name of the
current code in the variable list. The number of times the code appears in each document is
entered as the variable value for each document.
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Transform into a categorical variable – creates a new string variable whose value for
each document is the subcode that appears most often in that document (only works for
codes that have subcodes).
Intersections – shows a list of all codes that intersect with the current code. The code that
intersects most often is listed first.
----------------------------Delete code – removes the code, its subcodes, and all coded segments for that code from
the project. In the alternative view of the „Code System“, more than one code can be highlighted and deleted at the same time. A confirmation window will appear to make sure
that you really want to delete this code. Only after confirmation will the deletion be carried
out.
Rename code – allows you to create a new name for the code.
Copy subcodes – copies all subcodes so that they can be pasted into another code.
Copy coded segments – copies all coded segments for the code, so that they can be copied into a different code. After choosing this option, right-click on the code that you
would like to paste these coded segments into and select Insert coded segments from …
Move coded segments – cuts the coded segments from the current code, so you can insert them in a different code. After selecting this option, right-click on the code where you
want to move the coded segments to and select Move coded segments from … A window will appear confirming that you really wish to move the codes, and after you confirm
this, the coded segments are moved.
----------------------------Overview of coded segments – opens a table with all coded segments coded with the
current code, offering an overview of the text and image segments assigned with the code.
Overview of linked memos – Opens a list of all memos that are linked to the current
code.
----------------------------New code – creates a new subcode for the current code.
Sort codes – sorts all subcodes of the current code in alphabetical order.
----------------------------Add code to code favorites – adds the current code to the list of code favorites in the
quick code bar (see Coding with Code Favorites).
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3.6 Context Menus and Toolbars in Retrieved Segments
3.6.1 Toolbar
The following commonly-used functions are available in the toolbar at the top of the „Retrieved Segments“ window:
Print „Retrieved Segments“ window (all information about each coded segment is
included in the printout).
Show as Excel table – opens the retrieved segments in an Excel document in XLS/X.
Show as HTML table – opens the retrieved segments in your standard browser.
Export „Retrieved Segments“ window (in RTF or XLS/X format with associated
information).
Overview of Retrieved Segments – shows all retrieved segments in table form.
Code retrieved segments (with an existing code).
Code retrieved segments with a new code – opens the window for creating the
new code that should be used to code all retrieved segments.
Context search allowing for searches within the retrieved segments.
Maximize window
Hide window

3.6.2 Context Menu
All coded segments in the activated documents that were coded with the activated codes
are shown in the „Retrieved Segments“ window.
To the left of each of these segments is a yellow info box with information about that segment. The info boxes tell you in which document group, document, and paragraph the
segment is found and which code was assigned to it.

Clicking on the yellow info box opens the original document in the Document Browser and highlights the
document segment

MAXQDA Screens and Menus

41

If you right-click in the gray area on the left side of the „Retrieved Segments“ window
(not on an info box), a context menu appears.
This menu offers access to a number of different features that affect the way segments are
received in this window. You can, for example, set how retrieved segments should be
sorted or how activated codes are linked to each other.
The retrieved segments can be sorted according to the document in which they are found
(according to the order of documents in the „Document System“), according to the code
they are coded with (according to the order of codes in the „Code System“), or according
to the weight assigned to each coded segment.
By clicking on the Text retrieval option, you can select one of ten different ways activated
codes should be used to retrieve coded segments. These include simple options, like OR or
INTERSECTIONS, in addition to more advanced options.

Context menu in the gray area of the Retrieved segments window

Here are all the available functions in the context menu:
Text retrieval – opens the window that allows you to select the text retrieval variation.
Here you can choose, for example, to find intersections.
----------------------------Ordered by Document System – sorts retrieved segments according to the document it is
found in (listed in the order of the documents in the „Document System“).
Ordered by Code System – sorts retrieved segments according to the code it was coed
with (listed in order of the codes in the „Code System“).
Ordered by weight – sorts retrieved segments according to the weight assigned to them.
----------------------------Include subcodes – automatically includes all subcodes in the retrieval for each code activated in the „Code System“.
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Use weight filter – displays only those retrieved segments that are within a certain weight
range.
Edit weight filter – opens a window where you can change the range of weight scores
included in the „Retrieved Segments“ window. The default weight assigned to each coded
segment can be set by clicking on Options in the Project drop-down menu.
----------------------------Overview of retrieved segments – shows all retrieved segments in table form.
Code retrieved segments – opens a window that allows you to select a code to use to
code all retrieved segments in the window.

3.7 Use of Tables in MAXQDA
3.7.1

The Toolbars in Tables

There are many situations in MAXQDA where tables are used to display information, and
they are similar in how they can be worked with, which is similar to the handling of tables
in Excel. All table overviews have a toolbar offering quick access to frequently-used functions.
The overviews include various icons depending on their function and purpose. The following icons are found in some of these toolbars:
Excel table – shows the current table in an Excel document. This does not happen
within MAXQDA, but can be printed out or saved as a separate file.
HTML table – shows the current table in an HTML document. This can also be saved
or printed out, but is no longer connected to your MAXQDA project.
Export – saves the content of the table in XLS/X, HTML, RTF, or TXT (tab delimited)
format in a specified location on your computer and opens the file. This exported file is also
no longer connected to your project file.
Close window

3.7.2

Customizing tables

Tables in MAXQDA can be customized as in Excel or other similar spreadsheet programs.
For the following example, we’ll use the table view of the document variables (see Variables) in MAXQDA:
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Table view of an example project’s document variables

The heading of each column has the name of each variable, although the standard MAXQDA system fields are written in a different font color:
 Document group – the name of the document group
 Document name – the name of the document
 Creation date – the date on which the document was imported
 Author – the user that was logged in when the document was imported
 Bytes – the size of the document in bytes
 Number of coded segments – the number of coded segments in the document
 Number of memos – the number of memos in the document
The width of each column can be changed by clicking and dragging the border between
the columns. Double-clicking on the column header border to the right of the column resizes the column to its optimal size, so that the contents of each row can be fully seen.
It is also very easy to change the order of the columns. You just need to click on a column
header and drag it to the place you wish to have it.
By right-clicking on a column header, the context menu appears for that particular column.
This includes various options, including the option to hide the column or search within the
column. The Select field option opens a window where you can select which of the columns should be viewed in the standard view.
Tables can be sorted very easily. Just click on the column header of the column that you
want to sort the rows by.
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Sorting the a table by clicking on a column header

Tables can be sorted alphabetically or in reverse alphabetical order. Clicking once on the
column header sorts it alphabetically; clicking a second time sorts it in reverse. A small triangle appears in the column header of the column that is currently being used to sort the
table and whether it is sorted alphabetically or in reverse alphabetical order.
Tables in MAXQDA contain both editable (blue) and un-editable (black) columns. The system variables, for example, cannot be edited. You would therefore need to change the
document name in the „Document System“ and change the document group of a document by dragging it to a different document group in the „Document System“.
In the editable cells of the table, you can enter or change a value by double clicking on the
cell and then typing the value.
The table contents can also be selected and copied into the Windows clipboard. Selection is
done as in Excel or Windows Explorer – a single cell can be selected by simply clicking on it,
and additional cells can be added to the selection by holding the Ctrl or Shift key and clicking on the cells.
The selected sections of the tables in MAXQDA are colored differently than the sections not
selected (usually yellow). By clicking Ctrl+C, the selection is then copied to the Windows
clipboard. You can then paste the copied selection by going to another program clicking
Ctrl+V or choosing Paste from the Edit drop-down menu. If a selection is pasted into Microsoft Word, the columns are separated by a tab, and each row is separated by a hard
return. If you want to view the contents again as a table in Word, simply highlight all content and click on Table > Convert > Convert Text to Table.
You can also search for certain values within each column of tables in MAXQDA. You only
need to right-click on the column in which you want to search and select Search. In string
fields, the search will start with the initial character. If you wish to search for a certain word
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or phrase that does not have to appear at the beginning of the value, you can use the asterisk (*) at the beginning of your search.
All overviews in MAXQDA have context menus that can be called up by using the right
mouse button. The number of options that appear in the context menu depends on the
overview. It is usually possible to delete a selection (e.g. a coded segment or memo). In the
Overview of Coded Segments, you also have the option to change the weight score of each
segment. The most options are available in the variables table.

Context menu in the variables table

3.7.3

The Overview of Coded Segments Table

The Overview of Coded Segments is different from the Overview of Variables in that it is
split into two sections. The lower section is just like other tables, while the upper section
serves as a detailed view. The upper section displays the coded segment that is selected in
the lower section.

3.8 The Status Bar
At the bottom of the MAXQDA screen, you will see a status bar that includes information
about various aspects of your current workspace (e.g. the number of activated documents
and codes, the number of retrieved segments, the current retrieval option, etc.)
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The Status Bar
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4 Documents and the Document Browser
4.1 General Information about Documents in MAXQDA
MAXQDA can
 import all types of TXT, RTF, and DOC/X files without using any special formatting options unless you want to use certain MAXQDA functions or achieve a specific document
appearance,
 import all RTF documents with a certain structure (e.g. forms),
 import PDF documents,
 import pictures and graphics in JPG or GIF format,
 import audio and video files in order to analyze them and the transcripts at the same
time,
 create new blank documents that are freely editable by typing or pasting content from
the Windows clipboard.
Important: DOC/X documents can only be imported in MAXQDA if you have Microsoft Office installed on your computer. Otherwise, it is necessary to save the documents in RTF
format and import them that way into MAXQDA.
All DOC/X and RTF documents imported into MAXQDA can be edited in the „Document
Browser“. This means you have the option of fixing typos, deleting or adding text, etc. This
is also possible once you have done some coding and/or memoing. This means you don’t
have to have a completed document to start your coding. PDFs, images, and audio/video
files cannot be edited in MAXQDA.
Usually the documents in MAXQDA have been imported, which means the original document remains at its original location. You can edit, move, or delete this original document
without affecting the imported version. MAXQDA has complete control over the imported
document. This is a significant advantage over many other QDA programs, which only link
to external documents that could be changed or deleted, thereby causing problems for
your research project.

4.2 External Files
In MAXQDA 10 it is now possible for you to connect audio or video files to their transcriptions and import PDF and image files, which means that the “one project = one file” concept is not always optimal. If you were working with many audio/video, image, or PDF files,
for example, your project file would quickly become very large, which would slow down
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processes in MAXQDA and make it almost impossible to move the file from one computer
to another.
For this reason, MAXQDA 10 does not save imported PDF and image files that are larger
than a certain size (default 5 MB) in the project file. Instead it is saved in an external folder.
You won’t notice any difference in the way you work with the documents in MAXQDA; the
icons in the „Document Browser“ look just like they would if the documents were saved in
the project file.
The default maximum size for PDFs and image files can be changed under Options in the
Project drop-down menu. You can also set the location where external files are to be
saved. If you do not change it, the default location for all external files will be as follows:
 for portable license installations: [installed folder]\MAXQDA_Externals
 for normal license installations: [My documents]\MAXQDA_Externals
What actually happens when a PDF or image file larger than the set maximum size is imported into the „Document System“?
1. The document is added to the list in the „Document System“ just as it would be if it
were a smaller file.
2. The document is visualized with the PDF or image icon as is the case with smaller files.
3. The document is copied into the MAXQDA_Externals folder unless you have chosen to
have external files saved elsewhere. The original document remains in its original location.
It is import to remember that unless you change the default folder for external files, this
folder will hold externals for all projects. You will only have a separate folder for the externals of a certain project if you change the external folder in the Options window. It often
makes sense to use the same folder for all of your projects, so that several projects can
access the same external file. It is for this reason that audio/video files are not deleted from
the external files folder when the linked document is deleted; this audio/video file could
also be linked to other documents.
What happens to a document in the Code System when it is linked to a media (audio/video)
file?
1. The location of the original audio/video file is saved in the Properties menu of the document.
2. The original media file is never saved as part of MAXQDA project file, even if it is smaller
than the maximum file size.
3. The media file is copied into the MAXQDA_Externals folder or whatever folder you have
chosen for this purpose. The original document remains in its original location.
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4. When importing the file, MAXQDA looks through the transcript file for any time stamps.
If they exist, a time stamp table is created and the text is synchronized with the audio/video.
Which file is actually used – the original or the copy?
MAXQDA 10 always looks for the original first – it looks for the file based on the path that
is saved in the properties menu of the document. If the original is not found, the copy of
the file in the external files folder is used. This file is then loaded. In other words, the original file can be moved or deleted without it affecting the proper functioning of MAXQDA.
Be careful when using the same file name for different files!
It is possible to import several documents with the same name into the „Document System“ (e.g. three files named “Interview 1”). This is only a problem if the file is larger than
the set maximum and must be saved in the external files folder. When the most recentlyimported file is saved, it automatically replaces the older file with the same exact name.
What happens when you change the external files folder for a project that already has external files saved in the default external files folder?
In this case, MAXQDA will ask you if you would like to move the documents from the previous location to the new external files folder. The documents are only moved once you
confirm this. Since this action changes the global setting for all projects, all files are moved
from the former external files folder to the new.
What happens if a project with external files is passed on to a different computer/MAXQDA
installation?
In order to send the entire project, including the external files, follow these steps
1. Send the MAXQDA (MX4) project file.
2. Bundle all external files with the appropriate function in the Project drop-down menu.
MAXQDA then compresses all external files associated with the current project into a Zip
archive, which is named after your project (e.g. “Projectname.mx4.zip”) and saved in the
same place as your project file.
3. Send this newly created Zip file.
Procedure on receiving end:
4. Open the MX4 project file.
5. Choose Unpack bundle files from the Project drop-down menu and select the Zip
archive in the Windows dialog box that appears. MAXQDA then unpacks the archive
and moves the linked files to your external files folder.
If a document is linked to an audio or video file, the original location of the audio/video file
will be listed in the document properties. If a document with this name isn’t found in the
appropriate folder, the copy in the external files folder will be used.
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Careful!
The changes you make in the options menu in the Project drop-down menu are global,
meaning they change the settings for all of your projects. If you want to use a different external file folder for each of your projects, you have to always remember to change the options every time you work on a different project.

Global options for MAXQDA

4.3 Unicode
MAXQDA 10 is the first QDA software that completely supports Unicode, meaning you can
not only import and analyze documents in any language (from Japanese to Arabic), but you
can also create your codes, variables, document names, etc. in these languages. This Unicode functionality is available in every MAXQDA 10 function
Different countries, different languages, different alphabets – this is no problem as long as
one does research in the Americas or Europe. But what happens if you want to analyze
Russian or Mandarin? With the import of RTF files in MAXQDA 1, it was already possible to
analyze texts in other languages, but that was only the case in the „Document Browser“,
meaning the imported text could be in any language, but the codes could only be created
using Western characters. This meant text searches and in-vivo coding were not possible.
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MAXQDA 2 was then released with additional support for certain languages, so that codes
and searches could include Arabic, Greek, and Cyrillic languages. The „Code System“ could
then handle characters from these languages.
Then with MAXQDA 2007, the software was able to handle Unicode. Unicode is an international standard with the goal of standardizing all known languages and characters. This
makes it possible to work with various languages in the same document. One sentence can
be in English, the next in Mandarin, and the next in Arabic. This is possible because Unicode
(unlike more common computer character systems like ASCII or ISO Latin) can deal with
more than 128 or 256 different characters. In MAXQDA, even codes and variable names
can be created with “foreign” characters, and searches and in-vivo coding are possible with
any language.

4.4 General Information about RTF and DOC/X Formats
Documents can also be created within MAXQDA, but usually it is easier to work with a
document in a word processor or text editor and then import it. It does not matter which
word processor you use as long as you can save the document in RTF or DOC/X format,
which is almost always the case.
There are almost no limits to the options available in RTF and DOC/X format when creating
a document. When transcribing an audio or video file or typing up field notes, it is necessary to develop a transcription system or set of transcription rules.
One option is the simple Hoffman-Riem system, which can be used by anyone looking for
any easy set of rules. It’s translated version is below.
Characters

Meaning

..

short pause

...

medium pause

....

long pause

......

omission

/uh/

filler word

/eh/
((action))

nonverbal communication, e.g. ((shakes head))

((smiling))

nonverbal cues in combination with speech

very

noticeable emphasis or rise in volume

very

drawn out speech

()

indecipherable

(terrifying?)

not clear, but best guess
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RTF and DOC/X formats allow for all sorts of transcription rules so that it isn’t necessary to
preformat things for import into MAXQDA. If you wish to handle certain sections of text as
a single unit, though, it makes sense to have them together in the same paragraph. A new
paragraph number is inserted automatically in MAXQDA after each hard return. It is also
easier then to automatically code these paragraphs in MAXQDA (see Importing Structured
Documents).
Here are the things to remember when importing a text document:
 All formatting aspects – like bold, italics, etc. – are carried over to MAXQDA.
 All fonts and text sizes are carried over.
 Paragraph formatting (e.g. right-justified) is also carried over although the spacing between paragraphs does not necessarily stay the same.
 The text can contain tables, pictures, graphics, etc.
 MAXQDA supports Windows OLE, which means that audio file, PowerPoint slides,
hyperlinks, and video files can be embedded in the file. Double-clicking on these objects
in MAXQDA will open the appropriate program to view or play the file, assuming the
program is installed on the computer. If certain objects are imported or simply linked to
depends on your settings in the Options window in the Project drop-down menu.
The editing of tables within text documents is worth mentioning, as tables with more than
two columns were difficult to work with in older versions of MAXQDA. With MAXQDA 10,
though, this is no longer a problem; you can now easily edit and even code cells in tables
that are embedded in text documents. The only limitation is that the size of the table can
no longer be changed once it has been imported.

4.5 Objects Embedded in Text
MAXQDA supports Windows OLE (Object Linking and Embedding), which means that audio
file, PowerPoint slides, hyperlinks, and video files can be embedded in an RTF or DOC/X file.
The connection between the text document and these objects remains in effect even after
import into MAXQDA.
There are two ways to deal with these embedded objects, which will be explained with the
example of a PowerPoint slide:

The first variation works as follows:
Highlight a PowerPoint slide (e.g. from the sort view) and copy it into the Windows clipboard. You can then paste it into a MAXQDA document by pressing Ctrl+V; the slide can
then be viewed in the document in the „Document Browser“. By double-clicking on the
slide, you will open it in PowerPoint, where you have the option of editing the slide. You
can also code the slide, but MAXQDA handles it as a single object, so lines of text in the
slide cannot be coded separately. Depending on the type and size of the object, it may take
up quite a bit of memory to code it, so only code such objects if it is important for your
analysis.
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Second variation:
Here there is only a link created for the embedded objection (see Links: Document Links,
External Links, Web Links, and Geolinks). These work like hyperlinks in a web browser; you
will be able to tell that a link exists, because the text will be blue and underlined. By hovering the mouse over the link, you can see the name of file linked to that spot. Clicking on
the link opens the file in the appropriate program, assuming that program is installed on
the program you are working with (e.g. PPT files are opened in PowerPoint, audio files in a
media player, etc.). The program that will be opened depends on the computer’s settings.
With the second variation, it makes absolutely no difference how big the linked file is. With
the first variation, though, it is important to be aware of the object size, so the project file
doesn’t become too large. MAXQDA is first and foremost designed for analyzing text documents, so it is not recommended that you use it as a photo archive or as a multimedia
program.

4.6 Hyperlinks Embedded in Texts
Thanks to the expansion of the internet, everyone knows what a link and what happens
when you click on one. Documents imported into MAXQDA can also have hyperlinks in
them. Clicking on the link in MAXQDA brings up the webpage or HTML file in the default
browser.
Hyperlinks are always made up of two parts: the visualization (whether it be a button, picture, or text) and the URL, which is the information about the location of the file, which
may be a WWW address. By hovering over the link, you can see the location/URL in the
tooltip that appears. Usually, this is not otherwise visible.

Hyperlink in a Text

If you want to work in MAXQDA with pictures or other objects that require a lot of memory, it is recommended that you don’t import the pictures into the project file, but just link to
them. The links can still be code and called up in the „Retrieved Segments“ window, but
they don’t affect the size of the project file. Starting with MAXQDA, it is now possible to
import pictures into the „Document System“ and save them either in the project file or externally as external files. Limits for the file size of imported objects are set under Projects >
Options.
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4.7 Importing Documents into MAXQDA
Importing documents into MAXQDA is simple and intuitive: you can simply highlight the
documents in Windows Explorer and drag them with the mouse into the „Document System“. They will then be inserted on the upper level of the „Document System“ hierarchy,
directly under the “Documents” icon. In the following screenshot, you can see that eight
documents (Teresa, Joanna, Jon, etc.) have been imported.

Visualization of eight imported documents in the Document System

By moving the mouse over a document name, you will see a tooltip that gives you information about the document, including its size, the author (user logged in at the time of import), the date of import, and the number of coded segments and memos in the document.
All you have to do is drag documents into the „Document System“, and you’re ready to
start your analysis of those documents. Most people don’t start with the analysis immediately, though, and prefer to organize the documents in folders, as they might do on their
computer’s hard drive. Rather than using folders, MAXQDA uses document groups. They
work just like folders do in Windows Explorer – you can name them and drag documents
into them. The number of document groups is not limited in MAXQDA; you can make as
many of them as you want. When you create a new document group, it will automatically
be named “Group 1,” “Group 2,” etc.

Newly-created document groups are automatically named “Group 1,” “Group 2,” etc.
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Import of documents into document groups can also be done via drag and drop. You just
need to highlight the documents in Windows Explorer and drag them onto the document
group name. You’ll see that the documents are imported into the document group when
the file names appear under the document group icon and name.
You can also import documents via the context menu of a document group or the upper
level Documents icon.
1. Right click on the document group that you want to hold the imported documents and
select Import document(s) from the context menu that appears.
2. A Windows dialog box will appear that allows you to select the documents that you
would like to import.
You can also import documents by using the keyboard shortcuts Shift+Ctrl+T (import to the
upper level) or Alt+T (import to the selected document group).

Importing a document via the context menu

Newly-imported documents are put at the top of the list of documents in the document
group. They are given the same name as the original file, but you have the option of renaming them at any point. If you want to import several files at once into the same document group, you can select more than one document by holding the Ctrl button while
clicking on the documents to import.
The order of document groups in the „Document System“ can also be changed at any
time. You simply need to click on the document group icon and drag it to the location you
would like to have it. In other words, it is not necessary to know how you will organize all
of your documents when you import them.
Careful: If a file is open in another program (e.g. Word), it will not be possible to import it
into MAXQDA. Instead, a box will appear informing you that the import was unsuccessful.
Simply close the document in the other program and try the import again.
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4.8 Opening and Editing Documents
You will know that a document has been imported when its name appears in the „Document System“. To view that document, you can either:
 double click on the document in the „Document System“, or
 right-click on the document in the „Document System“ and choose Open document.
The document is then opened in the „Document Browser“, and the icon next to the name
of the document in the „Document System“ changes from a sheet of paper to a sheet of
paper with a pencil on it.

Symbol in the Document System for a document open in the Document Browser

You can now begin to work with the document in the „Document Browser“. You can code
document segments, attach memos, link segments, insert external links, edit text, or add
new text. There are two different modes for working on a document:
 Code Mode – allows you to code segments of texts or images, create internal or external links, and write memos.
 Edit Mode – allows you to edit text in documents imported from RTF or DOC/X format.
You can type new content, fix typos, and delete text.
Code Mode is active by default when a document t is opened in the „Document Browser“.
Click the Edit Mode button to switch to Edit Mode. When working in Edit Mode, many features you will be familiar with from word processing programs are available. You can
choose the font type, size, and color as well as formatting characteristics such as bold, italics, or underline.

Button for turning Edit Mode on and off

Edited text is automatically saved when you turn of Edit Mode or close MAXQDA, which
means it is not necessary to save your changes in any other way.
When working in Edit Mode, you can undo action by either clicking the Undo button
or selecting the command Undo from the Edit drop-down menu. If you, for instance, have
deleted a word or a paragraph, simply click the Undo button and the deleted text will appear again. If you click the Undo All option from the Edit menu, all changes that have been
made since starting in Edit Mode are canceled, and the text looks exactly the same as when
you switched into Edit Mode.
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Important: The undo function is only available when you are working in Edit Mode. As soon
as you go back to Code Mode or open another document, all changes that you have made
in the current document are saved and can’t be undone.
When importing a document, MAXQDA automatically creates a number of internal variables (formerly known as attributes) that are attached to the document. To see these variables, right-click the document and select Overview of Variables from the context
menu. These internal variables include the size of the document (in bytes), the date and
time it was imported, and the user logged in at the time of import (author). The number of
memos and coded segments in each document is also kept track of as a variable, although
new documents obviously start with zero.

Overview of variables for a newly-imported document

This information will also appear as a tool tip when you move the cursor over a document
name and hold it there for a moment.

4.9 Creating a New Document in MAXQDA
To create a new document without the help of a word processor, you should start by deciding where you want the document to be placed. You can then right-click on the document
group where you want the document to be created and select Create document. The new
document automatically starts with a name like “Document 1,” which you can then change
if you wish. After creating a new document, it is automatically opened in the „Document
Browser“ and put in Edit Mode, so you can start to type or paste text from another program into it.
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Creating a new document via the context menu

There is no need to save your new document. As is the case when editing an imported
document, everything is saved in the new document once you leave Edit Mode, view a different document in the „Document Browser“, or close MAXQDA.
You can also quickly create a new document with the keyboard shortcut Ctrl+T. The document will be created in the upper level of the „Document System“ hierarchy unless you
select a document group by clicking on it before using the shortcut. If you have a document group selected, the new document will be placed underneath that document group.

4.10 Assigning Colors to Documents
You have the option of assigning a color to each of your documents. This color is then used
in all tables and visualizations, including in MAXMaps, MAXQDA’s free mapping tool.
To assign a color, right-click on the document and select Color from the context menu that
appears.
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Color options

There is an almost endless number of colors that you can pick from for your documents,
and you can theoretically mix your own by entering values into the fields on the right side
of the window, although it makes sense to limit the number of colors you use in a single
project.
The document colors are usually listed in the first column of tables in MAXQDA, which
means you can then use them as sort criteria. By clicking on the column header, you will
sort that column, grouping together those documents with the same assigned color.

4.11 Creating Document Sets
MAXQDA makes it possible for you to create and save a temporary grouping of documents.
While each document can only be in one document group, it can be in as many document
sets as you wish, because document sets are only made up of shortcuts to the documents.
In other words, a document set can be deleted without it having any effect on the document. If that same document were deleted from a document group, however, it would be
deleted from the project along with all of its memos, coded segments, links, etc.
Document sets are created via activation. You can activate a document by right-clicking on
it and selecting Activate from the context menu or by clicking on the document while
holding the Ctrl key. You can tell that a document has been activated, because it turns red
and a red arrow appear just to the left of the document icon. You can also activate entire
document groups by right-clicking and choosing Activate or by holding Ctrl when clicking
on it (See Activation: The Principle of Segment Retrieval).
After activating all the documents that you want to create a set out of, you can create that
set by right-clicking on the word Document sets at the bottom of the „Document System“
and selecting New set from the context menu that appears.

60

Renaming and Deleting Documents

MAXQDA then creates a new set with the name “Set 1.” You can click on the name with
the right mouse button and choose another that is more appropriate. Document sets are
manipulated like document groups; you can activate all the documents in a document set
at the same time and use all the options for working with document groups (Codes, Memos, Variables, etc.).
Individual documents can be deleted from a document set or placed in another document
set; the easiest way is by using the drag-and-drop function.
When you want to analyze a certain selection of documents, using a document set is a very
practical method, allowing you to avoid a more complicated selection procedure (see Activation by Variable: Variables as Selection Criteria for Retrievals). Forming a document set is
also an easy way to save the result of a complex activation process.

4.12 Renaming and Deleting Documents
Document groups, document sets, and individual documents can be renamed at any point.
Simply right-click on any of these objects and select Rename from the context menu. It is
not recommended that you have more than one document with the same name. It is possible, but it can be very confusing.
You also have the option of changing the document organization at any point. A document
can be dragged from one group to another, and all associated coded segments, memos,
links, etc. are moved with it. The only thing that is affected is the organization in the „Document System“.
Right-clicking on documents gives you the option to delete them, which also deletes the
coded segments, memos, and links associated with it. It is not possible to undo such a deletion, which is why you must always confirm the action. You can also delete document
groups and document sets. Be aware, however, that deleting a document group also deletes all documents that are in it.

4.13 Sorting Documents
To sort documents in a document group, right-click on the document group and select Sort
documents. There are two options with the same text, but the icons next to them are different. The first indicates that the sorting will be done alphabetically (A to Z), and the
second indicates the sorting will be done in reverse alphabetical order (Z to A).
To sort the document groups by name, simply right-click on the word Documents at the
top of your „Document System“ and select the appropriate Sort document groups option.

Documents and the Document Browser
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Tip: Researchers often work with document names that include numbers (e.g. Interview 1,
Interview 2, etc.). If you are going to have more than 10 documents, it is recommended
that you make each single digit number into a two-digit number (Interview 01, Interview
02, etc.). When sorting the documents, you will then have them in the correct order. Otherwise Interview 20 would come before Interview 3. If you are working with more than 100
documents, all numbers should be written with three digits (e.g. Interview 001, Interview
002, etc.).

4.14 Text Formatting: Wrap and Line Numbers
In some cases, you may wish to analyze documents based on line number rather than paragraphs. There is a MAXQDA function that allows you to set the number of characters that
should make up each line, which will then be treated as a paragraph. To do so, open the
document in the “Document Browser” and switch to Edit Mode. Then right-click in the
document and select Wrap and line number. You can then enter the number of characters that should make up each line (normally a range of 50-70 characters is appropriate).
This option is only available for text documents that do not contain photos, tables, or external links. The result of the procedure is a line-numbered text with a fixed number of characters per line.
As long as the Edit Mode is switched on, you may step back to the original, paragraphnumbered for- mat, but if you leave the Edit Mode and switch to Code Mode or open
another text, then the line numbering is permanent and cannot be removed.
Careful: This action can only be undone while you are in Edit Mode. Once you have left Edit
Mode, opened a different document in the „Document Browser“, or closed MAXQDA, the
changes are automatically saved and irreversible.

4.15 Document Properties
If you right-click on a document in the „Document System“ and select Properties, the following window will appear, which lets you view and change certain settings for that document:
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Document properties window

Read-only – if this box is checked, the document will no longer be editable, even in Edit
Mode. This is the default setting for PDFs.
External Document – If this box is checked, it means that the document is not actually
part of the MAXQDA MX4 project file. Instead it has been copied into the folder for externally-linked files. In this case, the location of the original document will be listed. If you decide at a later time that you want to import the document into the project file after all, you
can do so with the Embed external document button.
Media file – If you want to link a document to an audio or video file, you can insert the
path to that document in this field (see Working with Audio and Video Files in MAXQDA).
Externe Link 1/2/3 – Click in this field to link to another document that can be accessed on
your computer and has pertinent information, for example, about the interviewee or the
project in general.
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5 Importing Structured Documents
5.1 What are Structured Documents?
Often you may wish to import documents that are structured and pre-coded. Examples for
this kind of document include:
 Forms – in this case, text passages should be pre-coded according to the heading field
of the form.
 Results from database retrievals, such as a list of references, should be pre-coded with
author, title, abstract, etc.
 Answers to open-ended questions in survey research – here you may wish to code the
answers with a question number or an abbreviation of the question.
It is often clear even before you start your analysis that certain sections of text are going to
pertain to a certain subject. So, to save the work of manually coding them, you can have
them automatically coded during the import process.
As an example of this type of document, consider the answers to open-ended questions in
questionnaires. Unlike narrative interviews, a document of this kind does not contain thirty
or fifty pages but rather only a few lines, perhaps 10 to 15. Often there will be a large
number of documents, maybe a few hundred or more. Another characteristic of such a
document is that it is pre-structured: certain answers correspond to certain questions. The
normal method of transcription and import into MAXQDA would make importing the documents a very time-consuming job. Every questionnaire would have to be transcribed with
a word processing program and saved as a separate file. Attaching a question to its answer
as a code to its corresponding text passage would not be possible when importing the text.
Also when working with focus groups, it saves a lot of time to code the text passages with
their speakers before importing the text into MAXQDA. The MAXQDA Preprocessor offers a
solution for this type of data.
There are two main options for coding during import: you can use either the Preprocessor
or the Excel table import option.

5.2 Importing Structured Documents with the Preprocessor
The Preprocessor allows you to enter a large number of documents into a single file and
have them separated out into different documents when imported into MAXQDA. The syntax rules are as follows:
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#TEXTtextname
this is the content of the 1st text
...
#TEXTtextname
this is the content of the 2nd text
...
#TEXTtextname
...
Formatting documents for the Preprocessor

Every document must start with the “#TEXT” without a space between “#” and “TEXT,”
and “TEXT” must be written in capital letters.
The name that you want to give to the document should come immediately after the
“#TEXT” without a space in between. If you do not enter a name, MAXQDA will automatically assign one when the document is imported. The first imported document will be called
“Document 1,” followed by “Document 2,” etc. in the „Document System“. This automatic numbering is useful when, for example, you enter the answers to open questions in a
partly standardized survey. The answers must then simply be entered in the order of the
standardized data in the SPSS file. It is not necessary to enter a name for each text. Both
texts will have the same name.
Document names are handled by MAXQDA as follows. You can enter any kind of string (up
to 32 characters) as a document name – spaces are also allowed. If you enter a document
name with more than 32 characters, MAXQDA will truncate it automatically. Once the
document has been imported into MAXQDA, you can change the name to include up to 64
characters.
And what happens if you accidentally import a document with the same name as a document that already exists in the „Document System“? This is not a problem for MAXQDA –
it will simply import the second document with the same name while retaining the first instance as well. It is not problematic for MAXQDA if there are several documents with the
same name. It is still recommended, however, that you change the name of one of the
documents, so that you don’t get confused as you continue your analysis. As is the case
when importing files without the Preprocessor, the most recently imported document appears at the top of the list of documents in the „Document System“. This means that if you
are using the Preprocessor to import several documents from the same file, the documents
at the bottom of the file will be listed first in the „Document System“.
An Example
In the example project, various interviewees were asked about their level of satisfaction
with various aspects of their life. The following is a Word file formatted for import into
MAXQDA with the Preprocessor.
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#TEXT4 (26,f,0k,sin)
I've gained too much weight over the last several years and I don't seem to be doing anything to get
rid of it. I have high cholesterol levels, but I don't attempt to change my eating habits. I'd like to jolt
myself into becoming more physically active, so I can lose the weight and feel more energetic. I keep
saying I'm going to do something about it, soon.
#TEXT3 (34,f,2k,mar)
Overall I am pretty happy with my mental, social and physical health. I would like to improve my dedication to working out. I am the type of person who will work out 5 times a week for a month straight
and then is slowly turns into less days a week until it is none. I get distracted by school work, my job or
just being tired.

…
Section of a Word file formatted for import with the Preprocessor

After each #TEXT entry is the name being given to the document. For the purposes of this
project, it made sense to assign a number for each of the interviewees in addition to some
basic information about that person, including age, gender, number of kids, and marriage
status.
The Word file was then saved in RTF format with the name “HealthSatisfaction.” It could
then be imported by right-clicking on a document group, selecting Import structured
document (Preprocessor), and then choosing the saved RTF file.

Importing documents with the Preprocessor

The document is then imported, separating out each individual document and assigning the
given name for each in the „Document System“ from the original RTF document.
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Documents after being imported with the Preprocessor

In this way, it is possible to very quickly import and separate out many different documents
formerly contained in a single file. The Preprocessor is able to do significantly more than
this simple action, however. In many cases, you will already be able to code aspects of the
document, and the Preprocessor can do that automatically during the import. To do so, you
simply need to use additional syntax words.
For each section of the document that is to be coded, you simply need to type “#CODE”
before and “#ENDCODE” after. In the case of a standardized survey or questionnaire, you
could, for example, code each answer with the question number that it connects to. The
answer to the first question, then, could be coded with the code “Question1” as is shown
below:
#TEXTinterviewee1
#CODEquestion1
answer to question 1
#ENDCODE
#CODEquestion2
answer to question 2
#ENDCODE
#TEXTinterviewee 2
#CODEquestion1
answer to question 1
#ENDCODE
#CODEquestion2
answer to question 2
#ENDCODE
…
Using syntax rules to prepare for import with the Preprocessor

It is important to remember that there should be no space between “#” and “CODE” and
that the word is written in capital letters.
To avoid typos when entering “CODEquestion1,” it is possible to simply use a place holder,
such as “§1” for the first question, “§2” for the second, etc. You can then later do an automatic search and replace, finding all instances of “§” and automatically replacing it with
“CODEquestion.” This can save you a lot of time in addition to helping you avoid typos.
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It is also possible to define and code with a subcode in a document prepared for the Preprocessor. To do so, use the following syntax:
#CODEcodename\subcodename
You are giving the complete information about the subcode, including its name and the
code it is a subcode of. The code and subcode are separated by a “\” symbol, but no spaces. As with any codes used in a document imported with the Preprocessor, MAXQDA will
first check whether the code already exists, and if it does not, it will be created.
Important: it is not possible with the Preprocessor to code the same segment of text with
more than one code. As soon as “#CODE” appears, the new code will be used, automatically ending the coded segment of the previous code.

5.3 Importing Structured Text from a Table/Spreadsheet
In the Document drop-down menu, you will also find the option to Import document
from a spreadsheet. With this function, you can import a number of documents at one
time, with each cell content coded automatically. You can also include variables in these
tables. This function is especially helpful if you are working with standardized online surveys
with open-ended questions.
The table to be imported can be in either XLS/X or TXT (tab delimited) format.
Every row in the table must represent a document, every column represents a code, and
each cell holds a coded segment. The first row contains all the key words, like “Textgroup,”
“Textname,” and then the names of the codes or variables. Variable names must begin
with the “#” symbol.
Example
Textgroup

Textname

Question 1

Question 1

$Variable

Group 1

T1

Text

Text

variable value

Group 1

T2

Text

Text

variable value

If you were to import the table above, you would get the following results:
1. The documents “T1” and “T2” would be created in the „Document System“ under
document group “Group 1.” If any of the documents or document groups already exist,
they will be ignored.
2. The text segments in the column labeled “Question 1” are automatically coded with a
newly-created code called “Question 1,” unless a code with that name already exists, in
which case that code will be used.
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3. If the variable “Variable” did not yet exist, it will be created, and each document (“T1”
and “T2”) will be assigned the variable value in its row. If the document already existed
and already had a value assigned to the variable, this value will be updated with the value in the table.
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6 Links: Document Links, External Links, Web Links,
and Geolinks
6.1 Links in MAXQDA
MAXQDA distinguishes between four types of links:
1. Document links represent a connection between two text or image segments (e.g. to
show the contrast between two interviewees’ responses to the same question, you could
link them with each other).
2. External links create a connection between a text or image segment and an external
document (e.g. a picture, document, audio/video file, etc.) that is not part of the
MAXQDA project.
3. Web links are connections between a text or image segment and a webpage. By clicking
on this link, you can open the website in your standard browser.
4. Geolinks create a connection between a text or image segment and a place on the
globe. This place is based on GPS coordinates and is shown in Google Earth.
You can create or delete links in MAXQDA’s „Document Browser“ or in MAXMaps, the
modeling add-on that allows you to create visualizations of your data and concepts and
show connections between them.
The four types of links are visualized with various symbols in the “Overview of links” (see
Overview of Links).

6.2 Document Links
It is possible to link documents or positions in documents with the help of document links.
Document links are used in the same way as hyperlinks in the Internet; they link two document or positions in document together. Clicking a document link causes the corresponding document link to be loaded.
In MAXQDA, document segments that are in the same document or in different document
can be linked. To link document, select at least a single character from a document in the
„Document Browser“ – normally a word or more is suitable.
Document segments are linked as follows:
1. Select the first document segment (the anchor) and click the blue Document Link symbol
in the coding toolbar (or choose the option Insert Document link from the context
menu). The selected document segment now appears blue and underlined.
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Toolbar button for creating a document link

2. You can now choose the document or document segment that the anchor should be
linked to. This second segment can be in the same document or in a different one. Simply go to the document or document segment and highlight a section of text.
3. To complete the link, simply click again on the Insert link symbol in the toolbar or
right-click on the highlighted text and choose Insert link.
If, after the first step, the user decides against creating the link or wants to change the text
that had been selected, clicking the Remove last link symbol removes it.

Toolbar button for removing a document link

Document links appear underlined and in blue in the „Document Browser“. Holding the
mouse cursor over the text causes a screen tip to appear with information about the linked
document segment: the name of the document and the actual text selected when the link
was made.

Blue underlined text with screen tip

For this reason, it is sometimes a good idea to select not only a word, but a whole sentence
or paragraph as the link.
Simply clicking a document link allows one to jump from the link in the „Document Browser“ to the other linked segment. The document containing the link appears at the position
of the linked segment.
To delete a document link, click the link with the right mouse button and choose Delete
Link from the shortcut menu.
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6.3 External Links
External links are links between a segment of a text or image in MAXQDA and a document
outside of the project (e.g. to link part of an interview transcript in MAXQDA with a picture
of the person saved elsewhere on your computer).
To insert an external link, simply highlight a section of text or image, right-click on it, and
select Insert external link. A window will then appear where you can select the appropriate external document to be linked. This can be on your internal hard drive, an external
medium like a flash drive, or a network location.
External links are also blue and underlined like the document links. When you hover the
mouse over the link, a tool tip appears with the name and location of the linked document.
Double clicking on the link opens the document in the appropriate program. If the segment
is linked to a Power Point slide, for example, it will be opened in Power Point.

6.4 Web Links
Web links in MAXQDA are links between a text or image segment and a website. A web
link can be created as follows:
1. Load the website in your internet browser, highlight the URL (web address), and copy it
to the Windows clipboard (Ctrl+C).
2. Switch over to MAXQDA and highlight the text or image segment to be linked with the
web address.
3. Right-click on the highlighted segment and select Insert external link.
4. A window will appear, asking if you want to insert the copied URL as the link. Choose
Yes.
As is the case with the external links, you can hover over the web link and see the linked
website in the tool tip. Double clicking on the link brings up the website in your standard
internet browser.

6.5 Geolinks
With the creation of programs like Google Earth™ and Google Maps™, it has become
possible to view any point on the globe with the appropriate coordinates. Geolinks or Georeferences are links between elements in MAXQDA and a selected place on the globe. You
could, for example, choose to link each interview transcript in MAXQDA with the place the
interviewee lives.
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With the help of these geolinks you can also show geographic aspects of sociological research data. The use of georeferencing tools, especially Google Earth™, in combination
with software for qualitative data analysis is fairly new. Cesar Cisneros, professor of sociology at Universitaria Autonoma Metropolitan Iztapalapa in Mexico, was one of the first to
use this technique. In 2006, he used geolinks in MAXQDA for a research project in South
America. MAXQDA 10 includes a column in the „Document Browser“ specifically for these
geolinks. To create one, follow these steps:
1. Go to the location in Google Earth™ that you would like to link to. You can then save
the location by right-clicking on it and selecting Save Place As …
2. Choose a location to save the file and make sure to save it as a “KML” file instead of a
“KMZ” file, which is the default.
3. Highlight the text or image segment to be linked in MAXQDA, right-click on it, and select Insert geolink. Simply select the saved KML file in the window that appears, and
the geolink has been created.
The KML file contains the coordinates to the saved place and everything else that Google
Earth™ needs to take you directly to that location. When you click on the geolink in
MAXQDA, Google Earth™ is opened, and you are taken directly to that location.
Geolinks are visualized similar to other links (blue and underlined), but there is also a blue
ball in the geolink column just to the left of the paragraph numbers in the „Document
Browser“, similar to the way a memo is shown. If the column is not shown, right-click
somewhere in the document in the „Document Browser“ and select Show geolink bar.
This bar makes it easy to differentiate between regular document links and the geolinks.
By hovering your mouse over the geolink visualization, you will see the coordinates that are
saved for that location. The screenshot below shows you this below. It is a geolink in the
interview transcript “Teresa”, linking to the place that she lives in “New York City, NY,
USA” at the exact coordinates.

The green ball symbol to the left of the paragraph numbers indicates that the link in the
document is a geolink
A copy of the KML file is automatically saved in the MAXQDA folder for externals, which
means that the file does not become part of the project file. Having all external files saved
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in this specific folder makes it easy to move your project file and all associated external files
from one computer to another. Be careful not to delete these KML files from the externals
folder – doing so will cause the geolinks to stop working. For more information on moving
external files with the project file from one computer to another, see General Information
about Documents in MAXQDA.
The KML file is in XML format. It can be viewed in Windows Internet Explorer or any other
software that can open XML-formatted documents.
Document segments that contain geolinks can be coded just as any other document segment can.
To view all of your geolinks in a project, document group, or document, right-click on that
document or document group and select Overview of links. You can then sort the links
according to type by clicking on the first column header. The rows with a green ball symbolizing the geolinks will be grouped together.

Overview of links showing the green ball in the far left column indicating a geolink in the third row

Inserting Geolinks as Stand-alone Objects in MAXMaps
Geolinks can also be inserted in MAXMaps by right-clicking in a map and selecting Insert
geolink. You will then be able to select the appropriate KML file from the window that
appears.
The MAXMaps screen then looks as follows:
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A geolink inserted in MAXMaps

The name of the location in Google Earth is automatically inserted as the label for the geolink in the map. This label is usually long and can be easily changed.
The inserted geolink can then be set up, visualized, linked to other objects, and moved
around just like any other object in MAXMaps. You can, for example, insert a picture to
replace the blue circle, change its size, etc.
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A geolink along with other elements in a MAXMaps map

Inserting Free Objects with Geolink Attributes in MAXMaps
You can also insert a free object into a map and link it to a geolink. The following screenshot shows such an object. If you click on this object, a border appears with a blue ball in
the top right corner, which indicates that it is linked to a geolink location.
Hovering with the mouse over the blue ball brings up the tool tip with information about
the location. By double-clicking on the symbol, you open Google Earth and go directly to
that location.
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A free object in MAXMaps with a geolink

Geolinking for Codes, Documents, Memos and Coded Segments in MAXMaps
All MAXQDA objects inserted in MAXMaps can be connected to a geolink. As with the free
objects mentioned above, a blue ball appears in the top right of object’s frame when it is
clicked on. Double-clicking on the ball opens Google Earth™ and takes you to the assigned
location.
Geo-Links as Hot Spots in MAXMaps
It is also possible to insert a geolink in MAXMaps as an invisible hotspot. You can insert this
hotspot by right-clicking on a white section of a map and selecting Insert geolink. You can
then get rid of the label and change it to invisible by unchecking the box next to Visible in
the object properties window. The hotspot is then invisible, but it still works; a double click
opens Google Earth™ and takes you directly to the assigned location.
These hotspots are especially helpful when you have a map as a background and want to
be able to click on different parts of the map to take you to that spot in Google Earth™.
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Making a geolink invisible, so it can act as a hotspot

Using a Background Image with Geolinks in MAXMaps
Google Earth™ allows you to save any view as a JPG file. You simply go to the File dropdown menu and select Save > Save Image. The view is then saved as a JPG file, which can
be inserted in MAXMaps as the background.
Invisible hotspots as well as all aspects of your MAXQDA project can then be inserted and
placed on the newly-imported background.

6.6 Overview of Links
Document links, the most common form of link, are easily seen in the „Document Browser“, but if you have created many links, it is difficult to get an overview of them. For this
reason, MAXQDA makes it possible to view all links in an overview table. This overview table is similar to the one used for the Overview of Coded Segments.
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To view the Overview of links, right-click on a document, document group, or the “Documents” icon (representing the entire project) in the „Document System“ and select Overview of links. When right-clicking on a document or document group, only those links
from that document or group will be shown.
The overview contains the following information:
Anchor point (Document 1), paragraph 1, preview 1, second location (Document 2), paragraph 2, preview 2.
In other words, you see the document name, paragraph number, and a preview of each
side of a link. Document links are not hierarchical, meaning they don’t have a specific direction. A link from Point A to Point B is also a link from Point B to Point A. If you view all links
from the whole paragraph, you will therefore see each link listed twice: once as Point A to
Point B, and once as Point B to Point A.

Overview of links for a project

In the Overview of links, each type of link can be distinguished by the symbol that appears
in the column on the far left:
Document links have a blue, two-directional arrow.
External links and web links have a red arrow pointing up and to the right.
Geolinks have a green .
The Overview of links table works like other MAXQDA tables. You can choose to sort it alphabetically or reverse alphabetically by clicking on the column headers. Clicking once on a
link opens the linked document segment in the „Document Browser“, showing you where
the link is located. You can also access several functions in the table toolbar:
Excel table – a table with the selected links is created and saved in XLS/X format and
opened in the program (usually Excel) that handles this type of files.
HTML table – a table with the selected links is created and saved in HTML format and
opened in the standard web browser.
Export – allows you to export the table in XLS/X, HTML, or TXT (tab delimited) format.
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7 Codes and How to Code
7.1 The Code System
One of the main functions of MAXQDA is the “coding” of document segments, that is, the
assignment of a code to particular document segments, enabling a systematic content
analysis of a text.
The codes themselves are simply strings containing up to 64 characters, which are attached
to segments of a document (text or picture sections). Codes are like drawers containing
index cards with text and image sections and keywords. The name of the code is like the
label attached to the front of a drawer. What you will find in the drawer is indicated here.
The label itself has no effect on the contents, so you can attach another label without consequences. Codes can be ordered into a hierarchical structure, a main code having several
subcodes, for example. As you add codes, they can be organized in this window. By rightclicking on either of the icons in the „Code System“ window, you will see a variety of functions that are possible there.
All of the codes are shown in the „Code System“ window. At the beginning of a project,
this window is empty except for the “„Code System“” and “Sets” icons MAXQDA’s „Code
System“ has the following characteristics:
 A code is a string with a maximum of 64 characters consisting of one or more words. A
code can contain any character except a backslash “\.”
 The number of codes in unlimited.
 The hierarchical structure can contain up to ten levels.
 Codes can be assigned a color.
 Codes are assigned an identification number.
 The so-called color codes play a special role. They are like text markers and change the
background color of the marked text.
Working with coded segments (of text and images) and the „Code System“ is a central
aspect of computer-supported text and content analysis. This work is usually not done automatically by the software, but rather is controlled by the researcher, although this often
requires a significant amount of time. The „Code System“ is shown as a tree structure on
the screen. It looks like the file/folder system in Windows Explorer with which you are likely
familiar. A plus or minus sign before the code name indicates whether or not a code contains subcodes. You can expand or close the sub-categories by clicking this button.
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Hide subcodes

In MAXQDA the codes and their sequence in the „Code System“ can be organized according to your needs. Just use the drag-and-drop function to change the position of a code in
the list. Click the code with the left mouse button and hold the mouse button while moving the code to the new position. It is easy to rearrange the „Code System“ in a way that is
useful for your work.
It is easy to rearrange the „Code System“ in a way that is useful for your work. It is often
the case that you will find it helpful to arrange your codes in an order that follows your research process or argumentation.
In MAXQDA 10, it is now possible to use the visual tool MAXMaps to create a networked
structure of codes for use in coding. When the map is open, you can code by simply highlighting a document segment in the „Document Browser“ and dragging it to a code in
your map
Attention: Changes to the order of codes on the same level can be done by holding the
Shift key as you drag a code to its new location.

7.2 The Code System Toolbar
Like the other main windows of MAXQDA, the „Code System“ has a toolbar where you
can find the following icons:
Resets activations, deactivating all codes
Prints the Code System
Exports the „Code System“ in RTF or XLS/X format
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Creates a new code
Switches to an alternative view of the Code System and code memos, which is
helpful when creating many codes
Allows for activation by code color
Toggles Code System view between the tree structure (as in Windows Explorer) and
the table view
Opens a field for searching for codes
In addition to using the toolbar to access functions in the „Code System“, you can also use
the context menus that appear when you right-click on various icons in the window (e.g.
on a code or the “Code System” icon, etc.).

7.3 Creating a New Code
In order to create a new code at the highest level, we can do one of three things:
1. The easiest option is to click on the New code symbol in the „Code System“ toolbar.

Toolbar icon for inserting a new

2. Another option is to right-click on the Code System icon and select New code from the
menu that appears. The word “Code System” at the top of the list represents the root of
the „Code System“ that you will build from this point. All codes can be created in this
way.
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Creating a new code with the context menu

3. The third option is to create a new code by using the keyboard shortcut Alt+N. For this
to work, however, the „Code System“ window must be selected.
No matter which way you choose to create a new code, the following window will appear:

The window that appears when creating a new code

Type the name of the new code in the upper dialog field of the window. You can select a
color attribute for the new code below. There is an almost unlimited number of colors that
you can pick from or design on your own. The dialog field in the lower part of the window
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enables you to write a code memo, for instance a definition of the characteristics of the
new code.
Codes can be removed from the „Code System“ either by using the Del keystroke or by
right-clicking the code and selecting Delete code(s) from the context menu.
If you would like to define subcodes, just right-click the parent code and choose the option
New code. Again the same dialog window as mentioned above will pop up. If you want
the subcode to have the same color attribute as the main code, just click the checkbox ”Inherit.”
Creating subcodes can also be completed using the Alt+N keyboard shortcut or the New
code icon from the toolbar.
If you have entered text into the memo field of the dialog box, a memo icon is displayed
beside the new code in the „Code System“ as soon as you close the dialog window.
Newly-created codes are always added at the top of the „Code System“ unless created as a
subcode, in which case it will appear as the top subcode.
The order of the codes and subcodes in the „Code System“ can easily be changed using
drag-and-drop operations with the mouse. You can also sort them alphabetically by clicking
the menu option Sort codes from the context menu of any level.
If you wish to move certain codes to the top of the alphabetical sort, you can rename them
to start with a special symbol like the “_.”
Attention: With the mouse, you can drag codes to new locations or make them subcodes
of other codes. To change a subcode to a higher-level code or to change the order of the
higher-level codes, you need to hold the Shift key as you move them.

7.4 Using the Code Browser to Create Codes
The Code Browser offers a fast way to define a set of codes or an entire „Code System“.
The function is started by clicking the appropriate icon from the toolbar.

Opening the Code Browser

In the left part of the window shown below, the already existing codes are displayed. The
dialog field in the upper right corner is used to type in new codes. You may do this step-bystep, one after the other. At the end of each code click Insert or press the Return key. Defining subcodes is as easy as defining the codes. Click a code in the list on the left side. This

84

Coding Text and Images

brings the code into the dialog field. Type in a slash (“\“), then the name of the subcode,
and press enter.

Code Browser window for code creation

You also have the option of creating a code memo by typing in the field in the bottom right
of the Code Browser.

7.5 Coding Text and Images
Assigning codes to segments of texts or images in MAXQDA is known as “coding.”
The smallest segment of text that can be coded is a single character.
In most cases, you would want to code at least an entire word. The Code toolbar is especially helpful when going through the coding process. If it is not currently visible, you can
activate it by clicking on it in the Toolbars drop-down menu.

The Code toolbar
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A document or document segment can be coded with as many codes as you want. There is
practically no limit to the number of codes that you can create and assign. Coded segments
can also overlap, intersect, or be completely contained within other coded segments.
Highlighted segments of text can be copied at any point into the Windows clipboard. You
can do this with the standard PC shortcut Ctrl+C, via the context menu called up with a
right click, or by choosing Copy from the Edit drop-down menu.
The action of coding can be done in many different ways, but you must always start by
highlighting the section of the document to be coded. An example of highlighted text within the „Document Browser“ is shown below:

A highlighted segment of text

MAXQDA offers several ways to code document segments:
 Classical Coding: select a document segment and attach an existing code from the
„Code System“.
 Free Coding: this is the typical style of initial coding in Grounded Theory – a new code
will be attached to a text segment.
 Targeted, selective Coding: documents are scanned for a selected code. When a text
passage is found that belongs to the selected code, coding will be performed.
 In-vivo Coding: the term in-vivo also comes from Grounded Theory and means that
words or terms used by the interviewees are so remarkable, that they should be taken
as codes. In-vivo coding adds these terms of the respondents as codes and codes the
text passage at the same time.
 Color Coding: This works like highlighting a text passage in a book with a colored text
marker. In MAXQDA, five different colors can be used for color coding: red, green, yellow, blue or magenta.
 Coding with a Selection: a document segment is coded with the activated codes.

86

Coding Text and Images

The following section describes in detail how these techniques are used. The different options can be chosen from the context menu that pops up when you select a document
segment and click the right mouse button.
1. Classic Coding via Drag and Drop
Left-click and hold on the selected text and move the mouse pointer to the name of the
code in the „Code System“. Release the mouse button to assign the segment to this code,
as you can see in the gray column next to the document in the „Document Browser“ window. The reverse also works, i.e. you can drag the code to the selected document segment.
In this second variation, you can also code with several codes, one after the other, without
reselecting the document segment to be coded.
2. Coding by Right-clicking on a Code
Right-click on the code in the „Code System“ that you would like to use to code the highlighted document segment in the „Document Browser“. Select Code from the context
menu.
3. Coding with Multiple Codes Simultaneously
Activate the codes in the „Code System“ that you want to use to code the selected document segment in the „Document Browser“. Then right-click on the segment and choose
the option to Code with selection.
4. Free Coding with Keyboard Shortcuts
An easy way to create a new code, i.e. a code that is not yet listed in the list of codes, is to
use the shortcut Ctrl+W. A dialog window will open, and you can type in the name of the
new code. The code will be added to the „Code System“ at the highest level of the hierarchy. If necessary, you can later move the code to another level in the „Code System“.
5. Focused Coding with the Quick List Coding Button
At the top of the „Document Browser“ in the Code toolbar is a list of the codes last used.
Whenever you assign a new code to a segment, the code is added to the list. By clicking on
the button to the right of this list (screen tip: “Code”), you assign the selected segment to
the code presently in the toolbar. This allows you to assign a document segment to a code
that has already been created. In this way, you can search the document for a certain topic
and quickly code corresponding passages without going through the process of selecting a
code each and every time.
6. Coding with the In-vivo Coding Button
Another way of coding is with the so-called in-vivo coding. If you, for example, select the
word “global village” and then click on the in-vivo coding button in the toolbar, the word
“global village” is added to the list of codes as the code for this short text segment. The
shortcut Ctrl+I has the same effect.
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Coding with the in-vivo coding button in the Code toolbar

When you want to code a whole segment of text with the in-vivo coding function, and not
only one or two words, code the one or two words with this function first. Next, select the
entire text segment (including the word) and click the coding button (not the in-vivo coding
button!). MAXQDA expands the coded segment automatically.
7. Highlight Coding / Color Coding
Color coding text is a technique that is especially useful at the beginning of the analysis
process. It is similar to the marking of text in a book with a highlighter. It allows you to
mark the passages you find particularly interesting when reading through the text for the
first time. Before you decide which codes to use and before you start analyzing your text in
categories, this technique lets you keep track of what simply seems important. There are
five colors with which you can color code: green, blue, yellow, red, and magenta.
The purpose of this highlighting function is not simply to change the text’s color– you could
do this in Edit Mode by selecting a different font color for a text passage. Not only does the
text change background color, but it is also coded with the name of the color. Thus, all the
code functions are available to you when you are working with these segments later on.
When going through the text a second time, it will be easier to develop your codes and
categories from this basis.
To activate the toolbar, select Highlight coding from the Toolbar drop-down menu. You
will then see the following toolbar with the five available colors:

Highlight coding toolbar with five color options

To highlight code a segment of text, you follow a similar process as with standard coding:
highlight the text segment with your mouse and click on one of the five colors in the toolbar. The text segment will now be highlighted in that color, and it will be coded with a new
code called green, blue, red, magenta, or yellow. You will see the new code in the „Code
System“ as well as in the coding column to the left of your document in the „Document
Browser“.
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A section of text coded with “GREEN”

In practice, then, the highlight coding does much more than just change the color of the
text – it is also a coding action. This means that you can later call up all of the greenhighlighted segments and work with those that are most important. This lets you code
more specifically once the first general coding run is complete. Retrieving all codes with a
specific color coding can be done by activating all documents in the „Document System“
and activating the appropriate color code in the „Code System“ (see Retrieval: Finding
Coded Segments).
If at a later point, you delete the color code in the „Code System“, you are not only deleting the code. All coded segments for that code will also be deleted. In other words, all
highlights of that color will be deleted from your documents.
Information for all types of coding: MAXQDA does not allow the same code to overlap itself or be used more than once for the same section of text. If, for example, paragraphs 4
through 8 are coded with the code “Health,” and you highlight paragraphs 7 through 12
and code it with the same code, MAXQDA will adjust the coded segment to include paragraph 4 through 12.

7.6 Assigning Colors
Every code and subcode can be assigned a color. This color attribute is used for the display
of coding stripes in the „Document Browser“ and for visualizations. The colored coding
stripes make it especially easy to find certain coded segments in documents in the „Document Browser“.

Codes and How to Code

89

Coding stripes of various colors in the Document Browser

The color is also seen in the bottom right of the icon next to each code in the „Code System“.

Codes of various colors in the Code System

The color attribute is also displayed in all MAXQDA tables that contain codes, e.g. in the
Overview of Coded Segments table that is available for each document group and each
document. There, the color attribute may be used as a criterion for sorting the table. This is
done by clicking on the column header of the column containing the colored icons. Unless
you have changed the order of the table’s columns, this column will be the first one in the
table.
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Color attribute in the first column of the Overview of Coded Segments

The color attribute plays an important role in all visual tools of MAXQDA. For instance, the
Document Portrait is based completely on the colors of the codes that are assigned to a
particular document. Thus, the selection of colors is an important step: colors should be
assigned according to the kind of analysis that you plan to conduct. For instance, a psychologist could assign red colors to aggressive statements and green colors to friendly
statements. When analyzing documents in regard to the topics mentioned a meaningful
association of topics and codes is recommended. Thus, you are able to identify topics and
combinations of topics with one glance. When working with focus groups, you should associate the speakers with the different colors, in order to quickly find out when a person is
speaking.

7.7 Coding with the Code Favorites
If you are working with an extensive „Code System“, it can be difficult to work efficiently,
since it is hard to find each code quickly in the large list. The coding Quick List offers on
way of working around this, but there is another option that can be helpful in certain circumstances. It allows you to also code with more than one code at once. The function is
called the Code Favorites.
And how does it work? Simply right-click on a code and select Add to code favorites.
After you have added the first code, the Code Favorites window will appear. You can then
continue to add more codes to the list in the same fashion: right-click on the code and select Add to code favorites.
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The list of code favorites

You can now begin to code. Simply highlight the section of the document in the „Document Browser“ and click on the codes in the Code Favorites window that you want to assign to it. You can now see in the coding column on the left side of the „Document Browser“ that the segments have been coded.
If you want to delete a code from the list, simply click on the checkbox in front of it and
click on the x at the top of the window.
When you are finished using the Code Favorite window, simply close it by clicking on the x
in the top-right corner. To re-open the window, you can either add another code (via the
context menu) or select Code bar from the Codes drop-down menu.

7.8 Visualization of Coded Segments in the Document Browser
As soon as you have coded a document segment, a coding stripe appears in the gray area
next to the document in the „Document Browser“. The standard color for this symbol is
green, but you can choose another color for any code, causing all the code symbols for this
code to appear in this color. The column for the coding stripes can be made bigger or
smaller by clicking on the separator between the column headers and dragging to the right
or left. Double-clicking on the column separator makes the column the optimal size. This
optimal view can be impractical, though, if you have too many coded segments. In such
cases, the text will be made so small that you won’t be able to read it easily.
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Visualization of coding stripes on the left side of the Document Browser

You can also choose whether code names should be shown in the coding strip column. By
right-clicking in the gray area of the column, you will call up a window with various setting
options. One of those options is to Show code name.
You will always be able to see the code name in the tool tip that appears if you hover your
mouse over the coding stripe. The tool tip also shows you the assigned weight, the author
of the coded segment, and the date that the segment was coded.

Tool tip appearing from the coding stripe

This tool tip always displays the complete code name, even if it is a subcode. This is significant, because the coding stripes in the column only show the name of the codes, rather
than including the codes that they are subcodes of. In other words, the code “Significantly
positive” is a subcode of “Day-to-Day Issues,” but that is only visible in the tool tip, not in
the coding stripe column (see above). In the tool tip, it is shown as “Day-to-Day Issues\Significantly Positive.”
If there are many coded segments, it can also be difficult to figure out exactly where each
one starts and ends. By simply clicking once on the coding stripe, however, you can view
the coded segment in the document; MAXQDA highlights it for you.
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7.9 Coding Stripe Column Visualization Options
By right-clicking in the coding strip column, you can call up a window with various settings
for the visualization of coded segments in the coding stripe column:

Option menu for the visualization of coding stripes

Here you can adjust the following settings:
 You can choose to only visualize activated codes.
 You can choose to visualize coded segments created by certain users.
 You can choose to only visualize coded segments of a certain color.
 You can choose whether to change the text color of the text in the document to match
the color of the code it was coded with.
 As mentioned before, you can choose whether the code name should be shown or not.
 Finally, you can choose whether the tool tips should include the information about the
author and date of creation.
The option to switch off codes with selected colors is particularly useful when you are
working in a team with independent coders. In this case, the coders should be defined as
codes on the highest level of the code hierarchy and the different coders should use the
same code tree organized as subcodes of the coders. Now, while the training the coders,
you can hide the visualization of other coders’ work. Later on, they can compare their coding with the coding done by the others.
The option to color the text according to code colors is new in MAXQDA 10. This option
only makes sense if you do not have many overlapping codes. Overlapping codes cause the
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color of the text to be a mix of those overlapping codes, which can make it very difficult to
interpret.

7.10 Deleting Coded Segments: The Undo Function
Clicking on the code symbol with the right mouse button causes a context menu to appear,
with which the coding of the text segment can be removed. Choose Delete and confirm
the deletion by clicking Yes in the confirmation window that appears.
If you need to first find the location of a coded segment in a document, deleting the code
in this way may not be very convenient. A better way is to use MAXQDA’s Undo function.
In the coding toolbar on top of the „Document Browser“ window there is an Undo button. Clicking on it opens a list containing the last codes assigned.

“Undo” function in the Code toolbar

The most recent coded segments are shown at the top of the list.
Through certain functions, such as “Move coded segments” or autocoding, you may carry
out dozens or even hundreds of coded segments at one time. In such cases, the Undo
function can be very helpful.
Another option for deleting coded segments can be found in the “Code System” (see Modifying Coded Segments).

7.11 Deleting Codes
Deleting a code from the „Code System“ is somewhat like cutting of a branch of a tree. By
deleting that code, you are also deleting any subcodes, which are like smaller branches attached to the bigger one you cut off. At the same time, all coded segments that had been
created with those codes are deleted.
You can delete codes either in the classic tree structure view or in the table view by rightclicking on the code and selecting Delete code(s).
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Deleting a code from the context menu

Attention: When deleting a code, you are also deleting all coded segments that were
created with this code.
If you want to delete more than one code at a time, it is necessary to switch to the table
view of the „Code System“. To do so, click on the Change view icon in the „Code System“ toolbar. You can now select as many codes as you wish by clicking on them while
holding the Ctrl key and then right-clicking and selecting Delete code(s) from the context
menu.

7.12 Modifying Coded Segments
There are three ways to modify coded segments:
1. A code can be “un-assigned” or removed from a segment – when, for example, you
assigned the code to the segment by mistake.
2. A different code can be attached in place of the other.
3. The size of the coded segment can be changed (e.g. to encompass paragraphs 5-12
instead of just 5-10).
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All three of these modifications can be easily carried out in MAXQDA.
Deleting a Coded Segment
From the Document Browser:
1. Right-click on the little circle in the middle of the coding stripe in the column to the left
of the document in the „Document Browser“.
2. Select Delete and confirm the deletion by clicking Yes.

Deleting a coded segment in the Document Browser window

From the „Retrieved Segments“ window:
1. Right-click on the yellow info box to the left of the coded segment.
2. Select Delete and confirm the deletion by selecting Yes in the confirmation box that
appears.
The segment is then removed from the „Retrieved Segments“ window, and the deletion
can not be undone.

Deleting a coded segment in the Retrieved Segments window
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Coding a Segment With More Than One Code
After having coded a segment, the segment remains selected. It is possible to attach more
codes to the same segment by simply continuing to drag codes the selected segment or by
right-clicking on the code in the „Code System“ and selecting Code in the context menu
that appears.
Another option is to highlight the document segment, activate the codes you want to code
it with, and then right-clicking on one of the codes and choosing Code with selection.
The segment will then be coded with all activated codes at once.
Replacing a Coded Segment
When reviewing your text analysis, you may decide that the wrong code was assigned to a
text segment. Or you may decide that the „Code System” is not precise enough, so it is
necessary to expand the “Code System” and distinguish between different codes. In both
cases, you will need to replace one code assigned to a text with another.
1. Click on the coding stripe next to the segment with the left mouse button, thereby
highlighting the document segment.
2. Assign the new code to the segment.
3. Right-click on the older coding stripe and delete it.
Editing the size of a Coded Segment
When listed independently from the original text, a coded segment may be difficult to understand because it is out of context. The segment is probably too small. To extend the
segment’s boundaries, first click on the code symbol to again select the segment. Then,
expand the boundaries of the highlighted text by dragging the mouse over the text to be
included in the segment. Then reassign the code to the text, which you can do by simply
clicking on the code button again. The code symbol will change correspondingly. It is also
possible to use this process to make the coded segment smaller.

Changing the size of the Coded Segment
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7.13 Modifying the Code System
A large part of the work that is done in computer-assisted qualitative data analysis involves
codes, their relation to one another, and the process of assigning them to document segments. The hierarchical „Code System“ in MAXQDA allows you to do this work efficiently.
When working with a large number of codes and different hierarchical levels of codes, it
might be helpful to hide the subcodes in order to get a better overview of the „Code System“.
Changing the order and the structure of the „Code System“ is not difficult. All codes can
be moved with the mouse and the drag-and-drop function.
In the following example, the „Code System“ contains four codes (A, B, C, and D).

Moving codes with the mouse

To move Code D to the top of the list, you would need to do the following:
Hold the Shift key, click on Code D, drag it to the top of the list and release the mouse button.
This process allows you to move codes that are one the same hierarchical level or that are
to be moved to a higher level. It is also easy to make a code a subcode of another code. If
Code B and Code C are to become subcodes of Code A, for example, you would carry out
the following actions:
Click on Code B, drag it to Code A, and release. Code B is now a subcode of Code A. You
can now do the same with Code C.
Subcodes can also be sorted alphabetically by right-clicking on the code they are subcodes
of and selecting Sort subcodes.

7.14 Copying Code System Structures
In some cases, you will be setting up the same subcodes for various codes. You might, for
example, have the codes “Childhood,” “Teenage Years,” and “Adult Life,” which should

Codes and How to Code

99

each have the subcodes “Education,” “Family,” “Friends,” and “Memorable Experiences.”
So that you don’t have to create these four subcodes three times, you have the option of
setting them up for one of the main codes, copying its subcodes, and pasting them into the
other main codes. To do so, you would follow these steps:
1. Create the three main codes: “Childhood,” “Teenage Years,” and “Adult Life.”
2. Create the four subcodes for the main code “Childhood.”
3. Right-click on the Childhood code and select Copy subcodes.
4. Right-click on each of the other main codes and select Paste subcodes.

7.15 Moving Code References
If you move a code from one position in the „Code System“ to another, the code references move automatically together with the code. This is like moving a drawer from one
place to another in a cabinet; the drawer’s contents move together.
To move a complete drawer is something other than to move only its contents. The same is
true with code references. If you only want to move the code references to another code,
you cannot use the procedure described above. There is another procedure that leaves the
drawer in its place and merely shifts its contents.
In MAXQDA, it is the Move coded segments option that does this job. This option is available in the context menu of the particular code from which code references are to be
moved.
The following figure shows the result of moving coded segments from Code B to Code A.
Actually, what takes place is the merging of Code A and Code B:

To move the coded references from Code B to Code A, follow these steps:
1.

Right-click on Code B in the „Code System“.

2.

Select Move coded segments. This transfers the code references to an internal
clipboard. (Up to this point, nothing has really changed in the „Code System“. The
number of coded segments displayed to the right of Code B is still the same.)

3.

Right-click on Code A (the target code) and choose Move coded segments from
‘Code B.’ MAXQDA asks you to confirm the command before executing it.
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Moving coded segments

Code B remains in the „Code System“ until you delete it, but the number of its immediate
code references is now zero. The contents of the “drawer” have been moved to Code A.
The subcodes’ references, however, will not have been moved. Be careful when deleting
Code B now, since all subcodes – if there are any – will be deleted too, along with their
code references.
Tip: If you want to delete all code assignments but want to keep the code in the „Code
System“, it is best to create a code named “trash“ and then copy the code references to
the “trash.”

7.16 Copying Code Segments
The function “Copy coded segments” is similar to the “Move coded segments” function.
The only difference is that the code references also remain in Code B – that is to say, they
are duplicated. To do this, follow the steps below:
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1.

Move the mouse pointer to the “Code System” and right-click on the code from
which references are to be copied (Code B in the example above).

2.

Select Copy coded segments from the context menu that appears.

3.

This causes the code references to be moved to an internal clipboard. (Up to this
point nothing has really happened in the „Code System“. The number of coded
segments displayed to the right of Code B is still the same.)

4.

Now select the target code (Code A in the example above). Right-click and choose
Insert coded segments from ‘Code A.’

5.

MAXQDA then copies the code references to the selected location; no confirmation
is required.

7.17 Creating a New Top-Level Code
A common procedure when working with codes is to group previously defined codes under
a new, more abstract category, as shown in the next diagram:

MAXQDA’s hierarchical „Code System“ makes it easy to group existing codes under new
top-level codes. Reorganizing the „Code System“ can be done at any time during the analysis process:
1. Create a new code at the top level of the hierarchy (New Code in the example above).
2. Drag Code B to New Code and release it.
3. Do the same with Code D.
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Creating a new code to hold to former codes as subcodes

7.18 Splitting up a Code
Often when working with a „Code System“, it is desirable to differentiate between elements grouped under one code. In MAXQDA this corresponds to dividing a code in two or
more subcodes. For example, imagine you have created a code named “family” and have
assigned document segments, in which an interviewee talks about his family, to this code.
Then imagine that it becomes necessary to differentiate between “mother,” “father,” and
“brothers and sisters.”
The division of a code into subcodes can obviously not happen automatically, since you
must decide which references of the code are to be placed in which subcode. You must
read each coded segment and decide which of the subcodes is appropriate. In this case the
subcodes will not be exclusive since a person could talk about his father and his mother in
the same segment.

Codes can be divided as follows:
1. Activate all documents and the code “Family.”
2. Create three subcodes for “Family:” “Mother,” “Father,” and “Brothers and Sisters.”

Splitting up a code

A convenient way to separate the code references into the new subcodes is to bring all the
coded segments (in our example with “family”) into the „Retrieved Segments“ window.
Then for each of the segments go through the following steps:
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1.

Read the segment and decide which subcode(s) it should be assigned to.

2.

Click on the information box left of the segment. The text will appear in the TEXT
BROWSER with the segment highlighted.

3.

Attach the appropriate subcode using the drag-and-drop function.

4.

If necessary, repeat for another appropriate subcode.

When you reach the end of the list you will all have worked through all the coded segments and these will have been assigned new subcodes. But all segments will still be coded
with the original code “family” too, which is obviously not what you want. To finish the
job, you have to delete these code references, which may seem tricky, since now deleting
the code “family” would also delete its subcodes – including the three subcodes that you
just created.
In effect, you need to delete not the code itself but only its references. Since the command
“Delete Code References” does not exist in MAXQDA’s „Code System“, you have to do a
work-around to get the desired result:
1.

Create a new code called “trash.”

2.

Right-click on the code whose references are to be removed (in this example “family”).

3.

Select Move coded segments from the context menu.

4.

Move the mouse pointer to the code “trash,” click with the right mouse button, and
select Move coded segments from ‘family.’

5.

Delete the code “trash.”

7.19 Weight Scores: Indicating Segment Relevance
When coding a document segment, you are attaching a segment of a text or image to a
code in the „Document System“. MAXQDA also allows you to assign a weight score to
each of these coded segments to indicate how important that particular coded segment is.
It may be that certain coded segments represent a typical argument or theoretical concept
that you want to be sure and hold on to. In this case, these segments are a sort of signpost.
MAXQDA allows you to indicate how important or appropriate a segment is for the code it
is coded with by giving it a weight score between 0 and 100. This weight score could be
described as a “fuzzy variable,” because it is not meant to give an exact numerical worth
for the segment. Rather, it is intended to be a guide, so you can later sort your retrievals
based on the weight assigned.
Every newly coded segment automatically receives the default weight score, which is
somewhere between 0 and 100.
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To see what the standard weight score is (or to change it), simply select Options from the
Project drop-down menu and find the row for “Default weight.” Alternatively, you can
double-click on the icon in the status bar at the bottom of the MAXQDA screen.

Changing the default weight in the status bar

The weight of a coded segment (as long as it isn’t 0) is shown in the top right of the yellow
info box that appears next to each retrieved segment in the „Retrieved Segments“ window.

Weight score

The Overview of Coded Segments also includes the weight scores for each coded segment.
This weight is saved automatically, so that you can use it later to limit the results of your
segment retrievals (see Retrieval: ).
Assigning Weight Scores in the Document Browser
Right-click on the coding stripe for the coded segment that you would like to alter the
weight score for. You can then select Modify weight. You can then enter a number between 0 and 100.
How the weight scores are used is completely up to you. You could choose to have a system where a weight score of 1 is the highest or where 100 is the highest.
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Changing the weight score in the Document Browser

Assigning Weight Scores in the Retrieved Segments Window
A weight score can also be assigned and modified in the „Retrieved Segments“ window.
Right-clicking anywhere on the information box left of the coded segment opens the context menu, where you can select Modify weight and enter a number between 0 and 100.

Changing the weight score in the Retrieved Segments window

You will be able to see the newly-entered weight score in the top right of the yellow info
box directly after you make the change.

Updated weight score
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Changing Weight Score in the Overview of Coded Segments
In the Overview of Coded Segments table, you will find a column for the weight score of
each coded segment. By double-clicking on a cell in the column, you will be able to enter a
new weight between 0 and 100.

7.20 Creating Comments for Coded Segments
You have the option of creating a short comment (maximum of 127 characters) for each of
your coded segments. This might be an overview of the coded segment or a comment
about its significance for your analysis. These comments are then shown in the tool tip that
appears when you hover the mouse over a coding stripe.
To create a comment for a coded segment, follow these steps:
 Double-click on the little circle in the middle of the coding stripe,
 double-click on the yellow info box next to a coded segment in the „Retrieved Segments“ window, or
 enter your comment directly into the appropriate row of the “Comment” column in the
Overview of Coded Segments.
You can easily see if a comment has been written for a coded segment when you look at
the code symbol. Normally the inner part of the little square is white in color, independent
of the color of the code symbol. When a comment is attached, the inner square appears in
the same color as the outer line of the symbol.

A coded segment comment shown in the tooltip when hovering over the circle in the middle of a coding
stripe

If you import coded segments into MAXMaps, the mapping tool of MAXQDA, the comments are used as labels. Thus, with regard to the creation of maps and models in later
stages of your analysis, writing meaningful comments can be very important.
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Finding your Coded Segment Comments
As long as you haven’t changed the standard view, you can find all of your code comments
in the Overview of Coded Segments table in the second column. You can also insert new
comments and delete/change old ones from this view. By right-clicking on the column
header, you will have the option of clicking on the Search function. You can then start typing the first word in the comment you are looking for. If you want to search for a word that
appears somewhere in the comment, not necessarily at the beginning, you can simply start
the search string with the “*” symbol.
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8 Intercoder Agreement/Reliability
8.1 About Reliability
When assigning codes to document segments, it is recommended that certain criteria be
set. You assume, for example, that coding is not arbitrary or random, but rather that a certain level of reliability will be reached. The “Intercoder agreement” function makes it possible to compare two people coding the same document independently of each other. In
qualitative research, the purpose of comparing independent coders is to discuss the differences, figure out why they occurred, and learn from the differences in order to improve
coding agreement in the future. In other words, the actual percentage of agreement is not
the most important aspect of the tool. This percentage is, however, provided by MAXQDA.

8.2 The Intercoder Reliability Problem in Qualitative Research
It is always the goal of qualitative analysts to achieve as high a level of agreement as possible between independent coders. It is not, however, focused on getting to a standard coefficient that is statistically necessary as in quantitative research. Rather, the focus is on a
practical improvement of the coding quality. For this reason, one doesn’t focus on the coefficient or percentage of agreement. Instead, qualitative researchers want to address and
edit the coded segments that do not agree, so that they can move on with more accurately
coded material.
The Intercoder Agreement tool is set up to compare and contrast a single document coded
by two independent coders, highlighting the areas where the two researchers’ coded segments align and do not align. It is then possible for these two coders (or a larger research
team) to decide which coding variation in each situation is most accurate.

8.3 The Agreement Testing Concept in MAXQDA
The Intercoder Agreement function in MAXQDA works as follows:
1. Two people code the identical text independently of each other with the agreed upon
codes and code definitions. This can be done on the same computer or on different
computers. The most important thing is that the two coders can not see how the other
has coded. It makes sense to name each document in a way that makes it clear, who has
coded which (e.g. “Interview1_Michael” and Interview1_Jessica.”
2. To test the two documents, they must both be in the same MAXQDA project. If they
were coded on different computers, the two projects can be merged. It is also possible
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to use the teamwork functions to only exchange codes, memos, and variables (see
Teamwork ).
You can now start the Intercoder Agreement function by selecting it from the Analysis
drop-down menu.

Starting the Intercoder Agreement function via the Analysis menu

If you only want to check the agreement of certain codes, activate those codes before starting the test.
1. Select the first coder’s document from the “Document 1” menu and the second coder’s
document from the “Document 2” menu.
2. If you only want to test the activated codes, you can check the box at the bottom left of
the window next to “Only for activated codes?”
3. You can then choose between three different analysis criteria for the agreement test:

Variation 1 – Code existence in the document
The criterion in this variation is the presence of each code in the document, meaning
whether or not each code is found at least once in the document. This variation is most
appropriate when the document is short, and there are many codes in the „Code System“.

Variation 2 – Code frequency in the document
The criterion in this variation is the number of times a code appears in each coder’s version of the document.

Variation 3 – Segment agreement in percent
In this variation, the agreement of each individual coded segment is measured. This is
the most precise criterion and is used most often in qualitative research. You can set the
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percentage of agreement that is required in each segment for it to be considered in
agreement (correlation). The tool takes each segment and evaluates the level of agreement between the two documents.

Testing intercoder agreement based on segment agreement in percent

The screenshot above shows the Intercoder Agreement window, which shows that
“I1_Marissa” will be compared with “I1_Thomas.” The third variation is selected, meaning
agreement will be tested at the segment level, and the required agreement percentage to
be considered “in agreement” or “correlating” is 90.
Results for Variation 1
The Code Matrix Browser window will appear only for the two documents that are being
compared. The Code Matrix Browser is set to visualize whether or not each of the codes
exists in the two documents. If the code exists, a blue circle or square will be shown in that
document’s column.

Testing the existence of codes in two documents

The screenshot shows the results for three codes. The codes “career” and “home” exist in
both of the documents, but the code “health” only exists in the document coded by Thomas.
Clicking on one of the blue symbols selects the corresponding document in the „Document Browser“ and the corresponding code in the „Code System“. Double-clicking on the
symbol opens the document, highlighting the coded segment.
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At the top of the results window, you can see the percentage of agreement. In this case,
there was agreement for two out of the three codes, so the correlation was 66%.
Results for Variation 2
The results for the second variation are also shown in the Code Matrix Browser for the two
documents to be compared. Results can be viewed either as symbols or as numbers. It is
then fairly easy to see where there is agreement between the documents. The correlation
percentage is shown again in at the top of the results window. For each code, the number
of times it appears in each document is compared. If the number is the same, there is
agreement. If the number is not the same, there is disagreement. It makes no difference in
this case whether the difference between the two numbers is 1 or 100.
Tip: MAXQDA calculates Intercoder Agreement for the first two variations as follows:
% Agreement
= # of agreements / (# of agreements + # of non-agreements)
= # of agreements / # of rows
Results for Variation 3
This is the most complication variation, since intercoder agreement is tested on the segment level. If the first document has 12 coded segments and the second document has 14,
there will be 26 tests carried out and presented in 26 rows of a table.
It is necessary to decide how similar the coded segments must be to be considered in
agreement. This is measured in percent and can be set in the bottom right of the Intercoder
Agreement window. The default is set at 90%.
Two results tables are created: the code-specific results table and the detailed agreement
table.
a) Code-Specific Results

The Intercoder Reliability results for the individual codes

This table is made up of one row for each code that was included in the test. It shows the
level of correlation between the two coders for each code. This can make clear, for example, if certain codes are in disagreement more than others. Every code is shown in a row
with the number of times its use in the first document correlated with the use of the code
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in the second document, the number of times they did not correlate, and the total percentage of correlation.
b) Detailed Agreement Table
The second results table allows you to see exactly which coder coded which segment and
whether the coded segments correlate. A red “x” in the first column shows that the coded
segments do not agree. Clicking on the column header sorts the rows, showing all the noncorrelating segments first, so the coders can analyze and discuss each of them step-by-step.
By double-clicking on the box in the “Document 1” column, you can open that document
and call up the exact document segment in question in the „Document Browser“. Doubleclicking on the square in the “Document 2” column brings up the segment in the second
document in a new tab, showing the place where the correlating (or non-correlating) coded
segment is. You can now very easily switch back and forth between the documents in the
two tabs to analyze which of the coded segment variations is the most accurate.

Results table for all coded segments
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9 Memos: Managing Your Ideas
9.1 About Memos
MAXQDA makes it possible for you to create “Post-It”-like notes with your ideas, comments, etc. and to attach them to document segments, documents, document groups, images, or codes. These notes are called memos in MAXQDA. These memos can have various
functions: they are commonly used, for example, as an integral part of Glaser and Strauss’s
Grounded Theory analysis method. You can also differentiate between various types of
memos within MAXQDA that then have different roles in your analysis. It is important to
recognize the difference between memos and documents: documents are analyzed and
coded, but they are usually not changed radically once the analysis has begun.
Memos, on the other hand, are a dynamic form of text. They are created by the user and
can be modified and integrated at any time during the analysis process.
In MAXQDA, memos can be attached to document groups, documents, document segments, images, and codes. There is also the option of creating a “free memo,” which is not
attached to anything other than the project. These free memos also come out of Grounded
Theory, which has memos without a any concrete connection to a part of the data.

9.2 Memos Attached to Document Segments
Document segment memos can be attached to any line of a document viewed in the
„Document Browser“. To create a new memo, double-click in the memo column just to the
left of the paragraph numbers in the „Document Browser“ in the line that you want to
create the memo.

Creating a new memo
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You will then see the memo window:

The memo window

You can now enter a title for the memo, so that you can easily find it later in the Memo
Manager.
The memo title also appears in the tool tip that appears when you hover the mouse over
the memo symbol in the Document Browser.
When creating a memo, you can simply move from one field to the next, entering all the
information that is required. MAXQDA automatically inserts the currently logged in user as
the “Author,” so that you can later find all memos by author. You also have the option,
though, of changing the name in this field.
The memo’s “Creation date” is also inserted automatically and appears in the top right of
the memo tool tip when you hover over the memo symbol.
Ever memo can be given the standard yellow “Post-It”-style symbol or one of the 10 other
available symbols. These options allow you to indicate what type of memo it is. The following visualizations are available:

Memo visualization options
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Choosing different visualizations for differing types of memos is up to each user. Those using Grounded Theory, for example, might choose to use the visualization with a “T” to
represent theoretical memos, the visualization with an “M” for method memos, etc.
You can also link each memo to codes from the „Code System“.
The actual memo can be typed into the large text field at the bottom of the memo window. Memos can be edited in Rich Text Format, meaning you can set the font style and
size; use underline, italics, and bold; and change alignment options. You can also keep
track of your additions to the memo by clicking the
symbol, which automatically inserts
a date and time stamp. If you want to insert a section of text from another document, you
can simply copy it and paste it into the memo field. You can also simply highlight the text
and drag it in.
When you are finished with the memo, you can close the window by clicking on the x in
the upper right hand corner or by clicking on the
symbol. The memo will now be visualized in the memo column in the „Document Browser“.
The actual memo text can be as much as 64 KB, which is about 20-30 pages of text. There
is no limit to the number of memos you can create in each document. You should remember, however, that when you open a document in the „Document Browser“, the memos
are opened as well. If you have 1,000 memos in one document, this document won’t open
as fast as one without any memos.
Document segment memos are assigned to a specific paragraph number. If you delete this
paragraph of text while in Edit Mode, however, the memo will not be deleted. Instead, it
will be attached to the new paragraph next to it. The memo is not deleted in order to avoid
any accidental deletions of important notes that you have made.
Memos can be moved from one paragraph to another in the „Document Browser“ via drag
and drop, but must remain in the memo column.

9.3 The Memo Window and Toolbar
Wherever you see a memo, you can double-click on it to open it. In the toolbar at the top
of the memo window, you have the following functions:
Print memo
Export memo as an RTF file
Delete memo
Assign a code from the code quick list
Delete code assignment
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If you double-click on several codes in a row, they will be opened in different tabs within
the memo window. You will probably recognize the tab system from your internet browser
– it allows you to have various documents (in this case memos) open at the same time and
quickly switch between them. Clicking on the x symbol in the tab row closes that tab.

9.4 Memos the Document System
Memos can also be attached to aspects of the „Document System“. Right-click on the
name of the “Documents” icon, a document group, or a document, and select Memo. The
memo dialog box appears in its usual form.

Creating a memo for a document from the context menu

Once created, the memo icon will appear next to the entry in the „Document System“ and
can be opened and modified by double-clicking on it. You can also create a memo with the
shortcut Ctrl+M when a document or document group is selected.
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Visualization of a memo in the Document System

A memo attached to the “Documents” icon can be used as a memo or description of the
entire project. The memos for each document could be used for overviews of those documents. You can also see the first few lines of a memo by hovering your mouse over it until
a tool tip appears. It is, therefore, a good idea to have the most important aspects of a
memo in the first few lines.

9.5 Linking Codes to Memos
Similar to document segments, memos can also be linked to a code. You can do this via the
Code Quick List, which is symbolized by the blue arrow in the memo toolbar. Clicking on
this symbol opens the most recently-used codes, so you can choose which ones to assign to
the memo. If the code you are looking for is not in the Quick List, simply click on the code
in the „Code System“ and try again. The code should now be listed at the top of the list.

Linking a memo to a code
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The linked code is then displayed with its complete path (code\subcode\subcode) in the
Codes area in the top right of the memo window.
If you later decide to remove a linked code, simply click on the code in the memo window
and click on the toolbar symbol of the blue arrow with a red x on it.

9.6 Viewing and Editing Memos
The memos attached to a document are visible when the document is loaded in the „Document Browser“. When the mouse cursor is moved over the memo icon next to the document, an information box appears with the memo title, author, creation date and time, and
the beginning of the memo.
If you double-click on the memo icon, the memo dialog box will open again and you will
be able to modify the memo. You can also click on the memo with the right mouse button
and select Open from the context menu to open the memo.
To delete a memo, click on the Delete button in the memo dialog box. You have to confirm the command before MAXQDA removes the memo from the document.
You can also move memos in the „Document Browser“ from one paragraph to another.
Simply click on the memo and drag it to the new location. Memos in the „Code System“
and „Document System“ cannot be moved.

9.7 Creating Code Memos
MAXQDA also allows you to attach memos to codes. These memos often contain the definition of a code or are used to organize the codes. Since code memos are part of the
„Code System“, they are managed in the „Code System“ window, and can be created by
right-clicking on a code.
Example
Let’s say that you wanted to create a memo with a code definition – and later for an anchor example – for the code “Insurance.” You would just need to right-click on the code in
the „Code System“ and select Code memo. The memo window then appears.
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Creating a code memo

After closing the memo, you will see it visualized next to the code in the „Code System“.
For code memos, you will often want to insert an anchor example or explanation of when
the code should be used.
As with other memo types, you can choose one of the 11 different visualization options,
which will then be displayed next to that code.

9.8 Memos and the Windows Clipboard
When working with memos in MAXQDA, the Windows clipboard can be used in the same
way as with text documents. This makes it easy to exchange text between MAXQDA and
word processing programs.
The Windows clipboard may be used in two ways:
 Text can be imported into a MAXQDA memo. Select the text in the word processing
program, copy it with Ctrl+C to the clipboard, and insert it with Ctrl+V into the memo.
 Text can be exported from a MAXQDA memo. Select the memo text or a part of it, copy
it to the clipboard, and paste it into the word processing document.
Copying, cutting, and pasting can be done in MAXQDA and with other Windows programs
with the shortcuts Ctrl+C, Ctrl+X, and Ctrl+V. In some Windows programs, you can also
perform these actions with the Edit drop-down menu.
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9.9 Printing and Exporting Individual Memos
Individual memos can be printed or exported. In the memo window, there are icons for
both:
prints and
exports.
Clicking the print icon causes the memo to be printed out. The memo title is set as the
heading, and the author and creation date/time are listed underneath it. You can also
choose to only print out certain pages.
It is also possible to export the entire memo as a Rich Text Format document. Clicking on
the export icon brings up a Windows dialog field, so that you can choose what to name the
file and where it should be saved.
NY Interview Notes
Document group
New York
Author
Marissa
Creation date
11.02.2011 09:52:38
There were very few interruptions during our interviews in NY. All of them took between 60 and 90 minutes,
and none of the interviewees seemed overly nervous to be talking to us.

An exported memo

9.10 The Memo Manager
Memos aren’t only accessible from their location next to documents, codes, document
segments, etc. They are also available as an Overview of Memos in the Memo Manager.
You can access these overviews in various ways. An overview of all memos in the entire
project can be called up by selecting Memo Manager from the Memos drop-down menu
or by clicking on the

symbol in the Standard MAXQDA toolbar.

The “Memos” drop-down menu also offers several other options for selecting memos to be
viewed:
 All my memos – lists all memos created by the user currently logged in.
 My code memos – lists the code memos created by the logged in user.
 My document memos – lists all memos created by the logged in user that are attached
to documents.
 Memos of the opened document – lists only those memos connected to the document currently open in the „Document Browser“.
 New free memo – creates a new memo unattached to any document, group, segment, or code.
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To see all memos linked to a certain code, right-click on the code and select Overview of
linked memos from the context menu.
However you open the Memo Manager or the Overview of Memos, a table will appear with
a list of the requested memos. Each row represents one memo. If you click on a memo that
is attached to a document segment, the appropriate document will be opened in the
„Document Browser“ at the exact location of that memo. Double-clicking on the memo
opens it for editing.
The columns in the table contain all important information about the memo, including:
 The name of the document and document group in which the memo is found (or the
name of the code in the case of a code memo).
 For memos attached to document segments, the paragraph number of that segment is
listed.
 The author of the memo.
 The creation date.
 A preview of the memo text made up of the first 64 characters
 The origin of the memo (e.g. the document, document group, document segment, or
code the memo is attached to).

The Overview of Memos

As usual in MAXQDA, the columns of the table can be sorted according to any field in the
table, either in ascending or descending order. Simply left-click on the header of the column according to which the table is to be ordered. You can also change the order of the
columns in the table by dragging any column to another position with the mouse.
You can also choose which columns should be included in the table. By right-clicking on
any of the column headers, you will have the option to choose Select fields. You can then
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check the box next to the columns that you wish to view and uncheck the boxes of any
columns you want to hide. You can also sort the table according to a column by clicking on
the column header.
MAXQDA also allows you to search in various columns. Right-click on the column header
and select Search. You can then enter the word you are searching for into the field. If the
word you are searching for is not necessarily the first word in the string, you can insert a
“*” symbol in front of the word. If you enter a search string of “Kennedy,” for example, it
will not find the entry “John F. Kennedy,” since “Kennedy” is not the first word. A search
for “*Kennedy,” though, would bring it up (see Searching for Text: The Lexical Search).

9.11 Jumping from a Memo to a Document
From each memo displayed in MAXQDA’s Memo Manager, you can jump to the position in
the document that the memo is attached to. You need only click on the desired memo
with the left mouse button. The source document immediately appears in the „Document
Browser“ positioned exactly at the place where the memo is found.
This option only works with memos attached to document segments, of course. If you click
on a code memo, the „Document Browser“ remains unchanged, but the code is highlighted in the „Code System“. The same happens with memos that are attached to objects in the „Document System“.

Jumping from a memo to a document
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9.12 Searching for Text in Memos
The Memo Manager allows you to search in each of the columns, but you are limited by
the fact that the preview only includes the first 64 characters of the memo. Searching the
complete memo text is only possible with the lexical search function.
The lexical search procedure is described in detail in Section 13 (see Searching for Text: The
Lexical Search). The only difference is that you have to select the option to search In memos so that MAXQDA searches there and not in the documents.

Searching for “health” in the project memos

The results are shown as a list of all memos that contain the search string in the memo text.
This table can be worked with as described above. You can sort, jump to the document,
edit the memos, etc.

9.13 Viewing Memos Linked to a Code
Codes can be linked to memos in order to indicate what the memo is about. Of course, you
can choose a descriptive title for a memo, based on the content of the memo, but to attach
codes is a more systematic way to attach more thematic topics than could be formulated in
a memo’s title.
To find all memos that are linked to the same code, right-click on the code in the „Code
System“ and select Overview of linked memos from the context menu that appears.
The result is a table of memos. The table contains all the memos to which the code is attached. As usual, double-clicking on a row opens the memo and a single click brings the
source document into the „Document Browser“ window.
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The table can be sorted according to its columns and it can be exported to other programs.

9.14 Options in the “Memo” Menu
The MAXQDA “Memos” drop-down menu includes the following functions:
 Memo Manager – opens a list of all memos in the entire project.
 All my memos – lists all memos created by the user currently logged in.
 My code memos – lists the code memos created by the logged in user.
 My document memos – lists all memos created by the logged in user that are attached
to documents.
 Memos of the opened document – lists only those memos connected to the document currently open in the „Document Browser“.
 New free memo – creates a new memo unattached to any document, group, segment, or code.
To see all memos linked to a certain code, right-click on the code and select Overview of
linked memos from the context menu.
However you open the Memo Manager or the Overview of Memos, a table will appear with
a list of the requested memos. Each row represents one memo. If you click on a memo that
is attached to a document segment, the appropriate document will be opened in the
„Document Browser“ at the exact location of that memo. Double-clicking on the memo
opens it for editing.

9.15 Memos in a Specific Document or Document Group
The memos belonging to a particular document group, document set, or document can be
viewed in a table. Right-click on the selection and choose Overview of Memos from the
menu that appears.
MAXQDA will then open a table similar to the Memo Manager table containing all the
memos attached to these document(s). As with the Memo Manager, it is possible to sort
the table, search in the different columns of the table, jump to the source document, and
export the table or parts of it to an external file or to the clipboard.

9.16 Exporting a Selection of Memos
The result of a search for specific words in memos is a table listing all the memos containing the words. The same type of result, memos in a table, is obtained through a search for
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linked memos or when viewing the memos attached to a document or document group, as
described above.
These tables of memos can be exported, that is saved as a file to be opened with another
program. You can save the table in XLS/X, RTF, or HTML format. Click on one of the Export
buttons located in the upper left corner of the dialog box, and choose appropriate the format.
The exported RTF file appears as follows:
Title
Document
Paragraph
Author
Creation date

Life strategy and mental health
New York\Vincent
9
Marissa
12.02.2011

Again, this touches on Vincent's life strategy. He is able to maintain "strong mental health" and have a positive
attitude even though he realizes he's "an accident waiting for a place". Again, it seems like his previous life
strategy enabled him to successfully deal with the situation.
Is it just Vincent's PMA that enabled him to cope, or is there something more? Other people use religion or a
support network (friends, family, etc.) to get through tough situations - is that the same sort of thing going
on???

Part of an exported memo table in RTF format

Here you see all the information contained in the memo, such as memo title, creation date,
and linked codes as well as the memo text itself. The exported RTF file can be opened in
your word processing program to add layout features like headers and footers.
If you choose HTML or XLS/X as the export format, MAXQDA creates a table that is immediately opened in your default web browser such as Internet Explorer or Excel. It is also easy
to print out the list in these formats.

Results of a memo export in HTML format
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9.17 Memo Tables in Excel and Word
It is very easy to export the entire table of memos or a selection of memos from MAXQDA
into Microsoft Word or Excel.
 Click on the Excel symbol
in the toolbar, and MAXQDA will create an Excel file and
open it in the appropriate program. You can then save the file again to a location of
your choice.
 You can also click on the export symbol
in the Memo Manager and then choose
Excel as the export format and assign it a name.
Tip: The entire table with all of your memos will be exported unless you have selected some
of the memos, which are then marked yellow. You can select a single menu by clicking on
it with your mouse. If you want to select more than one, hold the Ctrl button as you click
on them. If you want to select a number of memos that are right next to each other in the
list, click on the first one, hold Shift, and then click on the last one. All of the memos in
between the first and the last will also be included in the selection.
The easiest way to transfer to the table to Word is to first open it in Excel and then just
copy and paste.

Selected memos are yellow in the memo table
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9.18 Converting a Memo into a Document
Since memos are used to assist in the development of ideas and hypotheses, it could happen that they quickly become very important to your analysis. In some cases, these memos
may be important enough that you would want to convert them into documents, so they
could be analyzed and coded. It is only possible to associate an entire memo with codes,
while every single character of a document can theoretically be coded as many times as
needed.
To convert a memo into a document, follow these steps:
 Open the Memo Manager
 Select the memo(s) to be transformed
 Right-click on the memo
 Select Convert to a document
The newly-created document will now be listed as the first document in the „Document
System“. The first lines of the document are the former memo’s title, author, and creation
date.
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10 Variables
10.1 Variables (Attributes) in MAXQDA
The newest version of MAXQDA differentiates between document variables and code variables. In addition to the document variables – known in previous versions simply as variables or attributes – there are now code variables as well, which were added based on the
difficulties associated with analyzing group discussions.
Document variables are associated with an entire document, (e.g. the person interviewed in
an interview transcript). In these cases, you can assign socio-demographic information like
gender, age, education level, etc. that can then be analyzed in conjunction with the actual
text. Since the document variables are always connected to an entire document, it isn’t
possible to assign several values for each document variable. If a transcript includes various
interviewees, as would be the case in a group discussion, document variables are not
enough. In these cases, one would want to assign variables for each speaker. In these cases, you can use code variables, which make it possible to input as many different sets of
variables as you wish within a single document. The term “code variable” indicates that the
variables are actually assigned to a code rather than to a document. In a group discussion,
you can create a code for each speaker and then assign variables for that speaker’s code
(see Code Variables).

10.2 Document Variables
MAXQDA allows you to create a set of variables (attributes) for each of your documents.
They are linked then to an entire document and are therefore called “document variables.”
When you start a new project, the List of Variables holds only a few variables, which are set
automatically by MAXQDA:
 Document Group – contains the name of the document group that a particular document is a part of
 Document Name – contains the name of the document
 Creation Date – contains the date the document was imported/created
 Number of Coded Segments – contains the number of coded segments in the document
 Number of Memos – contains the number of memos in the document
 Author – the user that was logged in when the document was imported or created
 Bytes – the size of the document in bytes
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You can access information about the variables with the Variables drop-down menu or by
clicking on the appropriate icon in the Standard toolbar.

Icon for the List of Variables

The number of variables is not limited; you may add new variables or remove them whenever you’d like. However, MAXQDA is not designed to be a statistical program, but rather a
program for qualitative data analysis and mixed methods approaches, where working with
more than 100 attributes is rather unusual.
Document variables are created for the entire project, which means you cannot create different variables for each document group.

10.3 Code Variables
The development of code variables in MAXQDA 10 makes it possible for you to set variables for a section of a document rather than the entire document. As with document
variables, code variables can then be used as selection criteria during the analysis process.
These sections of a document can, for example, represent a certain speaker in a group discussion, for whom you would like to assign certain variables, such as age, income, education level, etc. You can then choose to only see what people between the ages of 50 and
60 with an annual income of $50,000-$75,000 said about a certain theme.
Working with code variables requires that you have already coded the specific sections of a
document as having been spoken by a certain person (e.g. things John Smith said would be
coded as “Smith” or “JS.”)
It is then necessary to create a top-level code, such as “Speakers,” as shown below. “Kermode,” “Tyler,” “McLuhan,” and “Seldes” represent the individual people that speak a
different points in the documents.

Top-level code “speakers” with the individual speakers as subcodes
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List of Variables

To see your code variables, right-click on the top-level code and choose Overview of code
variables. A window with the code variables then appears in the variable view. This variable view is the same as for the document variables. When you first open this view, as with
the document variables, there are only a few system variables to be viewed. Here you have
the option of defining variables and variable values for the speakers represented in the subcodes, e.g. age, gender, income, etc.
The management of code variables is exactly like that of the document variables, so they’ll
both be described together.

10.4 List of Variables
MAXQDA differentiates between two views of your data: the “variable view” and the “data view.” The variable view allows you to create new variables. The data view displays the
variable matrix that is organized like an Excel worksheet. All variables have to be created
before you can enter values.
When you open the variables dialog box for the first time, the table is not empty – as you
would probably expect – since MAXQDA has already automatically created internal variables or “system fields.” Later on, you may identify these variables because of their red
symbol listed in the first column of the table. A symbol located in the toolbar of the variable
view allows you to create new variables. Another symbol offers to switch to the data view.
The column to be displayed allows you to select the variables to be displayed in the data
view. If you work with many variables the data view may be a bit confusing. Thus, the opportunity to select only the variables currently needed can be very helpful.
The Variable List for Document Variables
You can access the variable list for the document variables by selecting “Edit” from the
“Variables” drop-down menu or by clicking on the variables icon in the MAXQDA Standard
toolbar.

Icon for the variables list

When you open the list of variables for the first time, system variable that are already
created include:
 Document group
 Document name
 Creation date
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 Number of coded segments
 Number of memos
 Author
 Bytes

An example of the List of variables (in variable view)

You can tell which variables are system variables, because they are listed with a red symbol
in the far left column. User-defined variables are visualized with a blue symbol. System variables cannot be deleted.
The Variable List for Code Variables
There are also system variables in the overview of code variables, which can be accessed by
selecting “List of code variables” from the “Variables” drop-down menu. When you open
the list for the first time, the following system codes are already included:
 Position
 Parent code
 Code
 All coded segments
 Activated coded segments
 Author
 Creation date
System variables cannot be edited here. If a code name has been incorrectly entered, you
can only change this in the „Code System“ window.
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List of Variables

The Overview of variables can be sorted in alphabetical or reverse alphabetical order just
like any other table in MAXQDA. Simply click once or twice on the column header you
would like to sort by.
A new variable can be created as follows:
1. Select List of variables from the Variables drop-down menu
2. Click on the New variable icon in the toolbar or use the shortcut Ctrl+N.

Creating a new variable with the icon in the toolbar

You can now insert a name for the variable and choose its type. There are five different
types of variables to be chosen from:
 String (text)
 Integer
 Floating point (number)
 Date/time
 Boolean
When creating an integer variable, you also have the option of defining whether it is a metric or a categorical variable. The variable for age, for example, can be handled in various
ways: if you want to enter the age in years, you are dealing with a metric variable, for
which you may want to establish a mean. If you have defined ages into categories (e.g. 1 =
under 18, 2 = 18-30, 3 = 31-50, 4 = 51+), then you are dealing with a categorical variable,
for which you would not want to find a mean value.
You can also select what value should be inserted automatically for those cases where there
is a missing value. This is especially important if you are planning to later export the data to
a statistics program like SPSS or SYSTAT.

Variables

133

To avoid confusion, it is recommended that you do not create two variables with the same
name. Statistics programs do not allow for two of the same name.
To avoid confusion, it is recommended that you do not create two variables with the same
name. Statistics programs do not allow for this, which could cause problems later if you attempt to export data from MAXQDA to that program.
If you are planning to later export the data to such a program, it is recommended that you
choose integer as your variable type if you aren’t sure which to use. SPSS can now automatically transform a string into a numerical variable, though, which allows you to create a
more user-friendly string variable. For example, it is easier to avoid confusion, when you see
“Gender = Male” rather than “Gender = 0.”
In MAXQDA, there is no limit on the number of variables you create, whether they be document or code variables. Every time you click on the New variable icon, you’ll be taken
through the steps for defining it.
When creating a name for your variable, it is important that you think ahead. MAXQDA lets
you create a name with up to 64 characters, and there aren’t any syntax rules, meaning you
can use several words with spaces and special symbols.
Tip: If you are planning on exporting your variables later to another program, though, you
should check on this other program’s requirements. Many statistics programs are more restrictive; SYSTAT/MYStat, for example, only allows for variable names with eight or fewer
characters, as was the case with earlier versions of SPSS. The variable names are also often
used in MAXQDA’s visual tools (usually as column headers), so long variable names can also
take up more space than you would want them to.

10.5 The “Data View”
MAXQDA differentiates between two views of your data: the “variable view” and the “data view.” The variable view allows you to create new variables. The data view displays the
variable matrix that is organized like an Excel worksheet. All variables have to be created
before you can enter values.
You can access the “data view” in three ways:
1. selecting Edit from the Variables drop-down menu;
2. right-clicking on the Documents icon at the top-level of the „Document System“ and
selecting Overview of Variables (you can also do this on the document or document
group level, which will then only show those variables for that document or group); or
3. clicking on the data view button in toolbar of the variable view.
The overview of code variables is only accessible via the codes and subcodes that contain
the variables. If you’ve created a code called “Discussion Participants,” for example, with
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The “Data View”

subcodes with the names of each of the participants, you can right-click on that parent
code and select Overview of code variables to see the code variables for that code and all
the subcodes.
The variable table includes a toolbar with the following functions:
Excel table – saves and opens a table in XLS/X format with the rows you have selected in the variable table.
HTML table – saves and opens a table in HTML format with the rows you have selected in the variable table.
Export – opens a window, so you can save the selected rows of the variable table in
XLS/X, HTML, or tab-delimited text format.
Variable view – switches between the data view and the list of variables.
There are also two context menus available. One appears when you right-click on the variable name in the column headers, and the other appears when you right click on a cell.

The context menu in the variable view

If you have created a large number of variables, it quickly becomes difficult to see then entire table at one time. You can view more columns at one time by making the columns
thinner (click and drag the separator between column headers), but eventually even this
does not suffice.
You do, of course, have the option of scrolling to the right, but you can also change the
order of the columns by clicking on a column header and dragging it to the location where
you would like to have it. It’s easier, though, to simply hide those columns that you aren’t
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working with. To do so, simply right-click on any column header and choose Select fields.
You can then check the boxes next to the columns you would like to view and uncheck the
boxes next to the columns you want to be hidden.

Variable selection of columns to be viewed

Besides (un)checking the boxes one by one, you also have the following options:
 select all fields
 deselect all fields
 only system fields (those automatically created by MAXQDA)

10.6 Entering Variable Values in Data View
MAXQDA gives you various ways to enter variable values for documents:
 You can open the entire variable table by selecting Edit from the Variables drop-down
menu or by right-clicking on the Documents icon in the „Document System“ and selecting Overview of variables.
 You can open the variable table for all documents in a specific document group by
right-clicking on that group and choosing Overview of variables.
 You can open the variable table for a single document by right-clicking on that document and selecting Overview of variables.
To enter code variable values, you can choose one of the following options:
 You can call up all code variables for subcodes of a parent code by right-clicking on the
parent code and selecting Overview of code variables.
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 You can call up the code variables for a single code by right-clicking on that code and
choosing Overview of code variables.
However you choose to open the table for inputting variable values, the next steps are the
same:
Double-click on the cell of the table where you would like to insert a value. The values that
have already been given to any of the cases in the column are in the quick list, sorted alphabetically. You can view this list and select a value from it by clicking on the triangle to
the right of the cell you double-clicked on.
If the value isn’t available in the quick list, you can simply type in the value after doubleclicking in the cell.
Tip: Pick lists are less useful when a variable has many different values (e.g. the exact income of every interviewee). Even if the value was in the pick list, it would be faster to type
it in than to search for it. You can stop the program from displaying a column’s pick list by
right-clicking on the column header and selecting (to uncheck) List of values.

Options for the variable value in the quick list

10.7 Renaming and Deleting Variables
Variables can be given a new name at any time. Switch to variable view, then double-click
on the variable, and enter the new name.
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Renaming a variable in the variable view

Renaming a variable has no effect on the values stored in the variable’s column, but it does
have an effect on the saved specifications for activation by variable function. This procedure
can save logical search formulas using variables to a file. These files are not refreshed when
you rename a variable. Thus, the saved formulas may no longer work when you reload
them because the variables mentioned in the formula no longer exist.
Deleting a variable is done in the same way as renaming it. Select the variable you want to
delete with the mouse. Now the focused variable is highlighted (yellow bar). Then click the
Delete variable button in the toolbar.
When you delete a variable, the whole column including all its values will be removed from
the table.
You can save background information about each document in a document memo. To
create or modify this memo, switch to “data view” and right-click on the row containing
the document. The context menu gives you access to this memo and to several overviews.
Once created, you will see the memo beside the document in the „Document System“.
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Context menu in the data view

10.8 Exporting the Table of Variables
The variables attached to the documents are not only used to save standardized information that is a part of every document (e.g. the names of interviewers, or the gender of interviewees), but can also be used in MAXQDA as criteria for retrieval (see Activation by Variable: Variables as Selection Criteria for Retrievals). Evaluating quantitative attributes, however, is only possible with a statistics program. MAXQDA does not offer any statistical analysis except for that of the frequency of codes.
A rectangular variable matrix is created using the values of variables entered for all documents. The matrix’s column headers hold the variables; thus, there will be as many columns
as variables. The documents (in our example, the interviewees) are the first column. Hence,
the matrix has as many rows as there are documents in the „Document System“. Each cell
holds a variable value for the given variable and document.
Var. 1

Var. 2

Var. 3

Doc A

1

11

6

Doc B

2

12

5

Doc C

3

23

3

...

1

25

3

...

3

26

2

Doc N

0

29

2

Variable matrix with documents and variables

...

...

Var. N
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So that you can immediately start analysis in a statistics program, you have the option of
exporting this matrix in various ways:
 Click on the Export button in the toolbar.
 Give the exported file a name. You can also select exactly where you want to save the
file.
 For the file format, you can choose between XLS/X, HTML, and TXT (tab delimited).
Most statistics programs work just fine with XLS/X files.
 Select OK.
The exported file will then be opened in Excel and can be immediately analyzed.
In many statistics programs, the variable names are much more limited than in MAXQDA.
Rather than allowing for up to 64 characters (including special characters), some programs
allow for only 8. It is also not possible to have more than one variable with the same name
in many of these programs.

Exported variable matrix in Excel

Tip: The variable matrix can also be transferred via the Windows clipboard. Simply highlight
the section of the table that you want to move and hit Ctrl+C to copy it. Then open Excel
and hit Ctrl+V to paste.

10.9 Importing the Variable Matrix into SPSS
Importing the variable matrix from MAXQDA into SPSS is easiest when you use the Excel
format:
 Choose Export data matrix from the Variables drop-down menu.
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Importing the Variable Matrix into SPSS

 Choose the Excel format (XLS/X), give the file a name, and choose where you want to
save it.
 The file will then be opened automatically in Excel, so you can check that everything is
formatted correctly. Close the document, so SPSS will be able to open it.
 Open SPSS and choose the option to open data. Change the data type to Excel.

Choosing the file type in SPSS

 Navigate to the file you just saved and double-click on it.
 Make sure the box Read variable names from the first row of data is checked and
click OK.

Setting the import settings in SPSS
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The results will look as follows:

Variable matrix of the document variables imported into SPSS

10.10
Importing the Variable Matrix for Document
Variables
There are several situations in which you might want to import document variables into
MAXQDA, such as:
 If you want to analyze answers to open-ended questions in combination with the quantiative socio-demographic information that you acquired for each of those who filled
out the survey. Usually, you will already have this quantitative data in a matrix of some
sort, and re-entering that information into MAXQDA would just cause you unnecessary
work.
 If you and others in a research team each entered variable values for various documents
and now want to bring them all together.
 If you did statistical analysis on material that you exported from MAXQDA and now
want to reimport the results of your statistical analysis into MAXQDA. You could, for
example, have done a culster analysis, and now want to import the information about
which cluster each document belongs to as a variable into MAXQDA. If you want to
avoid entering each one of these new values by hand, you can simply use the variable
import option.
MAXQDA can import data from XLS/X or TXT (tab-delimited) files. If possible, you should
always use the Excel format, since it is the easiest to work with. No matter which format
you use, though, it should be organized as follows:
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documentgroup

documentname

Variable 1

...

Variable N

Group 1

Text 1

Variable value for
Text 1

Variable value for
Text 1

Group 1

Picture 1

Variable value for
Picture 1

Variable value for
Picture 1

The first two column headers serve as markers for assigning variable values to the documents and are required for successful import. Every row must have an entry for the document group and document name columns. Only if these exact group and document names
are found in the Document System of the MAXQDA project, will the variables and variable
values be imported. You can also use the column headers “textgroup” and “textname” in
place of “documentgroup” and “documentname.” You can then include as many different
variable columns as you wish.
Tip: It is not possible to import variable values for documents that are not assigned to a
document group.
After preparing the document, be sure to save and close (!) it. You can then start the import procedure by selecting “Import” from the “Variables” drop-down menu.
A dialog field appears in which you can specify the source and target variables along with
the type of variables to be imported.
MAXQDA does the following during the import:
1. All variables in the import file that did not yet exist in the MAXQDA project are created
2. Variables that already existed will be updated with the new values in the import file.
Tip 1: If you don’t see the new variables in the variable list after import, it may be that they
need to be toggled on. To do this, right-click on one of the column headers and choose
“Select fields.”
Tip 2: An easy way to set up an Excel file for importing new values is to first export the variable data matrix as an Excel file by clicking on the Excel icon in the toolbar of the variable
list. An Excel file with all of the current variables will open up, and you can then add new
columns for new variables and update variable values that you want changed. All you have
to do after that is save the Excel file and import it into MAXQDA.

10.11

Importing the Variable Matrix for Code Variables

MAXQDA can import data from XLS/X or TXT (tab-delimited) files. If possible, you should
always use the Excel format, since it is the easiest to work with. No matter which format
you use, though, it should be organized as follows:
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Code

Subcode

Variable 1

...

Variable N

Code 1

Subcode 1

Variable value for
subcode 1

Variable value for
subcode 1

Code 1

Subcode 2

Variable value for
subcode 2

Variable value for
subcode 2

Die ersten beiden Spaltenüberschriften dienen der eindeutigen Zuordnung der Variablenwerte zu einem Code, daher sind diese beiden Spalten und ihre Überschriften obligatorisch.
Jede Zeile muss deshalb die Angabe eines Obercodes und eines Codes in der entsprechenden Spalte enthalten. Nur wenn ein mit diesen Angaben genau übereinstimmender Code in
der „Liste der Dokumente“ gefunden wird, erfolgt ein Variablenimport. In den weiteren
Spalten können so viele Variablenspalten wie benötigt angefügt werden.
The first two column headers serve as markers for assigning variable values to the codes
and are required for successful import. Every row must have an entry for the code and subcode columns. Only if these exact codes and subcodes are found in the Code System of the
MAXQDA project, will the variables and variable values be imported. You can then include
as many different variable columns as you wish.
Tip: It is not possible to import variable values for top-level/parent codes.
After preparing the document, be sure to save and close (!) it. You can then start the import procedure by right-clicking on the parent code and choosing “Import code variables.”
A dialog field appears in which you can specify the source and target variables along with
the type of variables to be imported.
MAXQDA does the following during the import:
1. All variables in the import file that did not yet exist in the MAXQDA project are created.
2. Variables that already existed will be updated with the new values in the import file.
Tip 1: If you don’t see the newly-imported code variables in the code variable list, it may be
because they were toggled off. Simply right-click on a column header and choose “Select
fields” to change which variables are viewed.
Tip 2: An easy way to set up an Excel file for importing new values is to first export the variable data matrix as an Excel file by clicking on the Excel icon in the toolbar of the variable
list. An Excel file with all of the current variables will open up, and you can then add new
columns for new variables and update variable values that you want changed. All you have
to do after that is save the Excel file and import it into MAXQDA.
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11 Retrieval: Finding Coded Segments
11.1 Activation: The Principle of Segment Retrieval
In MAXQDA, you can search for information in your documents in a variety of ways. One
method is to search for particular words or character strings with the lexical search function. You may be familiar with this search method from text-processing programs. The
principle is basically the same in MAXQDA, with the advantage that you can search many
documents simultaneously for the words. A lexical text search finds only those terms that
actually appear in the text. Searching with theoretical concepts and subject categories, such
as “Helper Syndrome“ in a study of volunteers in social work, will naturally not provide any
results.
By assigning codes to appropriate document segments, you be able to find segments that
relate to a certain theme. This finding of coded segments, also known as retrieval, requires
only that you have created codes and assigned them to those document segments. After
you have assigned codes to the document segments, you will be able to call up all segments that were coded with the same code. MAXQDA offers various ways to do this retrieval, but it is all based on activation of documents and codes.
The following explanation applies not only for texts, but also for coded segments of images
and PDFs. The more complex retrieval functions – which show, for example, the proximity
of codes to one another – can only be used for text documents (see Complex Retrievals).
The retrieval principle in MAXQDA is very simple:
All document segments from activated documents that were coded with any of the activated codes will be called up and shown in the „Retrieved Segments“ window.
Activating Documents
First the documents: All documents and document groups are listed in the „Document System“. When you import a document, it appears in the „Document System“, but it isn’t at
that point opened or activated.
The starting point, then, is an inactivated document. The status of the document – whether
activated or not – can be seen by its color. Inactivated documents are blue-green, and activated documents are red.
An inactivated (left) and an activated (right) document

And how do you activate a document? There are two ways to activate documents:
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1. Activation via the Context Menu
The first way to activate a document is with the context menu. Simply right-click on the
document and select Activate.
You will know that the document is activated, because it will turn red.
In the same way, you can activate entire document groups. Right-click on the document
group and select Activate all documents.
You can even activate all documents in your entire project at one time by right-clicking on
the Documents icon at the top level of your „Document System“ and selecting Activate
all documents.
2. Activation with the Ctrl Key
Tip: There is an even easier way to activate than via the context menu: simply hold the Ctrl
key on your keyboard and click on a document, document group, or the “Documents”
icon.
Activating Codes
Activating codes works in the same way as for documents. Either right-click on a code and
click to activate or hold the Ctrl key and click on the code.

Activating a code via the context menu

Activated codes are also visualized in red.
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Activation Status in the Status Bar
The status bar at the bottom of the MAXQDA window gives you information about the
number of activated documents, activated codes, and the number of document segments
that are being called up based on those activations.

Activation information in the status bar

When you activate a parent code, your settings will determine whether the subcodes are
automatically activated with it. You can change this setting by right-clicking on a code and
clicking on Activate codes together with subcodes. If a checkmark was showing next to
that line, selecting it will remove this checkmark, and subcodes will not automatically be
activated with the parent code. Your settings for that code will be saved until you change
them again.
All of the document segments that were found based on your activations are called retrieved segments or coded segments and are shown in the „Retrieved Segments“ window.

Called up document segments (coded segments) based on activated documents and codes

You also have the option of automatically activating documents based on their variable values. This is known as “Activation by variable” in MAXQDA. How to use this function is described in the section Activation by Variable: Variables as Selection Criteria for Retrievals.
Attention: If you are working with an extraordinarily large data set, your computer’s
memory could be overwhelmed by retrievals that pull from every single document in your
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„Document System“. For this reason, it is recommended that you do not activate all codes
and all documents at once when doing retrievals in unusually large projects.
Example
Let’s say that you wanted to know what certain interviewees (e.g. Joanna, Kim, and Vincent) said about other people in their lives. You would start by activating the appropriate
documents in the „Document System“:
 Hold the Ctrl key
 Left-click on the document “Joanna”
 Left-click on the document “Kim”
 Left-click on the document “Vincent”
Next, you will need to activate the appropriate code. In this case, the code is called
“People.” If there are subcodes for this parent code, those subcodes will be activated as
well (assuming you have not changed the default settings).
You can now see some basic information about your activations in the status bar. It shows
that you have activated three documents and five codes (this includes the four subcodes of
“People”). You can also see that 14 document segments were retrieved based on those
activations:

Activation information found in the status bar

11.2 Activation by Color
Documents and codes can be activated manually (by clicking on them), automatically (via
activation by variable), and also by color. There is a symbol
in the toolbars in the
„Document System“ and the „Code System“ that lets you select the colors to be activated.
After clicking on this button, a dialog field appears with all the colors that have been used
for documents/codes so far. You can then check the box next to the colors to be activated.
The two radio buttons at the top also let you check or uncheck all of the colors with a single click.
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The colors representing codes or documents to be activated

11.3 Removing Activations (Deactivation)
When you want to start a new retrieval, but already have documents and codes activated
from a previous retrieval, the easiest way to proceed is to automatically deactivate all of
those documents and codes.
In the Standard MAXQDA toolbar, you will find a button that resets all activations, both
document and code activations. It is right between the buttons for opening a project and
activation by variable.

Button to “Reset activations”

If you want to reset activations for only the documents or only the codes, you can do so
with the button available in the „Document System’s” or “Code System’s” toolbars.

Button to “Reset activations” for all documents in the Document System

Button to “Reset activations” for all codes in the Code System
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It is also possible to deactivate all codes or documents by right-clicking on the Documents
icon in the „Document System“ or the Codes icon in the „Code System“ and selecting
Deactivate all documents or Deactivate all codes.

11.4 The Retrieved Segments
You can see in the „Code System“ whether or not each code has been assigned to any
document segments. The number to the right of each code tells you how many document
segments have been given that particular code. If you want to purely work qualitatively and
are annoyed by these numbers, you can choose to hide these numbers in the Options window in the Project drop-down menu. The following screenshot shows you, for example,
that the code “Recreation” has been used to code 14 documents segments.

Information about how many documents segments have been coded with each code

Attention: If there are no numbers listed next to your codes, the option to show these numbers as probably been turned off. To change that setting, go to the Options window in the
Project drop-down menu.
The „Retrieved Segments“ window is a results window – it shows you all of the coded
segments that were coded with any of the activated codes in any of the activated documents. The toolbar at the top of the window gives you quick access to the following functions:
Print retrieved segments – prints all retrieved segments with the information that
appears in the yellow info box next to those segments.
Show as Excel table – opens a table in XLS/X format with the retrieved segments and
associated information.
Show as HTML table – opens a table in HTML format with the retrieved segments
and associated information.
Export retrieved segments – allows for export of the retrieved segments in RTF,
HTML, or XLS/X format.
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Overview of retrieved segments – opens a table view of the retrieved segments.
Code retrieved segments – allows you to choose a code from the „Code System“ to
code all retrieved segments with.
Code retrieved segments with a new code – allows you to create a new code and
use it to code all retrieved segments.
Context search – opens a search field in the toolbar to search for text within the retrieved segments.

Segments retrieved based on activated documents and codes

Next to each retrieved segment (default is on the left side), you will find a yellow info box
about each retrieved segment and a memo column, showing any memos that were attached to the retrieved section of the document. If you want, you can also move the info
boxes to the right side of the „Retrieved Segments“ window, but the memo column always
remains on the left.

Info box for a retrieved segment

The info box above can be read as follows: the segment cam from paragraphs 10-13 in the
document “Kim,” which is in the Document Group “New York.” The segment was coded
with the code “Health,” which is a subcode of the code “Interview Guide Topics,” and the
weight score for the coded segment is “100.”
If you click on any part of the info box, the associated document will automatically be
opened in the „Document Browser“ window at that part of the document where the associated coded segment can be seen (paragraphs 10-13). This segment is also highlighted.
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The associated code is also highlighted blue automatically in the „Code System“ window. If
you right-click on the info box, you will see the following context menu:

Context menu for the yellow info box

It is possible here to delete the particular coded segment, but that does not delete the actual code from the „Code System“ or the document segment from the document. You will
have to confirm your deletion. You can also change the weight score for the coded segment. If you select Modify weight, the following window will appear:

Modifying the weight score of a coded segment

You can also carry out other functions by right-clicking on a gray area of the column where
the info boxes appear. These same functions are also available in the Analysis drop-down
menu.

Context menu that appears when you right-click in a gray section of the column

All functions in this context menu connect to the entire „Retrieved Segments“ window or
the to the retrieval itself rather than to an individual retrieved segment.
By clicking on Text retrieval, you can choose from a variety of different forms of retrieval.
There are ten different options.

152

The Retrieved Segments

Text retrieval options

MAXQDA differentiates between simple text retrieval (the “OR-Combination”) and the
more complex retrieval options. The more complex options include, e.g. retrieval of overlapping coded segments or coded segments that are near each other.
The standard analysis is the “OR-Combination,” which means it will retrieve all segments
coded with any of the activated codes in any of the activated documents. A segment could
be coded with “Code A” or “Code B” or “Code C.”
More information about the complex retrieval options can be found in the section Complex
Retrievals.
The next few functions in the context menu affect the sorting of the retrieved segments.
There are three possible variations:
 Ordered by Document System – this means that the segments are listed in the same
sequence as in the „Document System“. The list starts with the segments of the first activated document in the „Document System“, then those of the second activated document are given, and so on. Search results in this order would let you compare what
one respondent said to different selected topics. For example, given that the first respondent’s answers were contained in one document or interview, followed by a second
respondent’s answers in a separate second interview, all of the retrieved segments from
the first interview would be listed before those from the second interview.
 Ordered by Code System – this means that the segments are listed in the same sequence as the codes in the „Code System“. All of the segments assigned the same code
are listed one after the other.
 Ordered by weight – This sorts the segments according to the weight that has been
assigned to them.
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Setting the order of the retrieved segments

11.5 Hierarchy of Codes in Retrieval
The third group of options offered in this context menu (as well as in the Analysis dropdown menu) deals with integrating subcodes in the retrieval process and with weight
scores.
A hierarchical system of codes can be constructed with MAXQDA. The program offers an
easy way to make use of the hierarchical structure. Imagine you want to check if there are
co-occurrences of Code A and Code B, and Code B has two subcodes, B1 and B2. If you
activate these codes, in total four codes would be activated: A, B, B1, and B2. Now, when
selecting the Intersection or Overlapping options, MAXQDA will search for text passages
where all of the four codes are present. Obviously this is not what you want, since it is very
unlikely that there are segments to which all four codes are attached. (Code B1 and Code
B2 are likely exclusive: either B1 or B2 is attached but not both of them.) To get the desired
result, you would have to split the analysis in three parts:
1. Search for co-occurrences of Code A and B1.
2. Search for co-occurrences of Code A and B2.
3. Search for co-occurrences of Code A and B.
This is obviously a very inconvenient way of getting results, particularly if a code has many
subcodes or even different levels of subcodes. MAXQDA does, however, offer an easier
way. Simply click to include subcodes in the context menu.
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Subcodes will be included

It is also shown in the status bar, whether or not the subcodes (or “code children”) are included. If the symbol is crossed out, the subcodes are not included. You can also change
this setting by double-clicking on this icon.

Subcode inclusion shown in the status bar

Going back to the example above: if both Code A and Code B are active, and include subcodes is selected, MAXQDA will find all co-occurrences of Code A (or any subcode of Code
A) and Code B (or subcodes of Code B)

11.6 Finding Coded Segments Using Weight Scores
The context menu also lets you choose whether or not weight scores should be used to
filter your results. You will see the weight score of each retrieved segments at the top-right
of the corresponding yellow info box.

Weight score in the info box next to each retrieved segment

These weight scores can be used for the retrieval process. The user can define a range for
the weight scores in order to retrieve only those document segments with scores inside of
that range.
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If you choose to activate the weight filter, the following window will appear. You can enter
any numbers between 0 and 100.

Weight filter

This will cause only those segments to be displayed in the „Retrieved Segments“ window
that have a weight score within the defined range. The weight filter affects all retrieval
functions, including complex functions like “Intersection.”

Display of weight filter in the status bar

The status bar at the bottom of your screen contains information about the document and
codes that are currently active as well as the weight option, symbolized by the paperweight. This icon tells you if the weight filter is active or not, and its range, if it is. In the
figure above, the weight filter is active with a range from 1 to 75. This means that only
those codes that have been given a weight score between 1 and 75 will be displayed.

11.7 Jumping from Retrieved Segment to the Original
Document
It is possible at any time to jump from a coded document segment in the „Retrieved Segments“ windows to the original source document.
To the left of each segment, you can see from which document and paragraph the segment was taken, and which code was assigned to it.
If you click anywhere in this box, the original document from which this segment was taken
will be opened in the „Document Browser“ window at the position of the segment in the
document.
When examining the results of a retrieval, you should arrange your desktop as shown below. The source document is in the upper window, and the „Retrieved Segments“ window
is below it. Then, whenever you click on a segment’s information box, the source document
will appear in the „Document Browser“ window directly above it.
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Optimal view for jumping between retrieved segments and the source documents

11.8 Overview of Retrieved Segments
An easy way to get an overview of the retrieved segments is by calling up the Overview of
retrieved segments by clicking on the appropriate icon in the toolbar at the top of the
„Retrieved Segments“ window.

Opening the Overview of retrieved segments in the toolbar

This display combines a list view and a detailed view of the retrieved segments. The upper
half of the window shows the segment that is currently selected in the lower part of the
window. The lower part works in the same way as the other overview tables in MAXQDA.
Clicking on the column’s header will result in sorting the table corresponding to the values
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of the selected column. You may also switch the different columns on and off. Just rightclick on a column header and select Choose fields. You can then specify which columns
should be shown (box checked) and which should not (box unchecked). This kind of display makes it easy to browse through retrieval results. Just click on a line in the table and
then view the segment in the upper part of the window.

The two windows in the “Overview of retrieved segments”

The toolbar in this view includes the following functions:
Show as Excel table – opens a table in XLS/X format with the retrieved segments and
associated information.
Show as HTML table – opens a table in HTML format with the retrieved segments
and associated information.
Export retrieved segments – allows for export of the retrieved segments in RTF,
HTML, or XLS/X format.
Overview of retrieved segments – opens a table view of the retrieved segments.
Code retrieved segments – allows you to choose a code from the „Code System“ to
code all retrieved segments with.
The option to display the retrieved segments in a table in XLS/X or HTML format is particularly helpful. This gives a very good overview: not only the segment in plain text but all the
information around it is listed, for instance the date when the segment was coded and the
name of the person who did the coding.
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The overview table is also the best place to write comments on your coded segments. You
read the segment in the upper window and write your comment below. Just double-click
the field for comments in the matrix and type in your annotation.

11.9 Printing and Exporting Retrieved Segments
You may wish to continue to work with the retrieved segments that you have called up.
MAXQDA makes it possible for you to print out these segments, copy them to the Windows clipboard, or to export them as a file.
To print out the retrieved segments, you have two options:
 Select Print > Retrieved segments from the Project drop-down menu.
 Click on the Print retrieved segments icon in the „Retrieved Segments“ window toolbar.
You will then see the standard Windows option for selecting your printer. The information
will be printed in your printer’s standard font. The window that appears will also let you
choose to print out only certain pages.

Printout of the Retrieved Segments window
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The layout of your printout cannot be changed from your printer’s standard formatting. If
you have a color printer, the retrieved segments may be printed out in color. If you want to
be able to edit aspects of the formatting, it is recommended that you first export the retrieved segments, open them for edit in a word processor, and then print them out.
To export the retrieved segments, choose Export > Retrieved Segments from the Project
drop-down menu. You can then give the file a name and choose the format that you want
the document to be saved in. Alternatively, you can click on the Export retrieved segments icon in the „Retrieved Segments“ window toolbar. The results are the same.

11.10

Coding Retrieved Segments

MAXQDA makes it possible for you to code some or all of your retrieved segments in the
„Retrieved Segments“ window. In this way, you can search and code quickly within specific
segments that have been called up.
Let’s say you did a retrieval of the intersections between the codes “Health” and “Home
life” for all the women in your interview sample. You can then choose to code all of these
segments with a code called “Health + Home life + women.”
To do this, you can …
 select Code retrieved segments from the Analysis drop-down menu,
 click on the icon in the „Retrieved Segments“ window toolbar to Code retrieved segments, or
 click on the icon in the „Retrieved Segments“ window toolbar to Code retrieved segments with a new code, if the code you wish you code with hasn’t been created yet.
You will then see the following window:

Autocoding the retrieved segments with a new code

You can then choose a code from the quick list. The most recently-used code is listed at the
top of the list. To open the quick list, simply click on the small triangle on the right. If the
code you are looking for is not in the quick list, simply click on that code in the „Code System“ and open the quick list again – it will be listed at the top. If you selected that you
wanted to code the selection with a new code, you will be given the option to name that
code. To complete the operation, click the Autocode button.
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This action will be added to the list of coding actions in the Undo coding menu in the
Code toolbar. When you open this list, you will see the most recent coding actions at the
top with the number of segments coded in each action in parentheses after the code name.
If you have coded many segments at one time with the autocoding function, they can all be
removed at the same time by clicking once on the appropriate line in this list.

Undoing coding actions

11.11

Matrix of Code Frequencies

This matrix has “n” rows (n = the number of documents in the project) and “m” columns
(m = the number of codes and subcodes). This can be quite a large matrix; if there are 100
documents and 100 codes, the matrix will include 10,000 cells. Normally you would use a
statistics program to analyze this amount of data. You can, however, see this information –
or sections of it – with the Code Matrix Browser. You can select the documents and codes
that should be included in this visualization by activating them. To view the actual counts of
how often each code is used in each document, you need to click the Show values button
in the toolbar.

Code Matrix Browser showing the number of times each code was used in each document

You also have the option of exporting this matrix as an Excel file.
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If you decide you want to analyze this table with a statistics program like SPSS, it is necessary that the documents (cases) be listed on the y-axis. To export the table with the documents on the y-axis, go to the Project drop-down menu and select Export > Matrix of
code frequencies. You can then choose to export it in XLS/X or TXT (tab delimited) format.
Tip: If you want to create a matrix with only certain codes and documents, simply activate
those codes and documents before calling up the matrix.
In principle, the exported file will look as follows: the first column contains the document
names, but documents that have been assigned to document groups will have that document group in the name as well (e.g. “documentgroup\documentname”). The next columns will contain the codes, listed in their full form (e.g. “code1\subcode1”). The backslash
separates between either the document group and document name or the code and subcode. The individual cells of the matrix will then contain the number of times each code
was used in each document.
The following screenshot shows an example of this matrix viewed in Excel.

Matrix of code frequencies exported to Excel

Tip: With older versions of SPSS, there are a limited number of characters that can be used
for each document or code name. They will automatically be shortened, which could lead
to confusion. In this case, it is recommended that you first change the names in the Excel
file before importing it to SPSS. You can then create names of eight characters or less that
make sense to you.
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12 Searching for Text: The Lexical Search
12.1 Lexical Search Options
MAXQDA offers three main ways to search in the texts or within each main window.
 Each of the four main windows has a toolbar at the top of it that contains a magnifying
glass icon. Clicking on this opens a field where you can enter text to search for within
that window.
 With the lexical search tool (the magnifying glass in the main MAXQDA toolbar), you
can search within all documents, memos, or coded segments. You also have the option
of limiting this search to certain activated documents or document groups.
 The third option is to do an extended lexical search using Boolean operators.

12.2 Search in the Four Main Windows
All four main windows in MAXQDA have a magnifying glass icon in their toolbars. Clicking
on this icon opens a search field. Below you can see the search field in the „Document
Browser“.

Context search in the Document Browser

MAXQDA start to search as soon as you type the first character into the field. It carries out
a classic search, meaning that it looks anywhere for that character combination, even if it’s
not found at the beginning of a word. Searching for “sic” will bring up words like “musical” and “sick.”
MAXQDA also shows you how often that particular search string has been found. In the
example above, for example, you can see that “health” was found five times in the docu-
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ment, and the first hit is currently being shown. The arrow keys next to the numbers let you
jump from one hit to the next.

12.3 The Lexical Search: Options in the Dialog Window
The lexical search function allows you to research your documents without first coding
them. You can do searches of either
 documents,
 memos, or
 coded segments, which are currently shown in the „Retrieved Segments“ window.
The search can also be limited to activated documents. You can choose to search in a single
document, a document group, or all documents that have certain variable values. The lexical search function can be started by selecting Lexical search from the Analysis dropdown menu or by clicking on the magnifying glass icon in the MAXQDA Standard toolbar.

Lexical search icon in the MAXQDA Standard toolbar

After selecting to do a lexical search, the following window will appear:

The dialog window for the lexical search

When the dialog box first comes up, the left pane is empty. Click New to enter the word or
string (called the “search string”) that you want to find. You can specify that you want
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MAXQDA to match the case, or that you want to find only whole words. If the latter is the
case, click the Find whole words check box.
Search strings may consist of one word, multiple words, or only of a part of a word. For
instance, you can search for “Tom Hanks,” “Hanks,” or only “anks.” Quotation marks are
not necessary if a search string consists of more than one word.
Search strings may contain so-called wild card characters. The characters * or ? have the
same effect as in search procedures well-known from Windows operating system.
 If the character “?“ appears in a search string, MAXQDA finds, for instance, “Hanks” if
the search string is “H?nks,” but “Hunks” or “Hinks” would also be found.
 The character “*“ stands for multiple characters, e.g. “H*ks“ would find “Hanks“ and
also “Hawks.“
 A certain beginning of a word is found by use of the character „<.” The search string
“<(inter)” would find “Interest,” „interesting,” but not “winter.”
 A certain end of a word is found by use of “>.” Thus, the string “(ks)>” would find
“Hanks,” “Banks,” and “thanks,” but not “Bankside.”
Click the Delete button to remove search strings from the list. You can also modify your
search strings at any time.
In the right pane of the dialog box, a couple of options for the search procedure are available:
 First you need to select where you want to search: in documents or memos.
 If you choose to search in the documents, options will be accessible that were previously
grayed out. One of these options is to only search within activated documents, for example, or to only search the retrieved segments currently shown in the „Retrieved Segments“ window.
Other options:
 Find whole words - Search only for strings that are exactly the same as the search string.
For example, if you search for “teach,” the string “teacher” will not be included in the
search results. If you turn this function off, “teach” would also give you the strings
“teacher” or “teaching” as results.
 Case sensitive - Search only for strings in which the same letters are capitalized as in the
search string.
 Only in activated documents - Search only in activated documents. If no documents are
activated, there will of course be no results.
 Only in retrieved segments - Search for the string only in the text in the „Retrieved
Segments“ window.
 OR/AND combinations - For searches with more than one search string. With OR checked:
search for segments containing only one of the search strings. With AND checked: search
for segments containing all of the search terms (their required position with respect to one
another can be defined).
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 Within x paragraphs - For searches for segments containing more than one search string
(AND is checked). The search strings must be found within “x” number of paragraphs. If
you choose to search within 1 paragraph, only the paragraph in which the first string is
found will be searched. If you choose to search within 2 paragraphs, and the first string is
found in paragraph 12, paragraphs 11, 12, and 13 will all be included in the search for the
second string.
As soon as you click the Search button, the search will begin.
In order to spare you the effort of typing in a long list of search strings again and again,
MAXQDA can save the search settings. To do this, click on Save, enter a name, and click on
Save again. This creates a search file with the file extension “.sea,” which you can open
and continue to use at a later time.
Depending on how many documents you search and how complex the search is, it could
take a little time to find all of the results, which are then listed in table form:

12.4 Search Results
Your search results will be shown in a table that looks as follows:

Example search results

The toolbar at the top of the results window gives you access to the following functions:
Excel table - the search table will be opened in XLS/X format in the appropriate program (usually Excel). If you have selected a section of the results table (marked yellow), only
these will be included in the new table.
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HTML table – the search table will be opened as an HTML table in your standard internet browser. If you have selected a section of the results table (marked yellow), only
these will be included in the new table.
Export – this function gives you the option to save the table (or the selected section
of the table) in Excel, HTML, or RTF format
Autocode – brings up a window to allow you to choose a code to code all search results.
Options – opens the options window, which allows you to change exactly how much
of the context of each hit is to be coded or exported.
Attention: Coding hits in PDFs is limited to the actual string. It is not possible to code the
sentence or paragraph in which the string was found.
The table of search results can be handled in the same way as other tables in MAXQDA:
clicking on any column header will sort the table according to this criterion. For instance,
clicking on Document will arrange the document names included in the table in alphabetical order. Clicking here again changes the sequence to descending order. A little triangle
indicates the sort attribute and order (ascending or descending).
The entire table or parts of it can be copied to the Windows clipboard (by selecting all or
part of it and pressing Ctrl+C).
Below the title bar, you can see how many documents contain the search string and how
many times the search string appears in those documents. Clicking on a document in the
“Document” column opens the corresponding document at the position of the highlighted
search string.

12.5 The Extended Lexical Search
The „Extended Lexical Search” function, as with the simple search option, allows you to
analyze your documents to a certain extent without having to have already done any coding. The searches can be carried out in:
 documents,
 memos, or
 the coded segments currently called up in the „Retrieved Segments“ window.
The search can also be limited to those documents that are currently activated in the Document Browser.
The Boolean operator “OR” always has the highest priority. If you do a search, for example,
for “climate change” AND “atom” AND NOT “war” OR “climate destruction,” MAXQDA
will focus first on the OR, creating in practice the following formula: (“climate change”
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AND “atom” AND NOT “war”) OR “climate destruction”). The results will be those text
segments that meet the first criteria or the second criteria.
More details and specifics on the search function can be found in the section on The Lexical
Search: Options in the Dialog Window.

12.6 Exporting Search Results
The table of search results lets you export the results by clicking on the Export button at
the bottom left of the dialog box. You can choose to export in XLS/X, HTML, or RTF format.
The file will appear as follows:
New York\Teresa (24-24)
family
to go to college straight from high school in 1964 and become a teacher. I was a good student in high school
graduating 19th in a class of 403. I really wanted to go to college, but my family couldn't afford it. Unfortunately, my mother had the attitude college was a waste for girls, because they got married and didn't put their college education to use. So, I never pursued the issue. I know, I shouldn't blame my mother for my not going to
college. I could have been more enterprising and tried to find a way to pay for it on my own. I think never
having been a teacher will always haunt me. Now it's too late. I'd have to take a large salary cut if I were to
change professions at this stage in life.

Section of an exported results table with the option to include the paragraph in which the string was found

Each search result consists of the name of the document group and document, the paragraph number in which the search string was found, and the search string itself. The length
of the retrieved segment can be determined beforehand. Click on Options button.

Options for the export/coding of search results

When exporting the search results you should select the option Sentence or Paragraph
instead of Only search string. Otherwise only the search string would be written in the
export file, which doesn’t make much sense.
You can decide how many paragraphs to export:
 Paragraph = 0 - Only the paragraph that contains the search string will be listed. If the
string occurs in the paragraph more than once, the paragraph will still be listed only
once. The string will, however, be highlighted wherever it occurs.
 Paragraph +/- “x” – The paragraph that contains the string will be listed, as well as “x”
numbers of paragraphs before and after this paragraph.
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If the search string is found several times in the same paragraph and you have chosen the
option to code only the search string, then it may happen that the same paragraph will be
listed more than once. However, when you select paragraph as the unit to list, then the
same paragraph will appear only once in the output file.

12.7 Autocoding Search Results
Traditional quantitative content analysis works with the technique of automatic coding
based on a dictionary. Whenever a word or string is found, an entry is made in a matrix of
categories. After scanning a text in this way, the matrix is filled with numbers. The text itself
serves no further purpose; only the quantitative matrix is then analyzed.
This type of analysis is performed by programs like Textpack or Intext. MAXQDA’s add-on
module MAXDictio works in the same way. Automatic coding is a very fast and reliable
procedure, but unfortunately it is very restricted semantically. This is because the analysis is
based on single words and strings. Words may, however, have many meanings, and the
meaning of a sentence or a paragraph is something other than a collection of separated,
unrelated words. For this reason, automatic coding is not a usual procedure in interpretive
text analysis. But under certain circumstances, and for heuristic reasons, automatic coding
procedures may be useful in an interpretive analysis, particularly when analyzing openended questions.
In MAXQDA this automatic coding procedure is possible in conjunction with the document
search procedure. You begin with a document search as described above.
To code the results displayed in the table, you only need to click on the button Code. The
following dialog window is then opened:

Options for autocoding search results

In the options window that appears, you can:
 Select a code from the quick list (if the code you wish to use is not displayed here, just
click the code in the „Code System“).
 Choose the size of the segment to be coded (the search string, sentence, the whole
paragraph, or even more).
 Assign a weight to the coded segments.
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As soon as you click on the Autocode button, MAXQDA will start the coding procedure. If
more than one hit is located in the same segment, this segment will of course only be
coded once.
The size of the automatically coded segments depends on the properties chosen in the dialog box.
Here you may choose between the options Only search string, Sentence, and Paragraph.
“Only search string” means that only the string will be coded (this is similar to coding with
the manual In-vivo button).
“Sentence” means that you code the sentence surrounding the search string.
“Paragraph” means that the paragraph(s) surrounding the search string are also coded. The
exact number can be specified:
 Paragraph = 0 – only the paragraph that contains the search string will be coded. If the
string occurs in the paragraph more than one time, the paragraph will still be coded only once.
 Paragraph +/- “x” – the paragraph that contains the string will be coded, as well as “x”
numbers of paragraphs before and after this paragraph.
When you view the result in the „Document Browser“, the string will be highlighted wherever it occurs.
Automatic coding operations are added to the “Undo” list, allowing you to correct any mistakes easily, no matter how many segments are coded in one operation.

12.8 Autocoding Focus Groups
When working with focus groups the automatic coding functions can be used to assign the
name of the speakers automatically. This only works in a fast and reliable way if you respect
some rules for your transcription:
Whenever the speaker changes, start a new paragraph and always use the same notation
for the same speaker, for instance “JOHN SMITH.” Make sure that this string never occurs
in the text itself. Do not use the Return key inside a speaker’s turn; every turn should be
one paragraph!
The automatic coding of speakers will work as follows:
1.

Start the lexical search procedure.

2.

Type in the search string “JOHN SMITH.”

3.

Choose the option Case sensitive.

4.

Start the search by clicking the button Run search.
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5.

Define a new code “John Smith“ in the „Code System“.

6.

Code all hits, select paragraph = 0 as the context to code.

12.9 Keyword in Context (KWIC)
MAXQDA creates a list of the search results obtained as described in the preceding sections. This “KWIC” list can be saved as a file, in which not only the line of text in which the
sought-after word, or “hit,” is found, but also the surrounding text is saved, in the form of
expanded KWIC listings. The position of every hit in the document, i.e. the paragraph that
contains the hit, is also listed. The amount of surrounding text, defined as a certain number
of paragraphs can be determined. The procedure is as follows:
1. Type in the search string(s) as described in the previous section.
2. Select the number of paragraphs to be listed in the Options dialog field.
3. At this point, you have three ways of forming your KWIC listing:
i.) Click on the Export icon in the toolbar. This will save the results in a file in XLS/X,
HTML, or RTF format. This file can then be printed, edited, or imported into other
programs.
ii.) Click on the Show as HTML table or Show as Excel table icons in the toolbar.
This will display the results in the chosen format. This file can also subsequently
be printed, edited, or imported into other programs.
iii.) Create a new code in the „Code System“, left-click on the code to transfer it to
the quick list, and autocode the search results with this code.
The third method is more flexible, since you can then load the KWIC list into the „Retrieved
Segments“ window, check the list, and remove any undesired segments (by right-clicking
on the information box on the left of the segment and selecting Delete from the context
menu).
The final result, the corrected KWIC list, can be printed by selecting the menu option Print
> Retrieved Segments from the Project drop-down menu. It is also possible to export or
copy the KWIC list to the clipboard as well.
The KWIC list has the following structure: each hit starts with the information on the document source (document group, document name, and the paragraph number containing
the hit). The next line indicates the search word or search string that has been found in that
paragraph. Finally the text segment itself is listed.
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New York\Milly (23-23)
family
family
Family, 09 : My family my parents, my children, are very close. We share dreams and holidays and have much
warmth with each other.
New York\Mary (7-7)
family
I am pretty happy with my health situation. I get sick very rarely and when I do, it is only for a short amount of
time. I think this can be attributed to the fact that I eat right and exercise semi-regularly. However, my family
has a history of breast cancer and diabetes and I worry very much about contracting them.

Printout of search results from a file

12.10

Autocoding Answers to Open-Ended Questions

12.10.1

General Problems Analyzing Open-Ended Questions

MAXQDA doesn’t only offer special functions for entering and analyzing answers to openended questions. There aren’t any general rules or regulations for analysis strategies for
open-ended questions. It depends a lot on the amount of material, the sample size, and the
depth of the analysis.
Example
Anthropologist Kate Mac Queen reported on an AIDs research project at the U.S. Center
for Disease Control and Prevention. The epidemiological study was conducted in four phases with a total of 1,267 test subjects. Every phase of the study include open-ended questions.
Regardless of the method, it is likely that you would want to be able to connect the categorical and the quantitative data.
You would be dealing with the following situation:

At the beginning you would use a quantitative data matrix and transcribed answers, which
will be analyzed categorically and transformed into a standardized data matrix. This first
connection between the quantitative data matrix and the transcribed answers is easy to
make in MAXQDA: the quantitative data matrix can simply be imported via the Import
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function in the Variables drop-down menu (see Importing the Variable Matrix into SPSS). If
you entered the text of the answers to the open-ended questions as described above, no
further steps are necessary for descriptive and group-specific analysis.

12.10.2
Analysis Techniques Without Categorization of the Answers
to Open-Ended Questions
Creating an Overview of the Answers
You can get an overview of the answers given by all the test subjects to a particular question with the standard retrieval function. Simply activate all documents representing the
test subjects you wan to include, and activate the code in the „Code System“ for that question. You will then see all of the answers to that question in the „Retrieved Segments“
window.
Comparing Answers to Various Questions
Let’s say that you wanted to compare the answers to two questions – question 2 and question 4:
You would activate the two codes that represent these questions in the „Code System“
along with all of your documents. Check to make sure that the retrieval mode is set to the
standard OR in the “Analysis” drop-down menu, and set the „Retrieved Segments“ window to order according to document. This will give you the following results in the „Retrieved Segments“ window:
 Interview 1 answer to question 2
 Interview 1 answer to question 4
 Interview 2 answer to question 2
 Interview 2 answer to question 4, etc.
Selective Listing of Answers According to Subject Group
This form of analysis requires the quantitative data matrix and the sorted answers to the
questions. The matrix of quantitative data must first be imported into MAXQDA as document variables. This is possible via the import function in the “Variables” drop-down menu
(see Importing the Variable Matrix into SPSS).
Once the matrix has been imported, you can use it for standard activations by variable (see
Activation by Variable: Variables as Selection Criteria for Retrievals). With this form of selective retrieval, documents will be activated based on their assigned values for certain variables, and only answers from these documents will be listed in the „Retrieved Segments“
window. The only additional requirement is that you also activate the appropriate code(s) in
the „Code System“.
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12.10.3
Categorizing Answers to Open-Ended Questions with Autocoding
When categorizing answers to open-ended questions, is necessary to differentiate between
the methods autocoding and manual coding. The advantages of autocoding are clear when
working with over 1,000 subjects, as in the example above. The process is quick and reliable, so you save time and money. Unfortunately, there are also drawbacks: only words and
phrases are coded, which could have several meanings, so the actual meaning of the coded
segment can’t be ensured. In addition, it is obviously impossible for the autocoding function to “read between the lines.”
Opinions, attitudes, and beliefs are therefore difficult to autocode, although pragmatic considerations may push you to do so in certain cases.
Autocoding is a special focus of quantitative text analysis programs like Textpack and Intext.
There the coding is almost always dictionary-based. The dictionaries are usually made up of
single words, but can also include word orders. MAXQDA offers an add-on tool MAXDictio,
which can be used for such dictionary-based coding.
Example
Bos/Tarnai (1996, S. 39f., Computerunterstützte Inhaltsanalyse in den Empirischen Sozialwissenschaften) did a content analysis of the Association of Students and Teachers for Academic Education, creating a total of 18 categories. Category 5, for example, was defined as
follows:
“K05 – Academic Orientation
Sections that show academic interest, specifically in a specialization, or refer to an aspect of specialized
training/education.
Code example: comments about excellent researchers, research focuses”

The dictionary is made up of single words and phrases that obviously connect to a certain
category (and only this category). The following phrases, for example, would obviously
connect only to category 5:
 “good research raises the standard of learning”
 “must be grounded in research”
The documents are searched through for any of these words or phrases in the dictionary.
As soon as one is found, it is automatically coded. You will then get a table like the one
showed below, which contains a row for each coding that was made.
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Document

Case Variable

Interview 1

M 25 single

Category
5

Interview 1

M 25 single

6

Interview 1

M 25 single

5

Interview 2

W 31 married

1

Interview 2

W 31 married

5

Matrix Type A: Category of Coded Segments

This matrix can also be then aggregated in a table as seen below with documents on the yaxis, and variables on the x-axis. Each cell then contains the number of times each category
was found in each document.
Document

Case variable

C01 C02

C03

C04

C05

C06

Interview 1

M 25 single

0

0

0

0

2

1

Interview 2

W 31 married

1

0

0

0

1

0

…
Interview n
Matrix Type B: Number of coded segments per category in each document

This matrix allows for a number of analysis techniques, such as:
 Descriptive category statistics: which categories occur? How often? And which occurs
the most often?
 Creation and comparison of category means (on average, C05 occurred 1.3 times per
document, C06 2.5 times per document, etc.).
 Comparison of means (e.g. Educators mentioned C05 significantly more than the students).
 Cluster analysis, multiple correspondence analysis (MCA), and latent class analysis
(search for patters and category correspondence)
 Cluster correlation analysis with case variables (gender, age, education, etc.).
Content analysis based on autocoding – as described above – can be performed very well
with quantitative research programs like Textpack, Intext, and others. Automatic coding is
actually a process outside of the qualitative method spectrum and outside of the focus of
MAXQDA. It is, however, possible to apply such methods in MAXQDA with autocoding
functions.
Process for Autocoding
 Activate all documents.
 Activate the code that represents a question number.
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 Choose Lexical search from the Analysis drop-down menu and enter the search string.
In the following example, “friends” and “family” were entered as the strings.

Dialog window for the lexical search

It is necessary that you check the boxes next to Only in active documents and Only in
retrieved segments, so that you won’t be including the entirety of all of your documents.
Whether you want to Find whole words, make the search case sensitive, or use the OR or
AND options is up to you.
After clicking on the button to Run search, a table with a list of hits will appear. Now you
would just need to code these segments that were found. In order to do that, the code that
you want to code with must be in the quick list. Simply click on that code in the „Code System“ to add it to the list.
This new category could be name “People,” for example. Before you choose to carry out
the coding, though, it is necessary to choose how much context should be included in the
coded segment.

Options for autocoding search results

You can choose to code …
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 only the search string,
 the sentence in which the string was found,
 the paragraph in which the string was found, or
 the paragraph plus a number of paragraphs before and/or after it.
If you click now on the Autocode button, all of the search results will be coded with the
code shown in the quick list field. All of these new coded segments will be added to the
„Retrieved Segments“ window. Later, you can export this table of coded segments to SPSS
for quantitative analysis (see Exporting the Overview of Coded Segments).
The Coded Segments Table can be aggregated in SPSS to a document like in Matrix B
above (cases x categories). The display of the file is similar to the way it looks in Excel. In
SPSS, you also have the option of merging this Coded Segments Table with the quantitative
data matrix and analyze them together.
The aggregated matrix can be created an exported by choosing Export > Matrix of Code
Frequencies from the Project drop-down menu. You can save the file in XLS/X or TXT (tab
delimited) format. The file is set up as follows: the first column shows the document group,
and the second column shows the document name. The next columns show the code
names in their complete form (code\subcode with a backslash separating codes and subcodes). The individual cells then show the number of times each code was assigned in each
document.

Exported Matrix of Code Frequencies in Excel

MAXQDA handles these coded hits from the lexical search exactly like any other coded
segments. In this way, you can search for code combinations and do focused selective analysis based on certain variable values.

12.11
Categorizing Answers to Open-Ended Questions with
the Help of the Variable Table
The standard way to code open-ended survey questions as often described in literature on
methods starts with a systematic analysis of a section of the data set, out of which a cate-
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gory system can be developed. Coders are then trained and set to work on the rest of the
data set with these categories.
Example
Subjects in a study were asked to describe their visions for life as it would be in the year
2020. The answers were transcribed and imported into MAXQDA. In the first step, five categories were created, which came out of the initial analysis:
 Vision of technology
 Vision of communication
 Vision of self
 Vision of health
 Vision of the environment
We can set these five categories as variables with a simple dichotomous 0/1 scale (instead
of 0/1, we could also just y/n):
 Code 1 – the topic was mentioned in the answer
 Code 0 – the topic was not mentioned in the answer
The steps in MAXQDA are as follows:
 The texts to be analyzed must be in the „Document System“.
 Select the List of variables from the Variables drop-down menu and create the variable for each category with the New variable button in the toolbar. The variable type
should be set as integer.
 Now switch to the data view by clicking on the appropriate icon in the toolbar.
 It is recommended that you right-click on a column header and select to only view those
variables in the table that are currently needed before you begin coding.
Now you can set up your screen in a practical way with the „Document Browser“ at the
top of your screen and the variable matrix on the bottom half.
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Optimal window layout with the Overview of Retrieved Segments and Document Browser

In the above text “Mary,” communication is mentioned. So, we need to change the value
of “V of Comm” (vision of communication) for Mary from 0 to 1. We can do this as follows:
Clicking once on the coding strip for “Visions” in the coding column of the „Document
Browser“ will highlight the corresponding row in the variable matrix. You can now doubleclick on the appropriate cell (Mary x V of Comm) and enter “1.” You can then proceed
with all of your “Visions” coded segments in the same way. You can also split up this work
between people in your team. Every inputted variable value is saved immediately.
Another option for this process is with the help of the Overview of Coded Segments. You
can then go from row to row, systematically viewing each coded segment. The rest is as
described in the previous example.
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Optimal screen layout with the Overview of retrieved segments and the variable matrix

One advantage of using this approach rather than applying codes is that the results are already together with other quantitative information in a table. You can also use these variable values to do automatic activations (See Logical Activation).
Tip: It is also possible to create codes out of the five categories, code the segments, and
then transform the codes into variables.
The entire data matrix can be exported by selecting Variables > Export data matrix from the
“Variables” drop-down menu. You can then open this matrix for further quantitative analysis in a program like SPSS (see Exporting the Table of Variables).
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13 Complex Retrievals
13.1 Logical Combinations of Codes
Different than with classic quantitative content analysis, the categorization of data in qualitative analysis is not the end of the document analysis; instead it is simply a step toward
further interpretative analysis. The categories create a structure within the documents, but
they don’t replace them. MAXQDA’s analysis functions are tools to help you navigate and
further develop this structure.
MAXQDA allows you to combine activated codes in many ways. The OR combination was
already described in the section Coding Retrieved Segments. This section will go over the
many, more complex combinations that MAXQDA has to offer.
Tip: The following complex retrieval functions assume you are analyzing text in RTF,
DOC/X, or TXT format. PDFs cannot be analyzed in the same way, because their paragraph
formatting is so different than standard text. Functions that look for codes near to each
other, for example, are therefore no longer helpful.
The complex analysis options are available under Text Retrieval in the Analysis drop-down
menu as well as in the context menu (right-click) in the left column of the „Retrieved Segments“ window. Alternatively, you can click on the icon seen below in the MAXQDA Standard toolbar.

Icon for accessing complex text retrieval options

Access to retrieval options in the context menu of the Retrieved Segments window
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The chosen text retrieval function is shown in the first field.
Tip: If there aren’t any segments shown in the „Retrieved Segments“ window, it could be
because a retrieval function is in use that you don’t actually want.
The dialog window for the retrieval selection looks as follows:

Dialog window for complex retrieval options

The dialog window has the following aspects:
 The “Function” field allows you to choose the retrieval function.
 Just to the right is the button that lets you set whether subcodes should be included.
 Below that, there are three windows, labeled A, B, and C.
 Window A is important for almost every retrieval option and holds the selection of
codes to be included in the selection function. To add codes, activate them in the
„Code System“ and then click the button to add “All activated codes.”
 Window B is also for selecting codes, but you can do so from the quick list. Simply click
on the
symbol to view the list.
 Window C allows you to set certain parameters (e.g. the maximum distance between
two coded segments).
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The “Result” window at the bottom shows how many segments would be pulled up if the
retrieval were carried out with the current settings in Windows A, B, and C. Under this
window is a description of the retrieval function that is currently selected, and on the right
side, there is a visualization of what that function does.
The retrieval begins when you click on the Execute button.
The following table gives you an overview of the various functions:
Name
OR-Combination

Description

Intersection
(“small picture“)

Lists all intersections of Window A codes. It only shows the
section of the segments that have both codes.

Intersection (Set)

Lists all intersections of codes listed in Window A if at least x
codes from the list intersect. Only the overlapping section of
the segment is displayed.

Overlapping
(“big picture“)

Lists instances where codes in Window A overlap. Coded
segments that overlap with each other are shown in their entirety, rather than just that section that overlaps.

Only one code

Lists document segments that are coded with only one of the
codes in Window A, but none of the other codes in Window
A.

Only this code

Lists segments that are coded with the code in Window B, but
not with any of the codes in Window A.

If inside

Lists segments where the code in Window A is completely surrounded by the code in Window B. Results can be the segments of the inner code (Window A) or the outer code (Window B).

If outside

Lists segments where the code of Window A is completely
outside of the code in Window B. Results are the segments
coded with the Window A code.

Followed by

Lists segments where the code of Window A is followed by
Window B code within the selected number of paragraphs.

Near

Lists segments where the Window A code is near to the Window B code, within x number of paragraphs.

Lists all coded segments coded with one of the activated
codes in the „Code System“ found in any of the activated
documents in the Document System. This is the standard form
of text retrieval.

All of the analysis functions are based on the activated documents, but only the standard
OR combination is based on the activated codes. The other nine analysis functions are
based on the codes you insert in the various windows.
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Tip: All logical functions are only based on those documents that you have activated. The
weight filter and subcode inclusion setting are integrated in all 10 functions.

13.2 Variations of Logical Code Connections
13.2.1 OR Combination (Standard Analysis)
Definition: Segments coded with any code activated in the „Code System“ from any of the
documents activated in the „Document Browser“ are listed in the „Retrieved Segments“
window.
This function is described in more detail in the section on Retrieval: Finding Coded Segments.
How it works: Activate the documents in the „Document Browser“ and the codes in the
„Code System“ that you want to include.

13.2.2 Intersection
Definition: Lists all intersections of Window A codes. It only shows the section of the segments that have both codes.
How it works:

Example:

Activate documents and/or document groups that you want to
include. Activate the codes in the „Code System“ that you want
and then click on All activated codes in the text retrieval dialog
window to insert them in Window A.
No other settings are necessary. The number of segments that
will be pulled up can be seen in the “Result” window. Or, you
can simply hit Execute to call up the segments in the „Retrieved
Segments“ window.
Tip: All codes in Window A must be attached to a text segment
for it to be called up!
Changing the activations in the „Document System“ immediately
changes your results.
It is often helpful for this function to include the subcodes, so
that all combinations of intersections between each code (and its
subcodes) are automatically included. The easiest way to include
the subcodes is to click on the

symbol.
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13.2.3 Intersection (Set)
Definition: Searches for segments coded with a minimum of x instances of the codes in
Window A.
How it works:
Activate documents or document groups you want included in the retrieval. Activate the codes to be included in the „Code System“. Click on the button
All activated codes to have
the activated codes inserted
in Window A.

Example:

If Codes 1, 2, 3, and 4 are entered in Window A, and you have
entered in Window C that at least
three intersections are required,
the first two examples to the right
would not be called up. The first
doesn’t have any intersections,
and the second only has two intersecting codes. The third has the
required three intersection codes,
Set the minimum number of
though, so it would be listed in
codes that must intersect in
the „Retrieved Segments“ winWindow C.
dow.
You can see in the “Results”
Only the section of the coded
window how many retrieved
segments that is coded with all
segments would be found
three codes is displayed.
based on intersections.
Result:
The intersecting segments
are listed in the „Retrieved
Segments“ window.
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13.2.4 Overlapping
Definition: Lists instances where codes in Window A overlap. Coded segments that overlap
with each other are shown in their entirety, rather than just that section that overlaps.
How it works:
Activate documents or document groups you want included in
the retrieval. Activate the codes to be included in the „Code System“. Click on the button All activated codes to have the activated codes inserted in Window A.
It is not necessary to change any parameters. The number of
found overlaps is listed in the “Results” window.
Attention: Segments will only be listed if they are coded with all
codes listed in Window A.
The “Overlapping” function works just like the “Intersection”
function, except that the results are displayed differently. The
results of “Overlapping” include the entirety of each coded segment that overlaps, rather than just showing the section that is
coded with both codes.
As with the “Intersection” function, it is often helpful to include
subcodes in the retrievals. Then all combinations of codes and
subcodes are included.

Example:

186

Variations of Logical Code Connections

13.2.5 Only One Code
Definition: Lists document segments that are coded with only one of the codes in Window
A, but none of the other codes in Window A.
Tip: Think carefully before using this function as it could pull up a very large number of
segments.
How it works:
Activate documents or document groups you want included in the retrieval. Activate the codes to be included in the „Code System“. Click on the button
All activated codes to have
the activated codes inserted
in Window A.

Example:

If codes 1 and 2 are in Window A,
the first two examples on the
right would be included in the
retrieval, because they don’t overlap each other. The fact that
codes 2 and 3 overlap makes no
difference, because code 3 is not
in Window A. The third example
would not be included in the retrieval because codes 1 and 2 inIt is not necessary to change
tersect.
any parameters. The number
of found overlaps is listed in
the “Results” window.
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13.2.6 Only This Code
Definition: Lists segments that are coded with the code in Window B, but not with any of
the codes in Window A.
How it works:

Example:

Activate documents or
document groups you
want included in the retrieval.

Code 1 is the selected code (Window
B). Code 2 and 3 are the codes in
Window A. When either Code 2 or
Code 3 intersects with Code 1, Code
1 is not listed. This is the case in the
second and third examples on the
right. Only the first example shows
an instance of Code 1 that isn’t intersected by Code 2 or Code 3. It would
be listed in the „Retrieved Segments“
window.

Choose the code from
the quick list in Window
B that you want to call
up. If the code is not
there that you want to
select, left-click on it in
the „Code System“ and
This function is similar to the “Only
try again.
one code” function, but it focuses on
Now activate the codes
for Window A in the a specific code (Window B).
„Code System“ and click
on the button All activated codes to have the
activated codes inserted
in Window A.

188

Variations of Logical Code Connections

13.2.7 If Outside
Definition: Lists segments where the code of Window A is completely outside of the code in
Window B. Results are the segments coded with the Window A code.
How it works:

Example:

Activate documents or document
groups you want included in the
retrieval. Activate the codes to be
inserted in Window A in the
„Code System“. Click on the button All activated codes to have
the activated codes inserted in
Window A.

This function would be
helpful if you were looking
for text segments in which
people talk about what they
consider possible, but don’t
want to include those instances that are in the context of these peoples’ wishes.

Pick the codes for Window B from
the quick list. If they are not there, Code 1 is in Window A, and
left-click on them in the „Code Code 2 is in Window B. This
means you are looking for
System“ and try again.
instances of Code 1 that are
The number of results that will be
completely outside of Code
shown in the „Retrieved Seg2. In the example on the
ments“ window is listed in the
right, only the third example
“Results” window. It can also be
would be called up. In the
found in the status bar at the botfirst example, Code 1 isn’t
tom of the MAXQDA screen.
even there, and in the
second, Code 1 is not completely outside of Code 2.
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13.2.8 If Inside
Definition: Lists segments where the code in Window A is completely surrounded by the
code in Window B. Results can be the segments of the inner code (Window A) or the outer
code (Window B).
How it works:
Activate documents or document
groups you want included in the retrieval. Activate the codes to be inserted in Window A in the „Code System“. Click on the button All activated codes to have the activated
codes inserted in Window A.

Example:

Let’s say you are interested in the things
people said about criteria for success, but only
in the context of what
they consider feasible.
You could use this
function, putting the
Pick the codes for Window B from the
“criteria for success”
quick list. If they are not there, leftcode in Window A and
click on them in the „Code System“
the “considered feasiand try again.
ble” code in Window B.
You can then set what you want to
In the examples on the
view as the result of this function; you
right, only the first
can choose to call up the segments
shows a case where
coded with the code in Window A,
Code 1 (Window A) is
those coded with the code in Window
found completely inside
B, or both.
Code 2 (Window B).
The number of results that will be That is not the case in
shown in the „Retrieved Segments“ the second or the third
window is listed in the “Results” win- examples.
dow. It can also be found in the status
bar at the bottom of the MAXQDA
screen.
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13.2.9 Followed By
Definition: Lists segments where the code of Window A is followed by Window B code
within the selected number of paragraphs.
How it works:

Example:

Activate documents or document groups you want included
in the retrieval. Activate the
codes to be inserted in Window
A in the „Code System“. Click
on the button All activated
codes to have the activated
codes inserted in Window A.
These are the codes that will be
looked for.

In the example on the
right, we are looking for
Code 1 (Window B) following Code 2 (Window A)
within two paragraphs.

Code 1 appears four times
in the example, but only
the third instance would be
included in the results, because it follows an instance
Pick the codes for Window B of Code 2 within two pafrom the quick list. If they are ragraphs.
not there, left-click on them in
the „Code System“ and try
again. These are the codes that
must follow the Window A
code(s) within a certain number
of paragraphs.
In Window C, you can insert
the maximum number of paragraphs to look for the Window
B code(s) after finding a Window A code.
Finally, you can choose what
you want to view as the results in the „Retrieved Segments“ window.
The number of results is
listed in the status bar at the
bottom of the MAXQDA
window.
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13.2.10

Near

Definition: Lists segments where the Window A code is near to the Window B code, within
x number of paragraphs.
How it works:

Example:

Activate documents or document
groups you want included in the
retrieval. Activate the codes to be
inserted in Window A in the „Code
System“. Click on the button All
activated codes to have the activated codes inserted in Window A.
These are the codes that will be
looked for.

We are looking for places where Code 2 (Window A) and Code 1
(Window B) are found
within two paragraphs
of each other (Window
C).
Code 1 is found four
times in the screenshot,
but only the second and
third instances are within
two paragraphs of Code
2.

Pick the codes for Window B from
the quick list. If they are not there,
left-click on them in the „Code System“ and try again. These are the
codes that must be near the Win- We chose to view the
dow A code(s) within a certain Window B code in the
number of paragraphs.
Retrieved Segments, but
In Window C, you can insert the we could have theoretimaximum number of paragraphs cally chosen to list the
away the Window A code can be Window A code or even
both of them.
from the Window B code.
Finally, you can choose what you
want to view as the results in the
„Retrieved Segments“ window.
The number of results is listed in the
status bar at the bottom of the
MAXQDA window.
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Code Matrix Browser

14 Visual Tools
14.1 Code Matrix Browser
The Code Matrix Browser (CMB) offers you a new way of visualizing which codes have
been assigned to which documents. The matrix provides an overview of how many document segments from each document have been assigned a specific code, and this for each
existing code.
The Code Matrix Browser can be opened in the following ways:
 Selecting Code Matrix Browser from the Visual Tools drop-down menu,
 Using the keyboard shortcut Ctrl+B, or
 Clicking on the CMB symbol in the Visual Tools toolbar.

CMB icon in the “Visual Tools” toolbar

Before you open the Code Matrix Browser, you must decide whether to display all or only
the activated documents in the matrix. Usually, it makes sense to choose only the activated
documents, since the matrix serves to compare the frequency of particular, usually thematically-related codes. Otherwise, if the „Document System“ contains many documents, a
huge matrix is produced in which it may be difficult to find exactly the results you are looking for.
The CMB looks like this:

The Code Matrix Browser
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The first thing you will see at the top of the Code Matrix Browser window is the toolbar
give you access to the following functions:
Opens the CMB matrix in Excel.
Opens a window to let you choose to export and save the CMB matrix with the values
(showing values rather than circles/squares) in XLS/X or TXT (tab delimited) format.
Allows you to save a snapshot of the CMB as it currently appears in the window.
Opens the Quote Matrix in Excel, showing the segments represented in the CMB (see
Quote Matrix).
Shows small column headers without document names.
Shows short document names in column headers.
Shows full document names in column headers.
Calculates symbol size based on all coded segments.
Calculates symbol size based on coded segments in column.
Calculates symbol size based on coded segments in row.
Switches matrix view between symbols and values.
Switches between circle and square visualizations.
Switches from counting the number of coded segments in each document to simply
showing whether there is at least one coded segment (whether or not a each code was
used at all in the document).
Refreshes the visualizations if you’ve changed activations of codes or documents.
Shows information about the Code Matrix Browser.
Closes the window.
Just to the right of the toolbar, you will find a sliding switch. If documents you have chosen
do not fit into the CMB window, you may scroll through the diagram. Unlike in some other
MAXQDA tables, the sequence of the columns cannot be modified within the CMB.
Tip: The sequence of documents is fixed and will be determined by the sequence of the
documents in the „Document System“. Thus, if you want a diagram with a particular sequence of documents, you have to change their sequence in MAXQDA’s „Document System“, which can be done easily via drag and drop.
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The size and color of the clusters in the matrix show how many document segments in
each document have been assigned each particular code and subcode. The larger the cluster, the greater the number of segments that were assigned this code or category in this
document.
When you move the mouse cursor over a cluster, a screen tip appears:

Tool tip in the Code Matrix Browser

The name of the document, the code or subcode, and the number of coded segments assigned to the code are shown in the box.
The document names in the column headers can be displayed in three ways:
Without document names,
With short document names, or
With full document names.
The number of documents that can be displayed as columns in the matrix depends on this
setting. In most cases, it is sufficient to use short document names, showing only the first
few letters, which nevertheless is enough for you to recognize it. If in doubt about a document, you can take a look at the screen tip, where the full document name is displayed. If
necessary, the width of the columns can be adjusted by clicking on a dragging the lines
between column headers.
The codes are displayed in the CMB in the same way as in the „Code System“, in a tree
structure similar to that of Windows Explorer. Subcodes can be collapsed in the usual way,
by clicking the - symbol.
Tip: When the subcodes are collapsed, the number of coded segments is aggregated on
the parent code level. If a parent code (that hasn’t been used in the document) has three
subcodes with 10 coded segments each, when you collapse the subcodes, the parent code
will show 30 coded segments.
Jumping from the Symbol to the Coded Segment
The document segments that have been assigned a particular code can be called up immediately by double-clicking on the symbol. The relevant document is then activated and the
coded segments appear in the „Retrieved Segments“ window. It is possible to keep the
CMB open, allowing one to easily view the contents of different symbols.
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Exporting the CMB as an Image File
The
button in the toolbar lets you take a snapshot of the Code Matrix Browser as it is
currently seen in the window. You can save the snapshot as a BMP file for easy import in a
word processor or Powerpoint slide.

14.2 Code Relations Browser: Visualizing Overlapping Codes
A tool similar to the CMB is the Code Relations Browser (CRB). The CRB is a visualization of
the relationships between codes. A table shows how many document segments any two
codes are attached to. The representation is similar to the Code Matrix Browser, but in this
case, the little squares/circles stand for the number of co-occurrences of codes.
You can open the CRB in different ways:
 By selecting Code Relations Browser from the Visual Tools drop-down menu,
 With the keyboard shortcut Ctrl+O, or
 By clicking on the CRB symbol in the Visual Tools toolbar.

Icon in the Visual Tools toolbar for opening the CRB

CRB Options
Before you open the Code Relations Browser, you need to decide whether co-occurrences
should be brought up for all codes and documents or just some of them. If you decide they
shouldn’t all be included, you need to activate those codes and documents that you want.
You can then open the CRB. You will then be asked whether you want to limit the table to
activated documents and codes. This dialog box does not appear if you don’t have anything
activated, since it wouldn’t return any results.
You then have the option to choose which codes to have on the x-axis. You only have the
option of choosing top-level codes, but subcodes will automatically be included.
The Visualization
The Code Relations Browser looks like this:
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An example of the Code Relations Browser visualization

A the top of the screen, you will find the toolbar with the following functions:
Opens the CRB matrix in Excel.
Opens a window to let you choose to export and save the CRB matrix with the values
(showing values rather than circles/squares) in XLS/X or TXT (tab delimited) format.
Allows you to save a snapshot of the CMB as it currently appears in the window.
Shows small column headers without code names.
Shows short code names in column headers.
Shows full code names in column headers.
Switches from the “Overlapping” function to the “Near” function.
Switches between circle and square visualizations.
Allows you to change settings for the “Near” function.
Switches from counting the number of overlaps to simply showing how many documents have at least one instance of the two codes overlapping.
Refreshes the visualizations if you’ve changed activations of codes or documents.
Shows information about the Code Relations Browser.
Closes the window.
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To the right of the toolbar, you will find a scroll bar, which lets you scroll through all of
your y-axis codes without losing sight of the y-axis codes. The order of the codes is based
on the order in the „Code System“. If you want to change the order in the CRB, you must
first change the code order in the „Code System“ and refresh the visualization.
And what is the visualization showing us? Each symbol in the matrix represents the number
of intersections of the two codes. The bigger the symbol, the larger the number of intersections. If you choose to switch to the “Near” function, the symbols represent the number of
times two codes exist near to each other (within a certain number of paragraphs, defined in
your settings).
If you click on the Document based icon in the toolbar, the symbols represent the number
of documents that have at least one instance of an intersection between the two codes. It
no longer matters how many times these intersections occur in each document.
Jumping from the Symbol to the Coded Segment
You can call up the document segments with overlapping codes by double-clicking on the
symbol representing them. The “Overlapping” retrieval function will automatically be activated, bringing up the segments in the „Retrieved Segments“ window. The CRB can remain open, so you can quickly go from one set of overlapping codes to another.
Exporting the CRB as an Image File
The
button allows you to take a snapshot of the current CRB window and save it as a
BMP file, which you can then insert easily into a word processing file or Powerpoint slide.

14.3 Document Comparison Chart: A Visual Comparison of
Documents
This visualization works for a number of documents at one time and offers a sort of mix
between the Document Portrait and the Codeline. Simply choose the documents and codes
that you wish to include in the visualization by activating them before calling up the function.
The Document Comparison Chart shows the documents on the y-axis and the paragraph
numbers on the x-axis, making it possible to compare the flow of codes in each document.
The cells show the codes that exist in each paragraph of each document with a bar assigned the same color as the code it represents. Each code that is present in the paragraph
is represented by a colored section of the bar. If a code is used more than once in a paragraph, it is still only visualized once. To give you an idea how this works, see the screenshot
below. In this example, you can see 10 paragraphs for three different documents. You can
see that there were no coded segments in any of the documents in the first paragraph. In
“Doc 1,” the first coded segments are in paragraph two, where two blue and one red code
are visualized.
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The principle behind the Document Comparison Chart

If several codes with different colors appear in the same paragraph, the space available will
be shared between the codes. Generally, the space is fixed to 50 pixels. These pixels will be
allocated according to the size of the coded segments. If exactly the same segment is coded
with a green and a red code, then 25 pixels will be colored red and 25 green.
Like in Document Portrait, codes and colors must correspond in a meaningful way. Otherwise the diagram will have no meaning for you.
You can call up the Document Comparison Chart:
 by selecting Document Comparison Chart from the Visual Tools drop-down menu,
or
 by clicking on the

icon in the Visual Tools toolbar.

The visualization looks like this:

Example of a Document Comparison Chart

The Document Comparison Chart is particularly useful for the analysis of structured documents. In this case, all the documents have the same number of paragraphs and allow for a
direct comparison. You are more or less looking at a Document Portrait for each selected
document at the same time.
Active Symbols
As in all visualizations, the symbols representing the coded segments are active, meaning
you can jump directly to the coded segments in the original document in the „Document
Browser“ by clicking on the symbol.
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Exporting the Document Comparison Chart as an Image File
The
takes a snapshot of the visualization as it is currently seen on your screen, so you
can then save it as a BMP file and import it into a word processing file or Powerpoint slide.

14.4 Document Portrait: Visualizing a Document
This visualization is for a specific document, making it a case-oriented function. The document is shown as a picture of all the coded segments based on the order and colors of the
codes.
You can access the Document Portrait …
 by selecting Document Portrait from the Visual Tools drop-down menu,
 by right-clicking on a document and selecting Document Portrait in the context menu
that appears, or
 by clicking on the appropriate symbol in the Visual Tools toolbar.

Icon in the Visual Tools toolbar for calling up the Document Portrait

The results of this function are only meaningful if you have made use of the opportunity to
assign colors to codes. The visualization of a document can only be fruitful if this association of colors makes sense to you. Here are a few examples:
 Imagine a psychologist has coded an in-depth interview in a way that categories related
to aggression have red colors and categories for quiet and friendly behavior have green
colors. Now a Document Portrait would show with you in a single glance how often the
interview shows aggressive behavior and when during the interview this happened.
 In biographical research, the particular representations can be chosen for critical life
events, thus making it easy to get an idea of the life course of a person and the concentration of critical events.
 For thematic analysis, it may be useful to associate different colors to different topics.
Now, you can easily see which topics dominate the discussion and which topics are
closely related.
What Does a Document Portrait Display?
A Document Portrait shows the sequence of codes for a selected document. To better understand what happens, it is useful to take a look at the Overview of coded segments for a
selected document. All coded segments are listed in this overview. The first column displays
the color associated with the code. This is the material that is used to “paint” document
portrait. Only those colors displayed in the first column of the overview table will appear in
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the visualization. In the overview table, all segments are equal regardless of their size. The
Document Portrait, however, takes the size of the segments into account and “weights”
the color according to the segment’s size.
The color attributes of the codes associated with the document are displayed in a matrix
with 1,200 little squares (arranged in 30 rows, each one with 40 squares). The representation starts with the first square on the left in the first line, and ends with the last square on
the right of the last line. The picture is set up in the same way as a television screen, where
an electronic stripe goes along the screen from left to right. All 1,200 squares are divided
up according to the share of the coded segments. If a document only had segment coded
with a blue code, then the Document Portrait would be totally blue. If this segment were
coded with two codes, red and blue, the Document Portrait would consist of 600 blue and
600 red squares. If two segments were coded (again with red and blue codes) and the first
segment were twice as extensive as the second, the picture would start with 800 hundred
red squares followed by 400 blue squares.
Thus, Document Portrait displays the structure of documents in terms of codes as a colorful
picture. This helps to immediately identify the basic tone of a document, for instance, if
emotions have been coded with meaningful colors (aggressive= red, tolerant= green, and
so on).
Try out the Document Portrait – right-click on a document of your choice in the „Document
System“ and choose Document Portrait. Of course, meaningful results can only be obtained if you have assigned colors that make sense for your codes.

Example of a Document Portrait

Document Portrait Visualization Options
Visualize entire text document or coded text
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This button lets you toggle back and forth between the two visualization options. If you
choose to visualize the entire document, the visualization will include white squares for sections of the document that have no code assigned to them. The other options only visualizes segments of the document that were coded.
Mixed colors for overlapping codes (yes/no)
This setting decides how segments should be visualized that are coded with more than one
code. If the above option is off, each of the colors of the codes used to code the same segment will be listed sequentially, one after the other, similar to how it works in the Overview of
Coded Segments. If the option is turned on, the colors of each assigned code are mixed together.
Display nodes as circles (on/off)
This button lets you switch the symbols in the visualization back and forth between squares
and circles.
Active Code Symbols
The square or circle symbols in the Document Portrait are also directly connected to the
original data, which means you can double-click on any symbol to call up that coded segment in the „Document Browser“. (This is not possible if you have chosen to mix colors for
overlaps.)
Exporting the Document Portrait as an Image File
The
button lets you take a snapshot of the Document Portrait, save it as a BMP file,
and then insert it into a Word document or Powerpoint slide.

14.5 Codeline: The Sequential Visualization of a Document
The Codeline is a case-based visual function that displays a sequential view of a document’s
coded segments. The picture is quite similar to that of a score of a piece of music. The xaxis displays the paragraphs of the document, starting with §1 and ending with the last §
of the particular document. The y-axis displays the codes. The cells of the Codeline matrix
are filled with a colored symbol, if the code has been assigned to the paragraph.
The basic idea behind the visualization can be seen below. There are 12 paragraphs and
three codes shown. You can see that nothing was coded in the first paragraph of any of
the documents. In the second, eleventh, and twelfth paragraph, Code1 is used. In paragraph five, both Code2 and Code3 were used. This shows you already how you can use
this visualization. It gives you an overview, so you can quickly identify which codes appeared and overlapped in various phases of the document.
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Schematic representation of the Codeline

The Codeline is called up …
 by selecting Codeline from the Visual Tools drop-down menu,
 by right-clicking on a document and choosing Codeline from the context menu that
appears, or
 by clicking on the appropriate symbol in the Visual Tools toolbar

Calling up the Codeline visualization using the icon in the Visual Tools toolbar=

Codeline Options
When you call up the Codeline, you have two options:
1. Only for activated codes – this limits the codes to be included in the visualization to
those that you have already activated in the „Code System“.
2. Aggregate on the 1st level – this option means that only top-level/parent codes will
be visualized. The subcodes of each parent code will be handled as if they were instances of the parent code.

Options for the Codeline visualization

Codeline Display
Unlike the Document Portrait, the Codeline tool can be used even if you have not associated meaningful colors to your codes. The Codeline graphics display the color, but if you
have not selected colors, only green symbols will be displayed. The function of Codeline is
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to show where in a document the different codes have been applied, and this diagram also
makes sense and can be interpreted without color differentiation.
What can the Codeline be used for?
 Codeline gives a good overview of the coding and can therefore be used universally.
 The diagram may be of use for exploration – just follow a particular code, see when it
appears and which other codes appear near it.
 The opportunity to display only selected codes enables comparing two or more codes in
the course of an interview.
 When analyzing focus groups, you can see at a glance which speakers react to each
other and what the topics are in relation to the speakers.

Example of a Codeline visualization

The Codeline creates a table with the codes on the y-axis and the paragraph numbers on
the x-axis. The coded segments are shown in paragraph sequence, starting with the first.
This means that the visualization has as many columns as paragraphs. If the code is used in
a paragraph, the code’s color will be shown in the bar in the appropriate column. If a
coded segment is more than one paragraph, the bar continues from one to the next.
You can scroll through the paragraphs while keeping the code names visible by using the
scroll bar at the top of the window.
Active Code Symbols
The display of the coded segments is interactive. If you hover the mouse over a symbol, a
tooltip appears with the code or subcode name and the paragraph number. Double-clicking
on the symbol opens that document in the „Document Browser“ at the appropriate paragraph(s). The coded segment is also highlighted automatically.
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Exporting Codeline as an Image File
The
takes a snapshot of the Codeline as it currently appears in the window and lets
you save it as an BMP file, which you can then later insert into a Word file or Powerpoint
slide.

14.6 Tag Clouds
Tag clouds offer you a simple way to visualize the most frequently used words in a document or group of documents. The size of the font is dictated by the number of times it is
found in the selected document(s). MAXQDA puts the words in alphabetical order, starting
in the top left.

Tag cloud

The tag cloud function can be called up for a single document, a document group, a document set, or all documents in a project. Simply right-click on the document/group/set in
the „Document System“ and choose Tag cloud from the context menu that appears.
So that you don’t end up with a list of short words that have no meaning for your analysis
(e.g. and, or, the, but), you can create a stop list, so that such words aren’t included. The
easiest way to add words to a stop list is from the “Word frequency list.” This list shows all
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the most frequently-used words, sorted from most the most frequent to the least frequent.
To the left of each word is a green symbol. If you want to add a word to the stop list, just
double-click on this green symbol next to it. This word will now no longer show up in the
word frequency list or the tag cloud. You can also add several words at the same time to
the stop list by holding the Ctrl key, clicking on the words one by one, and then rightclicking on one of them and choosing Add to stop list from the context menu that appears.
In the screenshot above, you can see the Edit stop list button at the bottom left of the tag
cloud window. This button brings up a list in TXT format of all the words that are currently
in the stop list. You can here add or delete words as well, although the double-clicking option described above is considerably easier.
The Copy button copies the tag cloud to the Windows clipboard, which makes it easy to
then paste it into other programs, like Microsoft Word.

Word frequency list: double-click on the green symbol next to a word to add it to the stop list, or right-click
on the word and choose Add to stop list from the context menu.
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15 Mixed Methods Functions
15.1 General
MAXQDA is one of the pioneers of method integration. Functionality for working with both
qualitative and quantitative data was already available in the very first version of the software, which came out in the late 1980s. The option to view a matrix of quantitative data
parallel to the texts has been a keystone of these mixed methods. With the newest version
MAXQDA 10, the option to create code variables has been added, which makes it possible
to assign variable values for different sections of a single document (e.g. for various speakers in a group discussion).
Functions that combine qualitative and quantitative data are available in the Mixed Methods drop-down menu:
 Activation by variable – lets you activate documents or sections of documents to be
included in retrieval based on variable values. You could, for example, use this function
to find out what all men between the ages of 40 and 50 said about migration issues.
 Quote Matrix – creates a Word file showing what different groups said about a theme
based on certain variable values that you specify. Each group’s coded segments for the
specified codes are in a different column. You could, for example, choose to see how
those with various levels of education differ on their approach to combating homelessness.
 Crosstabs – works parallel to the Code Matrix Browser, except that this function
doesn’t work on the document level. Instead, you can create groups based on your variable values and compare how often each of these groups talks about each theme. You
could, for example, compare how often men talk about relationships in your life satisfaction interviews in comparison to women.
 Typology tables – shows an overview of variable values for qualitative typologies that
you have created (e.g. for people with various views on combating their own homelessness). You could see, for example, what the mean age, gender breakdown, and average
time already homeless is for the “apathetic pessimists” in comparison to the “proactive
optimists.”

15.2 Activation by Variable: Variables as Selection Criteria for
Retrievals
The retrieval function in MAXQDA makes it possible for you to call up all document segments coded with certain codes in a selection of documents. The selection of documents
for simple retrievals is based on the documents and/or document groups that you manually
activate in the „Document System“. This activation is done via right-clicking on the docu-
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ment or document group and choosing Activate or by holding the Ctrl key and left-clicking
on the selection. More complex, selective retrievals, however, can’t be done as easily with
this method.
It is not only possible to activate documents manually, though. You also have automatic
activation options. With the activation by variable function, you can choose to activate
documents and sections of documents based on the variable values that have been assigned to them. If you have defined variables for gender, age, and education level, for example, you could choose to call up only those coded segments that represent statements
made by women over the age of 40 that have at least a high school education. These activations can be made by entering the appropriate formulas. The formula syntax in MAXQDA
is similar to that of statistics programs like SPSS.
The “activation by variable” function always deals with the entire project. You can access
the function by choosing Activation by variable from the Mixed Methods drop-down
menu or by right-clicking on the Documents icon in the „Document System“ and choosing
Activation by variable from the context menu that appears.

Accessing the Activation by variable function from the context menu

You can also call up the function by clicking on the corresponding icon in the MAXQDA
Standard toolbar.

Accessing the Activation by variable function from the toolbar

If there are already some documents activated, you should reset these activations before
starting the automatic activation process. You can do this by clicking on the Reset activations button in the toolbar. It’s just to the left of the Activation by variable button.
After clicking on the appropriate button, a dialog window will appear, where you can enter
the formulas for activation. In the example mentioned above, we would want to only acti-
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vate document segments for women over the age of 40 with a high school education. The
dialog window is made up of the following sections:
 A section for the logical formulas and the buttons to create a new formula, delete the
currently selected formula, or reset all formulas.
 Checkboxes for selecting operators.
 Buttons for opening or saving formulas.
 The buttons for carrying out the activations.

Dialog field for activation by variable

All logical formulas must have the following components:
variable name / operator / value
If you have created a variable called “gender” and used the characters “m” for male and
“f” for female, we would use the following formula in order to activate those documents
or document sections that have been assigned to women:
gender = w
Example
Let’s say there was a study done about the effects of the Gulf Oil spill on the reputation of
offshore drilling companies, and all documents have already been coded. A variable was
created based on the presence or absence of a critique of drilling company management
(“Criticism”). If there was such critique in a document, the variable value was set to “Y.”
Otherwise it was set to “N.”
Now, if we only wanted to activate those documents that included critique of company
management, we would use the following formula:
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Criticism = Y
To do this, you would follow these steps:
1. Click on the New button.
2. Choose the variable Criticism in the window that appears by checking the box next to it
and clicking OK.
You will now see the following text in the formula window:
[Criticism] =
The only thing that is missing at this point is the variable value. On the right side of the
screen you will see a field where you can enter the value. Here you could enter “Y,” or
simply click on the arrow to open a drop-down menu and select from the list of possible
values. These possible values include any values that have been entered for a document up
to that point. In our example above, both “Y” and “N” would be in the menu. Using this
menu helps you to avoid any typos.
Be careful when typing in values: MAXQDA variable values are case sensitive, so it
makes sense to simply pick the value from the drop-down list.
Since the “=” operator is used most often, it is automatically selected when you start a new
formula. If you want to use a different logical operator, simply choose it from the right side
of the window.
The operators have the following meanings:
=

Looks for variable values that are the same as the formula value.

<> Looks for variable values that are not the same as the formula value.
<

Looks for variables values that are smaller than the formula value.

>

Looks for variable values that are larger than the formula value.

In our example, we wanted to activate those documents where the person did include critique of the company management, so the “=” operator is appropriate. We would want to
see those documents with the variable value equal to the formula value (“Y”).
If you are starting a formula with a numerical variable, a “0” is inserted automatically until
you change it.
Results of Activations by Variable
Once you have entered the correct logical formulas, you can start the automatic activation.
Click on the Activate button.
MAXQDA then checks the variable values assigned to each document to check whether it
matches the formulated criteria. The automatic activation window is closed, and you will be
brought back to the standard MAXQDA four-window interface. The documents that
matched the criteria are now activated (marked red) in the „Document System“.
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Tip: The status bar at the bottom of the MAXQDA window shows you how many documents have been activated.
If you also had codes activated, you will immediately see results of your retrieval in the „Retrieved Segments“ window.
Changing and Saving Formulas
After starting the automatic activation process, the dialog window is no longer seen. The
formulas, however, will still be in that window the next time you open it.
You can change the logical formulas (operators and values) at any time:
 Click on the formula in the dialog window and then click on the new operator on the
right side of the window.
 If you want to change the value as well, simply click on the value field and enter the
new value or select it from the drop-down menu.
When you’ve changed the formula as you wanted to have it, simply click on the Activate
button to restart the activations.
You can also save a set of formulas, so that you can have quick access to them at a later
time and don’t have to reenter them one by one. Just click on the Save button at the bottom of the dialog window. You can then give it a name and choose where you want to
save it.
Files for saved logical formulas are saved by MAXQDA as LOA (logical activation) files. To
open a saved set of formulas, choose Open and navigate to the place you saved the LOA
file. It makes sense to set up a folder for all of your LOA files, so they are easy to find.
Complex Logical Formulas
It is also possible to combine various logical formulas. The basic units of these combinations
are still the formulas in their basic form:
variable name / operator / value
Combining formulas just means that you are connecting two of these basic formulas with
an operator.
In the above example, we activated documents where the value for the variable “Criticism”
was “Y.”
If you want to further limit the results, so that you only see what women that critiqued
management had to say, we would want to include a second formula where the value for
the variable “Gender” is “f” for female.
This second formula would just need to be added and given the AND operator, so that
documents will be found that have variable values indicating that it is a woman, and the
woman critiqued management. The second formula, then, would be created as follows:
 First click New in the dialog window, and then
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 Choose Gender from the list of variables.
The new formula should now look like this:
[Gender] =
 Now you can select the value f from the drop-down menu.

 MAXQDA automatically inserts the “OR” operator. In our case, we want to use the
“AND” operator, so we would need to click on that option on the right side of the
window. The formulas will now have the “AND” operator between them instead of
“OR.”
In this way, you can add as many combinations of logical formulas as you want. You can
then click Activate to start the activations.
The combination operators OR and AND have the following affect on the results of your
activation process: If you choose the OR option, MAXQDA looks for documents that meet
at least one of the various formulas’ criteria. If you entered the formulas “Criticism = Y” OR
“Gender = f,” you will get all the documents that included critique of management as well
as those that were women. For our example, then, the OR option would not be appropriate. We want both formulas to be met, so we would need to use the AND operator, so that
it looks as follows:

A complex logical formula

Deleting Formulas
It is possible to go back and delete a formula at any time:
 Click on the formula to highlight it.
 Click on the Delete button.
Using Code Variables for Activation by Variable
It is not only possible to activate documents based on their document variables; you can
also activate sections of documents based on their assigned code variables. The Activation
by code variable function can be accessed by right-clicking on the Code System icon and
choosing the appropriate option in the context menu that appears.
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Activation by code variable function in the Code System icon’s context menu

15.3 Crosstabs
The Crosstabs function has some similarities to the Code Matrix Browser, except that
groups of documents are analyzed instead of single documents. Social groups, such as men
and women, or people with different personal background, etc. can be grouped based on
variable values. All of the variables that are in your project can be used to set up a group.
Crosstabs is a visualization of the relationship between variables and codes. The following
example displays the number of times each code was assigned to the groups of documents
separated by gender.

Crosstabs example based on gender
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The Crosstabs function can be accessed in the Mixed Methods drop-down menu or in the
Visual Tools toolbar as seen below.

Tip: In order to have access to this function, you need to have activated at least one code.
The Crosstabs toolbar at the top of the window includes the following functions:
Shows the matrix of values in Excel.
Exports the matrix of values in either XLS/X or TXT (tab delimited) format.
Saves a snapshot of the window as it is currently seen in BMP format for later use in a
presentation.
Opens a Quote Matrix for the selected codes and groups in the Crosstabs window.
Changes the calculations to be based on the number of documents that contain the
code rather than the total number of segments coded with that code.
The next three icons set how the values are shown in the matrix cells:
Number of segments – meaning the code frequencies for each group are shown as a
value.
Row percentage – meaning the value for each cell is shown as a percentage of the
frequency of the code in all groups (horizontal percentage).
Column percentage – meaning the value for each cell is shown as a percentage of the
frequency of all coded segments in that group (vertical percentage).
Refresh – recalculates the values in the table.
Showing information about the function.
Closes the Crosstabs window.
Crosstabs are well suited for the analysis of sub-categories and their distribution in subgroups of the sample. Imagine you have asked how students prepare for examinations, and
the different options (e.g. reading books, working together with colleagues, etc.) are defined as codes. With the Crosstabs function, you can compare various groups with each
other. Are female students participating more in training groups? Do male students read
more text? The options to view the values as row or column percentages make the interpretation of the data even easier.
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Selection of Codes and Attributes
You need to select at least one code and one variable (or more precisely, a variable value)
to create Crosstabs. If no codes are activated, the Crosstabs function is gray and can’t be
called up. As usual in MAXQDA, the selection of codes is done via activation. The selection
of variables values is done in a dialog window that pops-up when you start the Crosstabs
function. The window looks similar to that for the “Activation by variable” function.
After activating codes and selecting Crosstabs, you will have the option to create logical
formulas that will be used to assign documents to each column. The window is broken up
into the following sections:
 A section for the logical formulas and the buttons to create a new formula, delete the
currently selected formula, or reset all formulas.
 Checkboxes for selecting operators.
 Buttons for opening or saving formulas.
 The buttons for creating the Crosstabs visualization.

The Crosstab dialog window

All logical formulas must have the following components:
variable name / operator / value
If you have created a variable called “gender” and used the characters “m” for male and
“f” for female, we would use the following formula in order to create one column of the
Crosstabs to represent women:
gender = f
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If you wanted to create one column for women and one for men, you would follow these
steps:
1. Click on the New button.
2. Choose the variable Gender in the window that appears by checking the box next to it
and clicking OK.
3. Check the box next to insert all values into the table.
3. Click OK.
MAXQDA then lists the formulas that you have set up. In our example, it would look as
follows:
[Gender] = m
[Gender] = f
The Crosstabs created in this way would look as follows:

Crosstabs comparing the number of coded segments for each code by women and men

If you there are many different possible values for a certain variable, you can choose to delete those that you don’t want to include in the visualization. If, for example, you had a
variable “level of organization” with possible values “very high,” “high,” “medium,”
“low,” and “very low,” you might only want to compare the two extremes. To do this, you
would click on the formula for each of the other three values and delete them.
You can also compare groupings based on various variables (e.g. compare women to
people with an income over $100,000 per year). In this case, then, you wouldn’t check the
box to Insert all values into the table. Instead, you would simply create a formula. You
can do this by following these steps:
1. Click on the New button.
2. Choose a variable from the list by checking the box next to it and clicking OK.
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3. Insert the appropriate variable value in the field on the right side of the window or
choose it from the drop-down list. The drop-down list will have all the values that were
assigned to the chosen variable. Choosing the value from the list helps you avoid any
typos that would cause you to get false results.
4. Repeat the first three steps to set up each column of the Crosstabs.
5. Click OK to create the table.
You can also save a set of formulas, so that you can have quick access to them at a later
time and don’t have to reenter them one by one. Just click on the Save button at the bottom of the dialog window. You can then give it a name and choose where you want to
save it.
Files for saved formulas are saved by MAXQDA as LOA files. To open a saved set of formulas, choose Open and navigate to the place you saved the LOA file.

15.4 Quote Matrix
The Quote Matrix is based on the same idea as the Crosstabs function, i.e. to create a joint
display of themes and quantitative variables. The Quote Matrix does this on a more detailed, non-aggregated level. Here the coded segments themselves are listed in the cells of
the matrix, not only the number of coded segments for that particular cell. In the example
below, we can see a comparison about what married people said about certain themes
compared to what single people said about them.
Code

Family status = married

Family status = single

emotions

Happiness does not remind me of one
event. It makes me think of my life.
Even though there are bad times,
overall I am very happy with the way
I turned out as a human being. and I
like were my life is headed.

I feel as if I am very healthy and I know that
I have a firm background on what being
healthy means because of my interest in Nutrition and Exercise. I always to try to eat
better and make the right choices and exercise on a regular basis. I really think that
those two components contribute highly to
health. But, health also means emotionally,
mentally and even spiritually. I feel like my
spiritual life really contributes to the rest of
my health because I take care of my body
because God tells us to in the Bible and everything else falls into place.

(New York/Joanna, 34-35)
Sadness reminds me of the death of
my grandmother (Dec. 90') and my
grandfather (June 96'). Their deaths
effected my life greatly. They were
like my second parents. These two
times were definately the worst times
of my life

(New York/Milly, 11)

(New York/GINA, 12)
education

My career now is college. I am graduating this weekend from my Community Health Undergraduate program at Hofstra University.
I am
continuing my undergraduate studies
at CW Post in the fall to get a BS in
nutrition. Getting my RD is my major
career choice. My satisfaction level
on my career is only a 7 because I am
not looking forward to going back to

My major is Dietetics and I am planning on
working with children at either a center or a
Children's Hospital and do meal plan counseling for children that need special diets because of sickness, or whatever the case may
be.
I know that will not be happy in my occupation unless I work with children. I have a
heart for kids and I found this out by working
a summer camp for kids for the past 2 sum-
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undergrad college but it is the only
way I can achieve a license.
(New York/GINA, 17)

Overall I am pretty happy with my
mental, social and physical health. I
would like to improve my dedication
to working out. I am the type of
person who will work out 5 times a
week for a month staight and then is
slowly turns into less days a week
until it is none. I get distracted by
school work, my job or just being
tired.

mers.
I started taking a Nutrition class last year
and decided that it interested me and found
out what kind of jobs that I could get involved
with by talking with my counselor and it all
worked out great.
(…)
(New York/vincent, 12)

(New York/Silvia, 42)

Example of a Quote Matrix with the sources (document, paragraph) highlighted yellow.

In theory, it would be possible for you to create a Quote Matrix on your own by doing retrievals in MAXQDA for each group and copying them from the „Retrieved Segments“
window into a table in Word, but this would take a lot of time, and the sources of each
segment wouldn’t be listed.
The results of your Quote Matrix are opened automatically in whatever program is set to
open RTF files (e.g. Microsoft Word). The coded segments retain the formatting that they
had in MAXQDA. If some of your documents are formatted differently than others, this
could lead to a chaotic-looking document. It is recommended in these cases, that you highlight the whole table and assign the same font and size to it.
In order to ensure that the Quote Matrix is readable, it is limited to a maximum of four columns. If you absolutely have to have more columns than that, you can create two different
ones and bring them together in your word processor. The Quote Matrix assumes that you
are working with categorical variables. If you want to display metric variables, you need to
use the Typology Table.
Tip: The number of columns in the Quote Matrix is limited to a maximum of four.

15.5 Typology Table
This function offers yet another way to combine quantitative data and your codes. It is
called a Typology Table, because it is able to calculate various variables and their percentages (means, standard deviations, etc.) for qualitative typologies.
The table is set up similarly to the following example from Creswell and Plano’s book “Designing and Conducting Mixed Methods Research” (2010: 292):
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Example of a Typology Table

Here, the rows contain different variables divided into two sections: “Sociodemographic
characteristics” and “Psychological status”. The table starts with age, which is obviously a
metric variable. The next row lists the number and the percentage of women, a category in
the categorical variable “sex”. The third row gives a number and also the percentage for
the African Americans, also a category of a categorical variable. The next row also gives
information about a categorical variable “education less than high school”. The next three
rows after the heading “Psychological status” all deal with metric variables. Let’s go into
more detail:
The first column of the table “characteristics” contains the name of the variable. The
second column “Physician rated patient depressed n=27” gives aggregated information for
27 patients: on average, they are 73 years old with a standard deviation of 5.3 years. Twenty-one of the 27 persons are female, which is equal to 79%.
The third column “Physician rated patient not depressed n=21” gives aggregated information for another group of patients. With an average age of 77.1, they are older than the
first group. The standard deviation (5.3 years) is exactly the same as the other group. Fifteen of them are female (71%), slightly less than in the first group. The fourth column gives
a probability for a significant difference based on the comparison of group data.

15.6 Categorical Variables
Evaluative Categories in Content Analysis
In many research projects, forms of evaluative content analysis are used. The standard steps
are to: (1) define evaluative categories, usually with ordinal variables, (2) code text segments, and (3) analyze the data descriptively and statistically. A good example of this form
of analysis process is found in Philipp Mayring’s chapter on qualitative content analysis
found in “A Companion to Qualitative Research” (Flick, et al., 2004), which describes
scaled variations of structure content analysis.
In one of Mayring’s detailed examples from a study on student teachers, a category called
“self esteem” is created with three options: “high,” “medium” and “low” (see below).
These categories were developed from the material – one can see from the following figure
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that the categories are not only precisely defined, but also empirically supported with the
help of the anchor examples in the material.

Coding guidelines for the category “self-esteem” (from Mayring 2000:16)
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The coding process, which is standard procedure for content analysis, has the researcher
working through the entire data set and assigning evaluative codes to appropriate text
segments that have to do with “self esteem.” This means that every single text segment
that connects to self esteem will be assigned the code “high,” “medium” or “low” on the
basis of the coding guidelines established.
At the end, each case (in the case of interviews, a case would be an interviewed person)
can be analyzed as a whole and given a summary characterization as having “high,” “medium” or “low” self esteem. Cases characterized as having high self esteem can then be
compared with those with low self esteem. Code frequencies can also be compared and
used in combination with other categories in crosstabs.
Principles of Application in MAXQDA
The method for evaluative content analysis can be done in MAXQDA in the following way.
First, the category “self esteem” is created as a code with the subcodes “high,” “medium”
and “low.” The definitions of these codes along with anchor examples can be created as
code memos.
Now the material can be worked through, meaning that each document is read line by line.
The text segments that have to do with self esteem are identified and then coded with the
appropriate code (e.g. “high” self esteem). After an entire text has been worked through in
this way, the researcher will have one of the following situations:
 Text segments about self esteem were all coded with the same subcode (e.g. “medium”
self esteem). In this situation, the entire case can be said to have a medium level of self
esteem.
 Text segments about self esteem were coded with various subcodes, but one of those
subcodes obviously occurs more often (e.g. three with “high” self esteem and one with
“medium” self esteem). In this situation it makes sense to give the whole case that level
of self esteem that is coded most often.
 Text segments about self esteem were coded with various subcodes, and none of them
clearly occur more often than the others (e.g. two with “medium” self esteem and two
with “high” self esteem). In this situation, a quick categorization cannot be made, so
the coded segments should be compared to one another by the coders, who then make
a decision about which categorization is more appropriate.
 Text segments about self esteem were coded with various subcodes, and none of them
clearly occur more often than the others (e.g. two with “medium” self esteem and two
with “high” self esteem). In this situation, a quick categorization cannot be made, so
the coded segments should be compared to one another by the coders, who then make
a decision about which categorization is more appropriate.
The “Transform into a Categorical Variable” Function
After coding the appropriate text segments, the “self esteem” code can be transformed
into a categorical variable by right-clicking on the code and selecting the appropriate option
in the menu that appears.
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Calling up the “Transform into a categorical variable” function in a code’s context menu

After this option is selected, MAXQDA performs the following actions:
1. A new categorical variable is created in the List of Variables with the name of the code
that it was created from (in this case, “Self esteem”).
2. All cases (documents) in the „Document System“ are evaluated according to the rules
explained above. That means that each case is assigned as having “high,” “medium,”
“low,” or “undefined” self esteem or left blank. If only subcode is used more than the
others in a case, that case receives that label. If there are two or more subcodes used
the same numbers of time, it is labeled “undefined.” If none of the subcodes are used
at all, no value is assigned.

Variable matrix with the new categorical variable “Self-esteem”

Dynamic Properties of Categorical Variables
In MAXQDA‘s List of Variables, the categorical variables have a special status. One recognizes them in the list, because they have a green square in the first column and are created
from a “Code” as seen listed below in the “Source” column; categorical variables are defined as string variables, and the strings are taken from the „Code System“ (in this case
“High,” “Medium” or “Low”).
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The newly-created categorical variable “Self-esteem” in the List of Variables

Categorical variables are dynamic, which means they are updated automatically when new
coded segments are made in the documents. This is also the case for documents that are
imported after the categorical variable has already been created; when one codes this new
document, the variable label changes accordingly.
Tip: It makes sense to assign different colors to the various subcodes (e.g. red for “high”
self esteem, blue for “medium” and yellow for “low”). One can then right-click in the coding stripe column, check the box for Color-coded text, and very quickly find the coded
passages in the „Document Browser“.
Categorical Variables in the Context of Mixed Methods Functions
Categorical variables lend themselves very well to use with MAXQDA’s mixed methods
functions. With the “Activation by variable” function, for example, one can choose to activate only those cases (documents) with a certain variable value. This is helpful for answering
research questions such as “How do student teachers with low self esteem experience their
situation in the school system? How do they approach disciplines issues?”
The Crosstabs function offers an aggregated overview of the number of coded segments in
certain categories in the „Code System“ in each of the three levels of the self esteem variable. The self esteem characterizations are shown in the columns on the x-axis, and the other specified categories are shown in the rows on the y-axis. Using the self esteem example,
the Crosstabs function could count the number of times that student teachers with low self
esteem talk about discipline issues in comparison to the number of times student teachers
with high self esteem talk about the issue. With a single mouse click, one can also call up
the document segments counted in each cell in the „Retrieved Segments“ window.
One can also use the Quote Matrix to see a detailed table of the document segments, each
column holding those segments that occur in documents with a specific categorical value.
In our self esteem example, one column could hold those statements about a certain topic
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that come from student teachers with high self esteem, and the other column could display
those statements from teachers with low self esteem.
The Typology Table uses categorical variables similar to the way the Crosstabs function
does; a table is created with the categorical variable values in the columns. In this case,
however, the variables are analyzed rather than the categories. One could look, for example, what percentage of people with high self esteem are men and what percentage are
women, or whether good grades in teacher certification exams seem to connect in any way
to self esteem, etc.
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16 Teamwork: Using MAXQDA as a Team
16.1 Exchanging MAXQDA Projects
People doing qualitative data analysis often do so in a team, which raises the question how
MAXQDA allows for teamwork.
Important: MAXQDA is not a multi-user program. Simultaneous use of the same project
file at the same time is not possible. Various people cannot be changing the same file at the
same time.
Comfortable functionality as is currently available in MAXQDA does not blend with the logic of multi-user programs. A typical example of a multi-user program is the kind used by
airlines for flight bookings. Such programs only work when one user’s ability to change
something requires that the other users be given read-only permissions. MAXQDA, though,
is set up so that a user can write or change a memo, modify coded segments, etc. at any
time. All of these functions would be limited – if not made impossible all together – with a
multi-user system. For these reasons, one has to accept that simultaneous work by various
team members on the same project file is not possible. MAXQDA does, though, make it
easy to separate a project into various files, have team members work on them at the same
time, and then later bring them together in one file.
This teamwork is possible in two different forms, depending on how the team members
want to work together.
 Type 1 –Different people work with the same master version. They perform online
searches, text retrievals, and other kinds of analysis with this master version. But, they
do not perform code and memo procedures simultaneously on the master version.
 Type 2 - The different members of the group divide their work: Team Member A will
code text No. 1 through 5, Team Member B will code text No. 6 through 10, and Team
Member C text No. 11 through 15. They do their work at the same time and exchange
it using external media, a net- work, or the Internet.
Both types of teamwork are supported by MAXQDA. The first type of teamwork is the easier one, since a project file can be exchanged between the different PCs. The research group
always works with the same database, but the handicap is that coding and memo procedures in MAXQDA are not possible on more than one PC at a time.
The transfer of MAXQDA projects is very easy: MAXQDA saves all aspects of the project in a
MX4 file. If you name a project “ForumAnalysis,” it will be saved on your computer as “ForumAnalysis.mx4.”
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The project file does not contain …

Documents
 Saved search formulas
(SEA files = search files)
Codes
 Saved logical activation and Crosstabs formulas
Memos
(LOA files = LOgical Activation files)
Variables
 Files with exported coded segments and memos
Coded segments
(MEX files = MAXQDA EXport files)
Text links
 Saved Code Systems in MTR format
External links
 Graphics and photos from MAXMaps diagrams
Diagrams made in MAX Dictionaries in MAXDictio
Maps
These single MX4 project files can be exchanged between the members of the team –
they’re usually even small enough to send by email.









Tip: If you are planning on sending an MX4 file by email, you can make it even smaller by
“zipping” it into a ZIP file. This is recommended also because the file ending might not be
recognized by the receiving email program, and might not be accepted.
If you want to set up the project, so that various members of the team can work on it at
the same time, it is recommended that you start by importing all documents into a MAXQDA project on one computer, and then sending a copy of that file to everyone in the team.
This saves you the work of importing the files on each individual’s computer and guarantees that everyone will have the exact same data set.
Sharing Projects that have External Files
If you have associated audio or video files or very large PDF or image files, they will not actually be part of the MX4 project file. Instead they are put in a folder for external files (path
listed under Options in Project drop-down menu). If you want to share these files along
with the project file, follow these steps:
1. Send the project (MX4) file.
2. Group all the external files together in a ZIP file by selecting the Bundle all external
files from the Project drop-down menu. A compressed ZIP folder with those files attached to the project will then appear in the same folder as your MX4 file, which you
can then send to your fellow researchers.
Procedure for Receiving the Files:
1. Open the MX4 file first that you have received.
2. Select the Unpack bundled files option from the Project drop-down menu and
choose the ZIP file that was sent with the external files. MAXQDA unpacks these external files and puts them in the appropriate folder, so that they are connected to the newly-opened project.
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16.2 Exchanging Coded Segments, Memos, and Variables for
Documents and Document Groups
MAXQDA also supports a second type of teamwork, which allows people in the team to
work on documents at the same time. It is required that everyone have the same exact data
set, meaning that each person has a copy of the project on their own computer.
Tip: Every person must work with an identical form of the texts, meaning that it has the same
number of paragraph numbers, etc. The formatting, though – text type and size – does not
need to be the same.
The following example is set up for only two different PCs, but the same principle works for
as many PCs as you want.
PC 1

PC 2

Project with documents and codes

Project with the same documents
and codes as on PC1

Tip: It doesn’t matter if there are more documents on one PC than on the other, but those that
are the same must have the exact same structure on both computers.
If “Interview 1” was coded on PC 1, how do you make this work available to someone else
in your team? And what if new codes were created during this process? In this case, it
doesn’t make sense to send the project file, because the work that the person has done on
PC 2 would be lost. It is necessary in this case to simply transfer the work done on that single document.
In MAXQDA, you can do this as follows:
 The person working on PC 1 right-clicks on the text “Interview 1” in the „Document
System“ and chooses the option Teamwork export.
MAXQDA then copies all the information about this document, including coded segments,
memos, variables, and external links and exports it as a document with the name “Interview 1.”
So that you can tell that this is an exported teamwork file rather than just a regular document, the file has the ending MEX (Max-EXchange format). You will be able to tell later
then that this is your document with all the necessary information from MAXQDA.
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Choosing to export the information for the document “Teresa”

If you want to document all of the coded segments that you are exporting for the person
that will be receiving it, you can do so by right-clicking on the document a second time
and choosing to see the Overview of coded segments. You will then have a list of the
segments in the following form:

List of all coded segments in the document “Teresa”

You can then export this table and/or copy it to the Windows clipboard and paste it into a
word processing document, so you can print it out.
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The “Teamwork export” function always takes with it all coded segments, memos, variables, and external links for a document regardless of what you may have activated. This
means that it is not possible to export only those segments coded with a certain code. The
rule is: all or nothing.
The MEX file can then be sent as an email attachment or transferred with a flash drive. It is
recommended here again that you first compress it as a ZIP file, so that the email program
is sure to be able to read it.
Import the MEX File
The exported file can be imported on any PC where the same document with the same text
structure is present in the „Document System“. This works in the same way as the “Teamwork export.” Right-click on the document name in the „Document System“ on PC2.
Then choose Teamwork import and choose the appropriate file in the dialog box.
Tip: It is recommended that you back up your project before any import of teamwork. You
can do this by choosing the Backup project option in the Project drop-down menu.
You will then see a dialog field where you can check the source and target documents. If
the documents already have the same name, you don’t need to change anything, since
MAXQDA will already assume they have the same name. If the documents have different
names, you’ll have to choose the appropriate document in the target column.
You can then decide what exactly you want to import: coded segments, memos, variables,
and/or external links. You can also choose to view a protocol after the import, so you can
later document exactly what was imported. The standard settings are to import all aspects
of the document.

Options when importing teamwork
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Important: The document that you are importing the coded segments, memos, and variables to must have the exact same structure as the document that is receiving the information. To make sure you’re not importing a completely different document, MAXQDA will
ask you once again to confirm the import.
MAXQDA’s Import Process for Coded Segments and Memos
MAXQDA proceeds as follows with the imported coded segments:
 All coded segments existing before the import procedure remain coded.
 If additional segments in the imported file are coded with a code common to both documents, these segments in the destination file are also coded.
 Codes and subcodes that were not found in the „Code System“ of the destination file
will be created.
 Coded segments that already exist will be ignored to avoid the double-coding of a segment.
Document memos within the document are always imported. The memos that are attached
to the document or document group in the „Document System“ or attached to codes in
the „Code System“ are handled differently. Since there can’t be more than one of each of
these memos, one of the versions of the memo has to be kept, and one has to be ignored.
If a memo already exists in the project, the memos from the imported project will not be
included.
Variables are handled slightly differently. Variables that did not previously exist in the
project are automatically created, and the variable values are inserted. If the variables already exist, just the values will be updated.
To make sure that the import procedure was carried out correctly, it is recommended that
you open the document and check the codes. You could also obtain a list of all coded segments and memos with the Overview of coded segments” and the Overview of memos.
If you checked the box to create a protocol file, it will contain the following information:
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The start of an import teamwork protocol

16.3 Exchanging Coded Segments, Memos, and Variables for
Document Groups or the Entire Project
In MAXQDA 10, you can exchange coded segments, memos, and variables not only for
individual documents, but also for whole document groups or even the entire project. You
should be careful when using this function, since a lot of things will happen and it is difficult to maintain an overview. It is highly recommended that you backup your project before
you start the import procedure.
When exchanging data on the level of document groups, the same rules will apply as with
individual documents. To start the import function, right-click on the document group or
the Documents icon and choose Teamwork export from the context menu that appears.
As soon as the import procedure has been started, a dialog sheet appears. Here you can
link source and target files. MAXQDA presents a list of correspondences, according to document names, that may be modified by the user. Double-clicking the name of the target
files opens a list where you can choose between all the document names of the selected
document group.
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Options when importing teamwork for an entire project

16.4 Merging MAXQDA Projects
Another teamwork feature in MAXQDA is the option to merge two projects. The “Merge
projects” function causes a second project to be added to a project you currently have
open. To do this, follow these steps:
1. Open the larger of the two projects you want to merge.
2. Choose Merge projects from the Project drop-down menu.
3. Select the project to be merged from the dialog window that appears.
MAXQDA then starts the merging procedure, which may take some time, depending on
the size of the two projects.
Project A and Project B must have different project names. The merge function is carried
out in the following manner:
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 All the document groups and documents of Project B are inserted in the „Document
System“ of Project A.
 All memos of Project B are inserted in the Memo Manager
 All the codes of the two projects are merged. In the case that a code or subcode does
not exist in the „Code System“ of Project A, this code is created and inserted in its place
in the list.
 All variable and variable values are merged.
These rules may not seem too complicated. But many questions will arise when you use the
function, such as:
 What happens if a document group with the same name already exists in the opened
project? The document group will be imported, too. You may rename or remove text
group later.
 For all variables that exist in Project A but not in Project B, MAXQDA will define new
variable values for Project B. Numerical values will be set to zero, string values to blanks.
 All variables existing in Project B but not in Project A, will be created and the variable
values for Project A will be set to zero (numeric variables) or blanks (string variables).
 If variables with the same name but different variable types exist in the two project files,
then both variables will be maintained. When the import procedure is complete, two variables will exist in the resulting project file.
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17 Working with Audio and Video Files in MAXQDA
17.1 General
MAXQDA was developed for use to analyze qualitative data with a focus specifically on text
analysis. The fact that it is now possible to analyze audio and video files in MAXQDA 10
does not mean that it is trying to replace or compete with already-existent programs that
specialize in video analysis (e.g. Studiocode and Transana). MAXQDA’s new functionality
for working with audio and video files is actually a simple extension of the text analysis options rather than an attempt to offer a stand-alone video analysis tool. This was done in
response to the common wish to have a connection between text (usually interview transcripts) and the original audio or video files. For this reason, MAXQDA 10 makes it possible
to make this connection between texts in RTF or DOC/X format and audio or video files
(MP3, WAV, etc.).

17.2 Synchronized Display of Audio/Video Files and
Transcribed Text
You can use time stamps – which are visualized similar to the way memos and coding
stripes are seen in the „Document Browser“ – to synchronize your transcripts with the original audio or video files. These A/V files can even be played in MAQDA in the new integrated media player. A time stamp table also lets you insert comments for each section of
your transcript represented by that time stamp, so you can later search for these comments
and go directly to that section of the text or A/V file.
There are three different ways to work with text and audio/video files:
Variation A – First you do the text transcription with whatever transcription software you
want to use, import the transcription as a document in MAXQDA, and then link the document to the original audio/video file. At this point, there aren’t any connections between
specific segments of the transcript and parts of the external file. These connections have to
be created with time stamps within MAXQDA.
Variation B – The first step in this variation is to transcribe the file with the professional
software f4 (http://www.audiotranskription.de/english/home), in which you can create time
stamps as you transcribe. You can then export the transcript in RTF format and import it
into MAXQDA, and the time stamps are imported along with the text. You will then already
have the connection between your text and the audio or video file.
Variation C – In this variation, you transcribe the file within MAXQDA.
The second variation is the most efficient, because you have the advantage of a professional transcription software, and – as opposed to in the first variation – you don’t have to
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create the time stamps within MAXQDA. The option to transcribe audio and video files directly in MAXQDA is brand new in the most recent version and doesn’t have as many features as a program that is designed to only do the specific task of transcription. It is, however, now possible.
Working with F4
When transcribing with f4, it is recommended that you set up a standard structure of time
stamps. The easiest way to do this is to set the program to automatically insert a time
stamp every time you hit the Enter/Return key. It is also recommended that you take advantage of the shortcut keys to mark which sections are being spoken by different people (e.g.
in group discussions).
F4 allows you to export the transcript in RTF format with time stamps in hyperlink form in
the text. When you import this document into MAXQDA, these time stamp links in the text
are automatically converted into time stamps.
Direct Transcription in MAXQDA
It is also possibly to transcribe audio and video files directly in MAXQDA. To do so, rightclick on a document group or the Documents icon in the „Document System“ and select
Transcribe audio/video from the context menu that appears. You will then see a dialog
field, in which you can select the file to be transcribed. MAXQDA automatically creates an
empty document and opens it in the „Document Browser“. This document is now linked to
the multimedia file, which can be seen in the document’s properties (right-click on the
document and choose Properties to check the link). You can now play this file in MAXQDA’s internal media player and type the transcription in to the empty document. It is usually
easier to transcribe in F4, since this software is free and can be installed on as many different computers as you want, which is not the case with MAXQDA.

17.3 The Media Player Toolbar
Before you can do the transcription as describe above, it is necessary to make sure the Media Player toolbar is being displayed. You can access this toolbar from the Toolbars dropdown menu.

The symbols in the toolbar give you access to the following functions:
(De)activates the connection to the A/V file.
Opens/closes the time stamp table.
Turns on/off sync mode, which causes the text to follow the media file.
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Opens/closes the video window to view video files.
Inserts a new time stamp.
Rewinds the media file to the last time stamp.
Stops playback.
Pauses playback.
Fast forwards the media file to the next time stamp.
The two numbers next to the icons tells you the current point and the total length of the
media file.

17.4 Variation A Procedure (Import into MAXQDA without
Time Stamps)
This variation will be explained with a song as an example. Let’s say we wanted to have a
synchronized connection between the text and the audio for the song “I Want You” by
Bob Dylan. To save us the time of doing the transcription, we can get the text from Dylan’s
website. We can then either copy it and paste it into a document in MAXQDA, or we could
paste the text into an RTF or DOC/X file and import that file into MAXQDA. For this example, we’ll name the document “Dylan: I want you.” Once the text is in MAXQDA, we need
to create the connection to the audio file.
 Right-click on the document Dylan: I want you, and select Properties from the context menu that appears.
 Click in the field next to the Media file label in the Multimedia section. You will see a
button with … on it just to the right of the field. Clicking on that button will open up a
window, so you can find the audio or video file (in this case, the Bob Dylan song). Click
Open.
 Close the Properties window.
The MAXQDA document with the Dylan text is now linked to the audio file, but the audio
file wasn’t actually imported as part of the MAXQDA project. You will now see that the
symbol next to the “Dylan: I want you” document has changed. This is the symbol for a
document linked to a media file:

Double-clicking on this document opens it in the „Document Browser“ (see below). A new
column has been inserted between the text and the paragraph numbers, which will show
your time stamps. The document only has one time stamp at this point, representing the
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very beginning of the song, since we haven’t added any yet. To play the song with the internal media player, you need to activate the Media Player toolbar from the Toolbars
drop-down menu. You can then click on the red flag symbol in this toolbar to activate the
media file.

Next, we would want to put the cursor at the beginning of the actual song text in paragraph 3, right before “The guilty undertaker …” and start playback of the song. We can do
this by clicking on the Play button or using the F4 key on the keyboard. We would then let
the song go until right before the singing begins and insert a time stamp by clicking on the
Insert time stamp button or by pressing the F3 key. We want to do this same thing for the
beginning of each verse. We would then see a time stamp symbol next to the first line of
each verse.

We can now use the synchronized text and audio together. By clicking on any of the time
stamps, we will hear the song played from that point. If you do this with an interview transcript, you can in a similar way get back to various sections that you may want to hear
again for tone or emphasis.
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If you turn on the Sync mode in the toolbar and click on the time stamp next to the first
verse, the text follows the song, meaning the section of text being sung will be highlighted,
similar to the way karaoke works. You can then follow along with the song text as you hear
it.

17.5 Variation B Procedure (Time Stamps Already Created in
F4)
The second variation saves you the trouble of creating time stamps in MAXQDA, because
they were already created in F4 and can simply be transferred over with the text to MAXQDA. Choose Import document from the Documents drop-down menu and select the RTF
file that was generated by F4. MAXQDA then searches automatically for a media file with
the same name in that folder. It searches for files with typical media file formats like MP3,
WAV, MPEG, etc. If the transcript was called “Interview_06.rtf,” MAXQDA will look for
“Interview_06.mp3,” “Interview_06.wav,” etc. If such a file is found, you just need to confirm that it is the appropriate file. If the file has a different name, you will need to find in
the dialog window.

Tip: MAXQDA automatically checks whether the imported text document contains time
stamps. If you want to import the media file with time stamps, it can only be done by importing the text file that has the time stamps imbedded in it. It is not possible to synchronize transcripts that have already been imported with external media files.
After you have imported the text and audio or video file, you will see the time stamps in a
column just to the left of the paragraph numbers in the „Document Browser“. The media
file won’t be opened by MAXQDA, though, until you open the “Media Player” toolbar and
activate the media file by clicking on the red flag icon.

17.6 The List of Time Stamps
The time stamps list has as many rows as there are time stamps in the document, and every
row has three columns. The first two columns contain the start and end points of that segment. In the third column, you have the option of writing in a short comment about that
particular segment. These columns are set up just like columns in any other MAXQDA table.
Clicking on any of the column headers sorts the table by that particular column alphabetically (another click changes it to reverse alphabetical order). You also have the option to
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search in a column by right-clicking on the column header and selecting Search. If you
don’t know if your search term is the first word in the column, you can insert a “*” before
your term. (A search for “*any” would find the word “company,” for example.)

The list of time stamps

If you are importing a document with time stamps, you still have the option to add new
ones once it has been imported into MAXQDA. The option to write your comments in the
list of time stamps also gives you a new way to find sections of your media file. Doubleclicking on a row takes you to that section of the text in the „Document Browser“ and
starts playback of the media file from that point.

17.7 Video Files
In principle, MAXQDA handles video files just like it handles audio files. The only difference
is that you can take advantage of an additional window when you are working with video
files. This window shows the video.
You can open this window by clicking on the

symbol in the Media Player toolbar.

This icon works like a light switch, letting you show or hide the video window at any time
during playback. All other controls are found in the toolbar as well: you can play, stop, insert time stamp, go to next time stamp, or go to previous time stamp with it. As for audio
files, video files have a table that lists all the time stamps and lets you insert comments for
each of those segments of video.
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18 Documentation, Exporting, Printing, Index, and Statistics
18.1 Projects: Creating, Deleting and Backing Up
Creating a New Project
MAXQDA allows you to work with as many different projects as you want. If you want to
work separately with a secondary data set, you just need to create a new project for it.
This is how it’s done:
 Click on the Project drop-down menu.
 Select New project.
 Navigate to the folder where you would like to save this new project
 Give the project a name and click Save.
Every project in MAXQDA is given the ending MX4. In order to secure your work, it is recommended that you back up this file regularly on a CD-ROM, flash drive, or external hard
drive. Qualitative data analysis is a lot of work, but it only takes a minute to back it up and
avoid risking a loss of your work if something happens to your computer.
Deleting a Project
If you want to delete a project, you can do so in the same way you would delete any other
file in Windows Explorer. MAXQDA 10 projects always have the file ending MX4, and the
projects from previous MAXQDA versions have the endings MX3, MX2, or M2K. It is not
possible to delete a project directly from the MAXQDA interface.
Whether or not it is possible to undelete a project depends on your Windows Recycle Bin
settings, but MAXQDA does not have any control of these operations on the operating system level.
Renaming a Project
Renaming a project can also only be done from Windows Explorer, not within MAXQDA.
Right-click on the project file and select Rename from the context menu that appears.
Duplicating a Project
MAXQDA projects can easily be duplicated. Simply select Backup project from the Project
drop-down menu in MAXQDA. This creates a copy of your project file, and it is recommended that you do this on a regular basis, so you can always revert back to older versions
of your project if you accidentally delete important aspects of it. When you back up the
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project, the backup may be slightly smaller than the original file – this is because the project
is cleaned up, meaning deleted file associations, for example, are deleted.
This is how it works:
 Open the Project drop-down menu.
 Click on Backup project.
 Choose the folder that you would like to save the file in.
 Assign a name for the file and click Save.
To work with the copy of the project, you will need to open it; unlike the “Save as …”
function in programs like Word, the newly-created file isn’t opened automatically.

18.2 Project Security and Care
Everything that you have deleted in a project is not actually physically removed from the
MX4 file. This means that the project file doesn’t get smaller when you delete a document
or document group. These deleted items are only discarded when you duplicate the project
with the Backup project function. Therefore, if you have deleted many aspects of your
project as you’ve been doing your analysis, it makes sense to use this function occasionally
to slim down your project file size. It also makes sense to do this before copying the file to
an external medium for backup.
Tip: It is recommended that you regularly create a backup copy of your project file and save
to an external medium like a CD, flash drive, or external hard drive. This reduces the risk of
losing your work in case of computer problems. You also should avoid having all of your
backups in the same physical location as your computer, as all of them could be lost in the
case of water damage, robbery, etc.

18.3 Modifying Document Groups and Document Sets
You can rename document groups and document sets at any time without it having any
effect on the actual documents or their associated objects (memos, codes, etc.):
 Right-click on the document group or document set in the „Document System“ and
select Rename document group or Rename document set from the context menu
that appears.
 Type in a new name.
A similar process lets you delete a document group or document set along with all of the
project aspects associated with it:
 Right-click on the document group or document set in the „Document System“.
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 Select the Delete document group or Remove set from the context menu that appears.
Before the document group will be deleted, MAXQDA will ask you to confirm the action.
This confirmation is necessary, because deleted documents and document groups cannot
be recovered. Removing a set, on the other hand, is not as big of a deal, since sets are only
links to documents. If you delete a set, it is gone, but the documents are unaffected. You
can create a new set just like the one you deleted at any time.
When you delete a document group, it does not affect the actual codes in your „Code System“. The coded segments, memos, links, and variable values for those documents, however, are deleted with those documents.

18.4 Renaming and Deleting Documents
It is also possible to rename and delete those objects on the lowest level of the „Document
System“: the documents. If they are text-based documents, the actual content can be
edited as well, using Edit Mode (see MAXQDA Screens and Menus). Content of image and
PDF documents, however, cannot be edited.
To rename a document:
 Right-click on the document in the „Document System“.
 Select Rename document from the context menu that appears.
 Type in a new name.
To delete a document from the project:
 Right-click on the document in the „Document System“.
 Select Delete document from the context menu.
MAXQDA will ask you to confirm the deletion, since there is not way to undo it afterwards.
When you delete a document, you are also deleting all the memos, coded segments, links,
and variable values that are associated with it. If you want to hold on to the memos that
are visualized next to the document in the „Document System“, right-click on them and
select Copy memo. You can then go to a different document, right-click again and select
Paste memo.
Another way to hold on to the memo would be to transform it into a document, which
would then be added to the „Document System“. To do this, right-click on the memo and
select Convert to a document.
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18.5 Documentation Options
If you are working on a project with a large data set and „Code System“ – and especially if
you are working in a team – it can be very important to document the current status of
your research. MAXQDA is a fairly easy program to get an overview of, but at the same
time, you might not know how to do so quickly.
MAXQDA offers the following options for quickly documenting your project:
In the Project drop-down menu, you will see two options: Export and Print, which are
both helpful for documentation. Both options give you the opportunity to access the contents of the four main windows, for example. Here are the various aspects of the project
that you can document by printing or exporting them:
 The “Document System”
 The “Code System”
 The document currently visible in the „Document Browser“
 The coded segment currently called up in the „Retrieved Segments“ window
In the “Document System” and “Code System” windows, you will also find various overview functions that display information about memos, coded segments, links, and variables
in table form. Their contents are based on the level of document or code hierarchy that you
called them up from (e.g. for a document group, for all documents, etc.). These overview
functions and variable tables also include the option to export them in HTML or Excel format for documentation purposes.
In the “Codes” drop-down menu, you can also call up a table of your codes and coded
segments to be printed or exported. An additional function in the same menu let you view
code frequencies.

18.6 Print/Export Settings
You can adjust various print and export settings by clicking on Print/export settings in the
Project drop-down menu. The first two options are to add a header and footer and choose
how you want them to be aligned (right, left, or center).
If you chose to print or export the Document Browser with coding stripes, you also have the
option to set the maximum width of the coding stripe column. The default is set at 20%.
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18.7 How to do Documentation
This section will give you an overview of the various documentation forms MAXQDA offers
and how you can use them.
How many documents, coded segments, memos, etc. are there in the project that is
currently open?
 Open the Project drop-down menu
 Click on the Print option.
 Choose to print Project information.
MAXQDA then creates the following report:

Project information report

What document and document groups are there in this project?
 Open the Project drop-down menu
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 Click on the Print or the Export option.
 Choose Document System.
If you chose to export it, you will also be asked to assign it a name.
The printout of the „Document System“ looks like this:
Documents
New York
Teresa
Joanna
Jon
Kim
Milly
Mary
George
Vincent
Indiana
Jack
Kelly
Grace
Websites & Literature
Suikkanen 2011
OECD 2009
Spector 1997
WorldValuesSurvey
Images
LifeSatisfaction EU 1973-2010
Sets
Printout of the Document System

What documents are part of the project? When were they imported, and how
many times were they each coded?
 Open the Variables drop-down menu
 Click on the Edit option.
 A variable table appears with each document making up a row. To choose which columns you want to display, right-click on a column header, choose Select fields, and
check the box next to the columns you want.
The documentation table then looks like this:
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Information about each document in the variable table

You can sort this table by any column, and sections of the table can be highlighted, copied
to the Windows clipboard, and pasted in other programs, like Microsoft Word. If you
choose to export the table in HTML or XLS/X format, a table will be created and opened in
the appropriate program (an internet browser for HTML files, Excel for XLS/X files), which
you can then print out if you wish.

Information about each document in the variable table exported in HTML format

Documentation of Documents in a Certain Document Group: What were the documents imported and how many times were they coded?
 Right-click on the document group in the “Document System”.
 Choose the Overview of variables from the context menu.
 The variable matrix appears with each document of that document group represented
in a row. If you want to limit which columns are included in the matrix, right-click on a
column header, choose Select fields, and check the box next to the columns you want.
This documentation form is set up similar to the one shown in the screenshot above.
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You can sort this table by any column, and sections of the table can be highlighted, copied
to the Windows clipboard, and pasted in other programs, like Microsoft Word. If you
choose to export the table in HTML or XLS/X format, a table will be created and opened in
the appropriate program (an internet browser for HTML files, Excel for XLS/X files), which
you can then print out if you wish.
Documentation for a Single Document: When was it imported, and how many
times was it coded?
 Right-click on the document in the “Document System”.
 Choose the Overview of variables from the context menu.
 The variable matrix appears with only one row, representing the single document. If you
want to limit which columns are included in the matrix, right-click on a column header,
choose Select fields, and check the box next to the columns you want.
This form of documentation looks exactly like the one for a document group, except that it
is limited to one row.
What codes and subcodes are in the project?
 Open the Project drop-down menu
 Click on the Print or the Export option.
 Choose Code System.
If you chose to export it, you will also be asked to assign it a name.
The printout of the „Code System“ looks like this:
Code System [307]
placement program [2]
Insurance [1]
analyst [1]
satisfaction [0]
Challenges [0]
Life Strategy [0]
Self Growth [0]
Pivotal Moments [1]
Day-to-Day Issues [2]
Emotions [25]
Education [19]
Interests [15]
Hunches [0]
Money and Financial Issues [6]
Damn [0]
Religion and Spirituality [7]
Significantly Positive [29]
Interview Guide Topics [0]
Health [16]
Damn I wish I looked like that [2]
Overall [8]
Recreation [14]
Home Life [12]
Relationships [25]
Work Issues [13]
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Key Quotes [26]
People [17]
Friends [21]
Parents [18]
Partner [20]
Siblings [7]
Sets [0]

Printout of the Code System

If you want to view the codes exactly as they are seen in the „Code System“, you can make
a screenshot of it when MAXQDA is open. To do this, it makes sense to maximize the
„Code System“ window, so you can see more of the codes at one time. When you have
the codes looking like you want them, press the PrntScrn button on your keyboard. This will
save a picture of the screen to the Windows clipboard. You can then open an image editing
software and paste it in as a new file or paste it into a Word file.
Which codes are used in each document?
You can call up a table with an overview of your coded segments for a document as follows:
 Right-click on the document in the “Document System”.
 Select Overview of coded segments from the context menu.
 A table with all of the coded segments for that document will appear. You can sort this
however you wish and choose which columns are to be included.

The overview of coded segments for the document “Vincent”

Sections of the table can be highlighted, copied to the Windows clipboard, and pasted in
other programs, like Microsoft Word. If you choose to export the table in HTML or XLS/X
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format, a table will be created and opened in the appropriate program (an internet browser
for HTML files, Excel for XLS/X files), which you can then print out if you wish.
Another option is to use MAXMaps. If you open a new map, you can simply drag the document into it, right-click on it, and choose to Import activated codes. Obviously, it is necessary to activate those codes ahead of time in the „Code System“ that you want to be
included.
Which codes are attached to which segments in a certain document?
A good overview of this is offered by the Codeline visualization, which shows the use of
each code in the document by paragraph. You can then view any of the visualized coded
segments in the „Document Browser“ by double-clicking on any of the colored bars.
You can also see which codes are assigned to which sections of your document by viewing
that document in the „Document Browser“. As you scroll through the document, you will
see the coding stripes just to the left of the text or image. To see exactly where the coded
segments start and end, simply click on the coding stripe; the coded segment will then be
highlighted for you.
Many users will want to have all of this documented on paper, though, which can be acquired as follows:
 Open the document in the „Document Browser“ by double-clicking on it in the „Document System“.
 Then select Print > Document from the Project drop-down menu.
You will then be given the choices whether you want to visualize the coding stripes and
memos in the printout. Normally, you will indeed want to do this. If you have Adobe Acrobat installed on your computer, you can also choose to print the document as a PDF, which
will then keep your formatting as you see it in the „Document Browser“. The results look
like this:
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Printout of the document in the Document Browser

Which document segments has a particular code been assigned to?
To see an overview table of the coded segment for a particular code, follow these steps:
 Right-click on the code or subcode in the “Code System”.
 Select Overview of coded segments from the context menu that appears.
 A table overview of the coded segments for that code will appear. Clicking on any of
the rows of the table at the bottom will bring up a preview of the coded segment in the
top window. You can sort the table according to any of the column values and hide the
columns you don’t need. You could then, for example, sort the table according to document or weight score.
If you do the above procedure for a code that has subcodes, the document segments coded with one of the subcodes will also appear in the table.
You have the option to export the table in various formats:
 As an Excel table in XLS/X format.
 In TXT tab-delimited format.
 In HTML table format.
 You can also simply highlight all or sections of the table, copy it to the Windows clipboard with Ctrl+C, and paste it into another program (e.g. Microsoft Word).
What memos are in the project?
The Memo Manager offers all of this information.
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 Select Memo Manager from the Memos drop-down menu.
 A table appears with each memo in a row.
 You can hide those columns that you don’t need and sort the table according to any of
the column values (e.g. my memo type, document, etc.).

Icon for the Memo Manager in the MAXQDA Standard toolbar

You have the option of exporting this table in the following formats:
 As an Excel table in XLS/X format.
 In TXT tab delimited format
 In HTML table format.
 You can also simply highlight all or sections of the table, copy it to the Windows clipboard with Ctrl+C, and paste it into another program (e.g. Microsoft Word).
Which memos exist in a document or document group?
 Right-click on the document or document group.
 Select Overview of memos from the context menu that appears.
 A table overview of the memos for that document or document group will appear.
Clicking on any of the rows of the table at the bottom will bring up a preview of the
coded segment in the top window. You can sort the table according to any of the column values and hide the columns you don’t need.
You can also export this table:
 As an Excel table in XLS/X format.
 In TXT tab delimited format
 In HTML table format.
 You can also simply highlight all or sections of the table, copy it to the Windows clipboard with Ctrl+C, and paste it into another program (e.g. Microsoft Word).
Which memos are linked to a certain code?
 Right-click on a code in the „Code System“.
 Select Overview of linked memos from the context menu that appears.
 A table overview of the memos for that code will appear. Clicking on any of the rows of
the table at the bottom will bring up a preview of the coded segment in the top window. You can sort the table according to any of the column values and hide the columns you don’t need.
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18.8 Exporting the Entire Code System
MAXQDA allows you to export the entire „Code System“, so you can import it in another
project. This function is especially helpful if you have developed a „Code System“ in one
project and decide to use it for another project. Using the export and import function saves
you the time of re-entering all of the codes again in the new project.
 Right-click on the Code System icon at the top of your list of codes in the „Code System“ and select Export Code System.
The „Code System“ will then be saved as an MTR file. You can then right-click on the same
icon in the new project and choose to Import Code System. You will then be asked to
choose the appropriate MTR file that you just created from the other project.

18.9 Listing all Coded Segments
MAXQDA makes it possible for you to get a complete list of all coded segments in your
project.
 Select Overview of coded segments from the Codes drop-down menu.
 Or click on the appropriate icon in the MAXQDA Standard toolbar.

Icon for the overview of coded segments in the MAXQDA Standard toolbar

The following table appears with as many rows as there are coded segments in the project.
The exact number of rows is listed in the top right of the window, which will be the same
number as the total number of coded segments shown at the top of the „Code System“ or
„Document System“.
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Overview of all coded segments in a project

Clicking on any of the column headers of the table will sort the table according to the column values. You can also hide certain columns that you don’t need by right-clicking on a
header and choosing Select fields. You can then put a check next to those columns that
you want to view and uncheck those that you don’t.
You can also export this table:
 As an Excel table in XLS/X format.
 In TXT tab delimited format
 In HTML table format.
 You can also simply highlight all or sections of the table, copy it to the Windows clipboard with Ctrl+C, and paste it into another program (e.g. Microsoft Word).

18.10

Code Frequencies

It can be helpful to view the statistics of how often each code has been used in a project. In
MAXQDA, these statistics are called code frequencies. To access them:
 Choose Frequency of codes from the Codes drop down menu.
 Or click on the appropriate icon in the MAXQDA Standard toolbar.

Icon for opening the code frequency table

Documentation, Exporting, Printing, Index, and Statistics
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The following table appears, which has each code and subcode represented in a row. The
“Code ID” column tells you the sequentially-assigned number MAXQDA has given to that
code; and the “Position” column tells you where that code is placed in the „Code System“,
counting down from the top.

Code frequencies

The “All coded segments” column tells you exactly how many times that code was used in
all documents and document groups.
The “Activated coded segments” column tells you how often that code was used in the
documents and document groups that are currently activated in the „Document System“. If
all of the values in this column are 0, it is likely that you don’t have any documents activated. If you right-click on any of the rows in the table, you will see a number of options,
giving you access to things like the overview of code variables. You can also change the
color of the code from this menu.
If you want to see the code frequencies for a specific document or document group, you
just need to activate them. This is possible even if the table is already being viewed. As you
activate the codes, the table will automatically update.
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Code frequencies

You can also export this table:
 As an Excel table in XLS/X format.
 In TXT tab delimited format
 In HTML table format.
 You can also simply highlight all or sections of the table, copy it to the Windows clipboard with Ctrl+C, and paste it into another program (e.g. Microsoft Word).
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19 Import/Export Options
19.1 Overview
MAXQDA offers a variety of options for exporting data to other software programs like
SPSS or Microsoft Office programs. The following table gives an overview of the different
options.
Data Type
Single document

Option in MAXQDA
Project > Export > Document

Format
RTF

Or select everything in the „Document Browser“ with Ctrl+A and
copy it to the Windows clipboard.
Highlighted document
segment

Highlight and copy the selection
with Ctrl+C or by selecting Copy
from the Edit drop-down menu.

One or more coded segments

Highlight the segments by clicking XLS/X, HTML, RTF, Winon them while holding the Ctrl but- dows clipboard
ton and choose the export option
or copy with Ctrl+C

All coded segments in the
„Retrieved Segments“
window

Project > Export > Retrieved
Segments or from the „Retrieved
Segments“ window, hit Ctrl+A to
highlight all of them and Ctrl+C to
copy them to the Windows clipboard

XLS/X, HTML, RTF,
Windows clipboard

Coded segments for a single document (teamwork)

Right-click on the document and
select Export teamwork
Memo Manager > Export

.MEX (internal format)

Memos

Windows clipboard

RTF, XLS/X, HTML

Memos for a particular
document (for teamwork
export)

Right-click on the document and
select Export teamwork

.MEX (internal format)

Memos for a particular
document

Right-click on a document and select Overview of memos

RTF, XLS/X, HTML

Text of a memo

Copy to Windows clipboard with
Ctrl+C

Windows clipboard

List of variables

Variables > List of Variables and .HTML, XLS/X
then click on the icon in the toolbar
for HTML or XLS/X table
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Variable table (export)

Variable table (import)
Variables and variable values for a document
(teamwork)

Exporting the Overview of Coded Segments

Variables > Export data matrix or .TXT (tab-delimited),
click on the HTML, XLS/X, or Export HTML, XLS/X
icons in the variables list
Variables > import data matrix
XLS/X or TXT (tabdelimited)
Right-click on the document and
select Export teamwork

Export variable values for a Right-click on a document, select
document
Overview of variables, and click
on the icon in the toolbar for HTML
table, Excel table, or to export
Codes > Overview of coded
Code frequencies table
segments and click on the export
icon,

.MEX (internal format)

TXT (tab-delimited),
HTML, XLS/X

TXT (tab-delimited),
HTML, XLS/X or Windows clipboard

or
highlight the cells of the table that
you want to copy and hit Ctrl+C to
copy them to the Windows clipboard
Code frequencies

Project > Export > Matrix of
code frequencies

TXT (tab-delimited),
HTML, XLS/X

Import/export options

Die Funktionen zum Export und Import der Datenmatrix und der Matrix der Codezuordnungen weisen einige Besonderheiten auf. Sie finden in folgenden Abschnitten detaillierte
Beschreibungen hierzu:
Exporting the Table of Variables
Importing the Variable Matrix into SPSS
Exporting the Overview of Coded Segments

19.2 Exporting the Overview of Coded Segments
You might also want to export the “Overview of coded segments,” so it can be analyzed in
other data analysis programs. Unfortunately, there has been very little standardization of
file formats in data analysis programs, which makes it very difficult to exchange files. This
matrix, however, includes all the information you would need to move your coded seg-
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ments to another software. All that is required, then, is a form of import on the part of the
other software developer.
The table can be called up by selecting Overview of coded segments from the Codes
drop-down menu. It looks like this:

Overview of coded segments

The table contains has a row for each of the coded segments, so the size of the table depends on how much coding has been done in the project.
Below is an overview of the various columns in the table:
Document

Contains the document name (formatted: documentgroup\document name)

Code

Contains the
code\subcode)

Begin

The paragraph number where the coded segment
begins

End

The paragraph number where the coded segment
ends

Weight score

Weight score value

Preview

The first few lines of the coded segment

Comment

Comments written in by the user

code

or

subcode

(formatted:

To export this table, you just need to click on the appropriate symbol in the toolbar based
on the format you want the table to be exported in. You have the option of exporting in
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HTML, TXT, or XLS/X format. It is usually a good idea to hide the “Preview” column before
exporting, since this is rarely analyzed.
This matrix can be statistically analyzed in various ways. The options range from simply frequency analyses to sequence analysis. It is also possible to aggregate the data on the case
(document) level and then analyze, for example, correlations between codes.

Special Features and General Options
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20 Special Features and General Options
20.1 The Logbook
The logbook is a feature in MAXQDA 10 that lets your write a sort of journal to keep track
of your analysis work. The term “logbook” is usually used in connection with ocean navigation, which was used to record meaningful happenings and observations, and it can be
used in a similar way for your project. The logbook is set up to have the newest entries at
the top.
You can call up the logbook with the MAXQDA Standard toolbar:

Icon for calling up the logbook

The logbook window is a simple RTF window with a toolbar, which is fairly self-explanatory,
and lets you format the text as you want. You can, for example, edit the font style and size;
use bold, underline, and italics; and change the text color. The icons on the far left let you
create a new entry and print or export the logbook.

To create a new entry, click on the button on the far left of the toolbar. This automatically
inserts a date and time stamp at the top of the page, and you can enter your text directly
below it.
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20.2 Checking for Updates
You can check for free updates to MAXQDA at any time by selecting Search for updates
from the ? drop-down menu. The program will then check to see if there is a version online
that is more recent than the one installed on your computer. If there is a newer version, you
will be asked if you want to download it. These updates include improvements and new
features, and since it takes very little time to download the update, it is worth doing.
MAXQDA will then restart automatically.

20.3 General Options
You will find the Options in the MAXQDA Project drop-down menu. The window that
appears lets you view and edit your options. Some changes that you make will require that
MAXQDA restart.

The following settings can be changed:

Special Features and General Options
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“General” Settings
Confirm Deletions
The default setting is to require a confirmation for any deletions you make in your MAXQDA project. This can be important, since deletions cannot be undone. If you delete a document group, for example, you are permanently deleting all of the documents, coded segments, memos, etc. that are connected to it. It is therefore recommended that you leave
this option checked.
No Duplicate Code Names
If this option is checked, you will not be able to create more than one code in the „Code
System“ with the same name. This also applies to subcodes. In some cases, you will want to
allow for duplications (e.g. if you have the main codes “Theory” and “Praxis,” and want to
have “Political” and “Economic” as subcodes for each of them).
Do Not Display Code Frequencies in Code System
The default setting is for MAXQDA to list the number of times each code has been used.
You will see this number just to the right of each code name in the „Code System“. If you
do not want or need this, you have the option of hiding these numbers by checking this
box.
Include Subcodes in Matrix of Code Frequencies
You can create a matrix of code frequencies in the Project drop-down menu, by choosing
Export > Matrix of code frequencies. This matrix shows the number of times each code
or subcode was used in the project and can easily be imported for statistical analysis in programs like SPSS. You can calculate correlations between codes or do factor or cluster analysis.
If you activate this option, the codes will all be aggregated to the top level. In other words,
the frequency for the parent code “Theory” would include the frequencies of the subcodes
“Political” and “Economic.”
Import Objects (Diagrams)
Graphics, especially photos, can be very large and take up a lot of memory. For this reason,
you have the option in MAXQDA to link to graphics rather than import them as part of the
MX4 project file. If you actually want these graphics to be part of the project file, you can
click this option. It is important that you be careful not to let the project file get too big,
though.
Activate Codes Together with Subcodes
If this option is checked, subcodes will automatically be activated when their parent code is
activated. This also applies then for deactivations.
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Default Weight
The default weight score for newly-created coded segments is 100, but can be changed
here.
Max. Number of Codes in Quick List
This setting determines the maximum number of codes that can be added to the Quick List,
which is found in the Code toolbar. The default is 20.
Backup Externals
Here you can set the location for all of your externally-linked files to be stored. These include audio and video files, for example, that are too big to be included in the project file.
Image and PDF files might also be stored here, depending on their size and your settings
(see below).
“User Interface” Settings
Document System and Code System on the Left Side
The default setting in MAXQDA is for the „Code System“ and „Document System“ to be
on the left side of your screen and the „Document Browser“ and „Retrieved Segments“
window to be on the right. If you would like to switch this order around, you can uncheck
this box. MAXQDA will need to restart.
Large Font
The size of the text in the „Document Browser“ can be adjusted as you wish, but you can’t
control the exact text size in MAXQDA menus and toolbars. With this option, though, you
can switch all of these user interface texts to a larger size. MAXQDA will need to restart.
Reset User Settings
This is an emergency option of sorts that you can use if you have somehow altered your
settings in a way that makes MAXQDA unusable and can’t figure out how to undo these
settings. If you check this box, MAXQDA will need to restart, and all of your settings will
then be reset.
“Update Program Automatically” Settings
Search for Updates
The default setting is for MAXQDA to automatically search for updates. If you don’t want
this to happen, you can uncheck this box.
Time Interval [Days]
This sets the number of days the program should wait between checks for updates. The
default is 30 days.

Special Features and General Options
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“PDF and Image Documents” Settings
Do Not Imbed if Larger than [MB]
Images and PDF files can take up a lot of room in your project file. For this reason, you can
set a maximum size for these types of documents. If the files are larger than the given size,
they will be linked to instead of imported. The default maximum is 5 MB.
“Export” Settings
Apply Variable Names “Textgroup” and “Textname”
The default is to use the terms “textgroup” and “textname” as variable names. Otherwise
they would be switched to “documentgroup” and “documentname,” which can make it
more difficult to import tables into programs like SPSS and especially SYSTAT.
Excel Format
You can set here whether you want to export Excel files in XLS or XLSX format.
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21 Appendix
21.1 Keyboard Shortcuts
The following keyboard shortcuts are available in MAXQDA.
General
F1

Opens the MAXQDA help system.

Ctrl+A

Highlights the entire text.

Ctrl+C

Copies the selected text to the Windows clipboard.

Ctrl+X

Cuts out the selected text and puts it in the Windows clipboard.

Ctrl+V

Pastes the selection from the Windows clipboard.

Alt+Q

Opens the logbook.

Ctrl+B

Opens the Code Matrix Browser.

Ctrl+O

Opens the Code Relations Browser

Ctrl+1

Opens and focuses on the „Document System“.

Ctrl+2

Opens and focuses on the „Code System“.

Ctrl+3

Opens and focuses on the „Document Browser“.

Ctrl+4

Opens and focuses on the „Retrieved Segments“ window.

Ctrl+5,

Focuses on the next/previous window.

Ctrl+Shift+5
Ctrl+F

Opens the context search for the current window.

Ctrl+Shift+F

Opens the color filter for the current window.

Alt+double-click

Inserts a MAXQDA object (e.g. a document or code) into MAXMaps, if MAXMaps is open.

Document System
Double-click

Opens a document.

Shift+double-click

Opens a document in a new tab.

Ctrl+click

Activates or deactivates a document.

F2

Opens a field for renaming a document.
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Drag & Drop,
Shift+UpArrow

Moves a document or document group to a different place or up
and down in the „Document System“.

Shift+DownArrow
Ctrl+Drag & Drop

Creates a copy of the document.

Ctrl+T

Creates a new document and opens it for editing in the „Document Browser“.

Ctrl+Shift+T

Opens the dialog window for importing a document at the top of
the „Document System“.

Alt+T

Opens the dialog window for importing a document into the selected document group.

Ctrl+M

Creates a memo for a document.

Code System
F2

Opens a field for renaming the code.

Drag & Drop,

Makes a code into a subcode of another code.

Alt+UpArrow,
Alt+DownArrow
Shift+Drag & Drop,

Moves a code without it changing levels or becoming a subcode.

Shift+UpArrow,
Shift+DownArrow
Ctrl+Drag & Drop

Creates a copy of a code.

Ctrl+Click

Activates or deactivates a code.

Alt+N

Creates a new code on the activated level.

Ctrl+Shift+B

Opens the code browser.

Document Browser
Ctrl+Shift+E

Toggles Edit Mode.

Alt+l

Codes the selected segment with the most recently-used code.

Ctrl+W

Opens the dialog window for creating a new code, which will be
used to code the selected segment.

Ctrl+Q

Codes the selected segment with the code shown in the Quick
List.

Ctrl+I

Codes the selected segment with a newly-created code named
after the first 32 characters of the selected segment (in-vivo cod-

266

Keyboard Shortcuts
ing).

Ctrl+l

Inserts an internal link at the location of the selected segment. The
location it is linked to is set by highlighting another segment in
that document or another one in the project and hitting Ctrl+I
again.

PgUp,

Move to the next/previous page of a PDF document.

PgDn,
Alt+mousewheel
Pos1,

Moves to the first/last page of a PDF document.

End
Ctrl+Mousewheel,

Zooms in or out of the document.

Ctrl+Plus,
Ctrl+Minus
Ctrl+Tab,

Jumps to the next/previous tab.

Ctrl+Shift+Tab
Ctrl+F4

Closes the tab.

Retrieved Segments Window
Ctrl+Shift+l

Opens the “Overview of coded segments.”

Media Player Toolbar
Ctrl+P

Activates/deactivates media player.

F3

Inserts a time stamp.

F4

Plays or pauses the media file.

F5

Jumps to previous time stamp.

F6

Jumps to next time stamp.

Time Stamp List
Ctrl+H

Opens the table in HTML format in the standard internet browser.

Ctrl+E

Opens the dialog window for exporting the table.

Overview of Variables – Data Editor
Ctrl+H

Opens the table in HTML format in the standard internet browser.

Ctrl+E

Opens the dialog window for exporting the table.
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Ctrl+O

Switches to variable view.

Overview of Variables – Variable View
Ctrl+H

Opens the table in HTML format in the standard internet browser.

Ctrl+E

Opens the dialog window for exporting the table.

Ctrl+O

Switches to data editor view.

Ctrl+N

Creates a new variable.

Del

Deletes a variable.

Ctrl+B

Transforms a variable into a binary variable.

Ctrl+S

Transforms a variable into a string variable.

Overview of Coded Segments
Ctrl+H

Opens the table in HTML format in the standard internet browser.

Ctrl+E

Opens the dialog window for exporting the table.

Ctrl+Q

Opens the autocode window.

Overview of Memos
Ctrl+H

Opens the table in HTML format in the standard internet browser.

Ctrl+E

Opens the dialog window for exporting the table.

Ctrl+N

Creates a new free memo.

Overview of Links
Ctrl+H

Opens the table in HTML format in the standard internet browser.

Ctrl+E

Opens the dialog window for exporting the table.

Lexical Search – Search Results
Ctrl+H

Opens the table in HTML format in the standard internet browser.

Ctrl+E

Opens the dialog window for exporting the table.

Ctrl+Q

Opens the autocode window.

Ctrl+P

Opens the options window.

Intercoder Code-Specific Results Table
Ctrl+H

Opens the table in HTML format in the standard internet browser.
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Opens the dialog window for exporting the table.

MAXDictio Dictionary
Ctrl+T

Changes the category system view.

Tab

Changes the entry field between the category system and the
word table.

Ctrl+O

Opens the dialog window for opening a dictionary.

Ctrl+I

Opens the dialog window for adding a dictionary.

Ctrl+S

Opens the dialog window for saving a dictionary.

Ctrl+E

Opens the dialog window for exporting a dictionary.

Ctrl+N

Creates a new category or search term.

Del

Deletes a category or search term.

Ctrl+Alt+N

Deletes all categories and their contents.

MAXDictio Word Frequencies
Ctrl+H

Opens the table in HTML format in the standard internet browser.

Ctrl+E

Opens the dialog window for exporting the table.

MAXDictio Coder
Ctrl+H

Opens the table in HTML format in the standard internet browser.

Ctrl+E

Opens the dialog window for exporting the table.

Ctrl+Shift+R

Transforms the selected entries into variables.

Ctrl+R

Shows the search results.

21.2 Quick Troubleshooting Tips
If the results of a retrieval don’t match your expectations, the first thing you should always
do is reset the retrieval functions by clicking the appropriate icon in the MAXQDA Standard
toolbar.

Icon for resetting the retrieval functions
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This function takes you back to the standard OR retrieval settings, removes any weight filters, and undoes all activations in the „Document System“ and „Code System“. If you are
still having problems after resetting and starting again, go to the menu entry Project > Options drop-down menu and check the box next to Reset user settings. You can then close
and reopen MAXQDA, which will have all of its original settings.
A selection of other quickly-remedied problems are listed in the following table:
Problem
You can’t import any documents.

Solution
It could be that you’ve opened a MAXQDA project that is
read-only, which can happen if you copied the project
from a CD onto your hard drive. Go to the project file,
right-click on it, and click on “Properties.” Here you can
change the read and write privileges.

You imported a document, but
don’t see it in the „Document
Browser“.

To view the document, you need to double-click on it in
the „Document System“. It will then appear in the
„Document Browser“.

You want to import a document into a document group,
but MAXQDA says that the
document can’t be imported.

It could be that the document is still being used by
another program (e.g. Word). Make sure to close the
document in these other programs and then try again.

A Word (DOC) document can’t
be imported.

Are you sure that it is not open in another program?
Open it in your word processor, save it as an RTF file,
close it, and try importing it into MAXQDA again.

Your documents aren’t shown
in the „Document System“.

It could be that you’ve chosen to collapse certain document groups. Click on the + symbol in front of a document group to view the documents in it.

No segments are shown in the
„Retrieved Segments“ window
even though you’ve activated
documents and codes.

Make sure you haven’t accidentally chosen an advanced
retrieval function (e.g. Near or Followed by).
Check to make sure you haven’t accidentally turned on a
weight filter.
Both of these things can be checked in the status bar at
the bottom of the MAXQDA window.

Some of your codes aren’t
shown in the „Code System“.

It could be that you’ve collapsed certain codes, hiding
their subcodes. Click on the + symbol to show subcodes
for a code.
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You accidentally coded a segment incorrectly.

Technical Data and Information
Click on the Undo button in the Code toolbar. A list of
recent coding actions will appear, with the most recent
action at the top. To undo your most recent coding, click
on the first string in the list.
Or: Right-click on the coding stripe and choose Delete.

Tip: If you aren’t able to solve your problem, don’t hesitate to contact our support team.
You can contact them at http://www.maxqda.com/support/onlinesupport.

21.3 Technical Data and Information
Limitations
MAXQDA sets very few limits; usually the limit is based on the limits of your computer’s
memory or hard drive. The following limitations do, however, exist:
Text length:

No official limit, but it isn’t recommended that you
import texts larger than 1 MB.

Size of a coded segment:

max. 64 KB

Text formats:

RTF, DOC/X, PDF

Image formats:

JPG, GIF, TIF

Number of projects:

No limit

Number of document groups:

No set limit

Number of documents:

99,999

Number of codes:

No set limit

Code System levels

Max. 10

Strings in MAXQDA:

Usually 64 characters

Numerical data:

10 characters

Number of variables

No set limit, but more than 250 is not recommended.

File Management
The MAXQDA program file (maxqda.exe) is found in the “MAXQDA10” folder after it has
been installed, unless you changed the name of the installation folder.
MAXQDA creates the following file types:
MAXQDA.INI Configuration file
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.MX4

MAXQDA 10 project file

.MX3

MAXQDA 2007 project file

.MX2

MAXQDA 2 project file

.M2K

MAXQDA 1 project file

.LOA

Saved formula files (Logical Activation)

.SEA

Saved search files (SEArch file)

.MEX

Teamwork export file (MAX EXport)

.TXT

Exported table file

.RTF

Exported texts, coded segments, and memos

.MTR

Exported „Code System“
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